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GIỚI THIỆU VỀ MÔ ĐUN 
 
 

Vị trí, ý nghĩa, vai trò mô đun 
• Đây là một mô đun chuyên ngành được học sau khi học viên đã hoàn 

tất các mô đun hổ trợ trước đó như: Linh kiện điện tử, mạch điện tử, kỹ 
thuật số 

• Vi mạch số chức năng từ lâu đã có vai trò rất quan trọng trong các hệ 
điều khiển số. Nhưng vấn đề thường gặp trong thiết kế các hệ phức tạp 
là số lượng cổng quá nhiều và quá trình thiết kế cũng rất khó khăn kèm 
theo độ linh hoạt cũng kém. Một biện pháp khắc phục là phải tìm ra một 
linh kiện số đa năng có thể đáp ứng được các yêu cầu trên. Đó là các 
hệ vi mạch số lập trình từ những thiết bị quy mô nhỏ như PAL, GAL cho 
đến các chủng loại có mật độ tích hợp lên đến hàng ngàn cổng logic, 
vài chục thanh ghi, hàng trăm chân I/O. Ưu điểm của chúng là giãm 
kích thước, công suất tiêu thụ, tăng độ tin cậy, tính linh hoạt và đặc biệt 
với sự trợ giúp của các công cụ hổ trợ phần mềm quá trình thiết kế trở 
nên đơn giản rất nhiều. Do đó hiện nay chúng được áp dụng rất phổ 
biến trong lỉnh vực máy tính cũng như điều khiển tự đông trong công 
nghiệp. Chính vì thế kiến thức về họ thiết bị không thể thiếu đối với 
công nhân sửa chửa điện tử công nghiệp 

Mục tiêu của môdun 
Sau khi hoàn tất mô-đun này, học viên có năng lực: 

• Hiểu được cấu tạo, đặc tính của các họ vi mạch số lập trình như : PAL, 
GAL, CPLD… 

• Nắm được các ứng dụng cơ bản và thông dụng của op-amp 
• Giải thích được các sơ đồ ứng dụng thực tế. 
• Lắp ráp và sửa chửa được các thiết bị điện tử dùng vi mạch PLD 

 
Mục tiêu thực hiện của mô đun 

• Phân tích được các mạch ứng dụng vi mạch PLD 
• Xác định được các nguyên nhân gây hư hỏng thường xảy ra trong thực 

tế 
• Thiết kế được yêu cầu điều khiển dùng PLD kể cả phần cứng lẩn phần 

mềm 
• Sửa chửa và thay thế linh kiện hư hỏng 
• Kiểm tra được điều kiện hoạt động của thiết bị. 

 
Nội dung chính của mô đun 

Mô đun vi điều khiển bao gồm 5 bài học như sau : 
1. Giới thiệu chung về PLD 
2. Mảng logic lập trình 
3. Ngôn ngử ABEL 
4. Họ CPLD  
5. Phần mềm ISP Synario 
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SƠ ĐỒ QUAN HỆ THEO TRÌNH TỰ HỌC NGHỀ 
 

TRANG BỊ ĐIỆN 

ĐIỆN KỸ THUẬT 

LINH KIỆN ĐIỆN TỬ

ĐO LƯỜNG ĐIỆN 
TỬ  

MẠCH ĐIỆN TỬ 

CHẾ TẠO MẠCH IN 

VẺ ĐIỆN 

KỸ THUẬT XUNG 

CHÍNH TRỊ 

AN TOÀN LAO ĐỘNG

CÁC MÔN CHUNG 

MÔN HỌC BỔ TRỢ 

PHÁP LUẬT 

QUỐC PHÒNG 

THỂ CHẤT 

TIN HỌC 

ANH VĂN 

VI MẠCH TƯƠNG 
TỰ 

 
ĐIỆN TỬ CÔNG 

SUẤT

 
VI ĐIỀU KHIỂN 

VI MẠCH SỐ KHẢ 
LẬP TRÌNH 

KỸ THUẬT CÃM 
BIẾN 

KỸ THUẬT SỐ 

ĐIỀU KHIỂN LOGIC 
LẬP TRÌNH 

ĐIỆN CƠ BẢN 

MÁY ĐIỆN 

ĐẦU VÀO ĐẦU RA 
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CÁC HÌNH THỨC HỌC TẬP CHÍNH TRONG MÔ ĐUN 
 

Hình thức 1: Học lý thuyết trên lớp 
- Tất cả các bài học từ 1 đến 5 
- Làm bài tập và trả lờ các câu hỏi tại lớp. 
- Giải các câu hỏi và bài tập phần lý thuyết 
- Viết các chương trình băng ngôn ngử ABEL và áp dụng phần mềm ISP Synario 

 
Hình thức 2: Học thực hành trong xưởng 

- Giải thích nguyên lý hoạt động của sơ đồ thực tập 
- Lắp ráp mạch theo sơ đồ. 
- Đo kiểm tra, chạy thử và ghi nhận kết quả. 
- Phân tích các hư hỏng thường gặp và đề ra biện pháp khắc phục 
- Thực hành quy trình sửa chửa. 

 
Hình thức 3: Tự nghiên cứu 

- Phân tích nguyên lý hoạt động các máy thực 
- Tham quan xí nghiệp. 
- Tham khảo các vấn đề liên quan trên sách báo, internet... 
 
 

YÊU CẦU VỀ ĐÁNH GIÁ HOÀN THÀNH MÔ ĐUN 
Về lý thuyết: Hiểu và thực hiện được các nội dung sau 

- Cấu tạo, đặc tính của các họ PLD 
- Tập lệnh và chương trình viết bằng ABEL 
- Cấu tạo, đặc tính họ ispLSI 1016 
- Phần mềm ISP Synario 
- Ứng dụng ISP Synario trong thiết kế dùng CPLD 

Về thực hành: Có khả năng làm được 
- Thiết kế và thi công mạch điện theo yêu cầu 
- Viết chương trình điều khiển và kiểm tra hoạt động của hệ . 
 

Về thái độ 
- Cẩn thận, tỉ mỉ, chính xác. 
- Ngăn nắp, kiểm tra an toàn trước khi chạy thử  
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BÀI 1 
 
 

Tên bài: Giới thiệu chung về PLDs Mã bài: CIO 01 12 01 
 
 
 

GIỚI THIỆU 
Bài học này giới thiệu sơ lược về cấu trúc và các đặc điểm chung nhất về các họ vi 

mạch số lập trình cũng như hướng phát triển của chúng. Từ những bộ EPROM để lưu trử 
dử liệu đến mạch logic đa năng có khả năng thực hiện được những sơ đồ logic phức tạp 
bất kỳ, từ những vi mạch mật độ tích hợp thấp lập trình một lần đến những vi mạch mật 
độ tích hợp cao lập trình nhiều lần và còn cho phép lập trình ngay trên hệ thống mà 
không cần những thiết bị nạp chuyên dùng, do đó làm tăng độ linh hoạt cho thiết bị ứng 
dụng. 

MỤC TIÊU THỰC HIỆN 
• Hiểu được sự cần thiết và ý nghĩa trong thiết kế logic của họ PLDs 
• Biết cấu tạo sơ đồ logic, phân biệt giữa các họ PLDs   
• Biết phạm vi ứng dụng của từng loại PLD 
• Có một kiến thức chung về các phần mềm hổ trợ phát triên hệ logic ứng dụng 

PLD 

NỘI DUNG CHÍNH 
Nội dung bài học tập trung về các chủ đề chính như sau: 
• Lịch sử phát triển của PLD 
• Cấu trúc cơ bản của PLD 
• Các họ PLD trên thị trường 
• Các công cụ phần mềm hổ trợ thông dụng 
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1. LỊCH SỬ PHÁT TRIỂN 
      Trước thời kỳ vi mạch số lập trình (Programmable Logic Device) ra đời, thiết kế 

logic số truyền thống thường dùng nhiều vi mạch TTL loại MSI và SSI kết hợp lại để tạo 
ra các hàm logic mong muốn. Những nhà thiết kế dựa vào những sách tra cứu các vi 
mạch số để tìm hiểu chức năng và các thông số kỹ thuật, sau đó mới quyết định sử dụng 
các vi mạch số cần thiết cho yêu cầu thiết kế của họ. Điều bất lợi của việc thiết kế này là  
sử dụng nhiều vi mạch dẩn đến nhiều khuyết điễm như: Kích thước board mạch lớn, 
công suất tiêu thụ cao, dể hư hỏng, thi công khó khăn, tốn kém…Nói chung là không kinh 
tế nhất là với những yêu cầu điều khiển phức tạp.     

      Vào năm 1975,công ty SIGNETICS đã giới thiệu vi mạch số lập trình không có 
bộ nhớ đầu tiên 82S100 (hiện nay là PLS100)  gọi là mảng logic lập trình trường (Field-
Programmable Logic Array). Napoleon Cavlan, người được gọi là cha đẻ của mạch logic 
lập trình, lúc bấy giờ là nhà quản lý những ứng dụng PLA của Signetics đã thực sự hiểu 
rằng sử dụng PLA là phương pháp tốt hơn để thiết kế và thay đổi hệ thống số. Trong khi 
đó, công ty Harris đã sớm giới thiệu PROM, họ trình bày triển vọng  của PROM và đã ứng 
dụng vào trong một số mạch logic.  

      Công ty National Semiconductor đã chế tạo mặt nạ lập trình cho PLA, cấu tạo 
của nó gồm một mảng AND lập trình kèm với mảng OR lập trình, cho phép thực hiện tổ 
hợp tổng các tích số của hàm logic tiêu chuẩn. Bằng cách kết hợp công nghệ PROM sử 
dụng nguyên tắc cầu chì với khái niệm PLA, Cavian đã thuyết phục được các nhà quản lý 
công ty Signetics để đưa dự án PLAvào sản xuất. 

       Vi mạch PLA đầu tiên 82S100, là thành viên đầu tiên của họ vi mạch IFL 
(Intergrated Fuse Logic) có hình dạng 28 chân. Cấu trúc của PLA gồm một mảng AND lập 
trình và một mảng OR lập trình, nó cho phép thực hiện tổ hợp logic tổng của các tích số 
đơn giản . 

       Kỹ sư John Martin Birkner là một người quan tâm đến PLA, vì ông ấy hiểu rằng 
nhiều phương pháp  thiết kế logic được học trong trường thì không áp dụng được nhiều 
trong công việc hiện tại. Do đó, vào năm 1975 ông ấy đã rời thung lũng Silicon để đến 
công ty Monolithic Memories (MMI), đây là công ty chế tạo PROM và các vi mạch logic 
tiêu chuẩn. Vì vậy, Birkner có điều kiện hơn trong việc tìm hiểu PLA và công nhận những 
ưu điểm của mạch logic lập trình nhưng đồng thời ông cũng nhận ra khuyết điểm của 
PLA là có hai mảng lập trình. Sau đó, Birkner đã đưa ra khái niệm mới về vi mạch số lập 
trình, vi mạch này cũng tương tự  FLA nhưng thay vì có hai mảng lập trình thì PAL 
(Programmable Array Logic ) chỉ có một mảng AND lập trình và theo sau là mảng OR 
được giữ cố định (không lập trình ). Như vậy mỗi cổng OR sẽ có một tích số cố định được 
nối với ngỏ vào của nó, do vậy sẽ giảm được kích thước của vi mạch và cho phép tín 
hiệu được truyền nhanh hơn trong khi vẫn cho phép thực hiện các tổ hợp logic. PAL 
được đóng vỏ 20 chân. Sau một thời gian thuyết phục các nhà quản lý của công ty MMI 
thấy rõ những lợi điểm của PAL và đồng ý sản xuất. Vi mạch đầu tiên thuộc họ PAL được 
phổ biến là PAL 16L8, PAL 16R4, PAL 16R6, PAL 16R8. Các vi mạch này có thời gian 
truyền trì hoãn 35ns. Mỗi vi mạch có 8 ngõ ra và 16 ngõ vào, trong đó ký tự L trong ký 
hiệu của vi mạch biểu thị 8 tổ hợp ngỏ ra tác động ở mức thấp, ký tự R cho biết có 4, 6 
hay 8 thanh ghi ở ngỏ ra tương ứng. 

Sau một thời gian khởi đầu chậm, cuối cùng PAL đã được thiết kế trong hệ thống 
thực. Những công ty máy tính mini đã nhận thấy được ưu điểm của PAL là cho phép họ 
giảm số board cần thiết để thực hiện tốt những yêu cầu thiết kế, công ty MMI đã chọn 
phương pháp sản xuất PAL công đoạn mặt nạ chế tạo theo yêu cầu khách hàng. Vào lúc 
này MMI lại giới thiệu một  họ vi mạch mới HAL (Hard Array Logic) và để sản xuất những 
chi tiết này cho hãng Data General and Digital Equipment. MMI đã thay đổi cách sắp xếp 
công đoạn  mặt nạ cầu chì và thay vào đó là lớp  liên kết kim loại phù hợp yêu cầu thiết 
kế của khách hàng. Những chi tiết này có nhiều lợi ích gồm mang lại  những kết quả tốt 
và kiểm tra dễ dàng hơn. Đồng thời khách hàng cũng được lợi hơn bởi không phải quan 
tâm đến lập trình và kiểm tra các chi tiết. Điều này đã mang lại sự cải tiến về phương 
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pháp chế tạo PAL, và được sự chấp nhận của thị trường. Vào năm 1978, MMI đã xuất 
bản sách hướng dẫn PAL đầu tiên. Đó là một bước khởi đầu để PAL mở rộng thế giới 
của những người thiết  kế mạch logic. Ngoài ra trong sách hướng dẫn còn trình bày danh 
sách chương trình gốc của ngôn ngữ lập trình FORTRAN cho PALASM (PAL Assembler) 
đó là phần mềm dành cho việc thiết kế mạch logic PAL. PALASM có thể biên soạn, định 
nghĩa logic cho một khuôn thức. Ngoài ra PALASM cũng có khả năng mô phỏng sự vận 
hành trên phương trình mạch logic theo nguyên tắc PAL. Trong việc liên kết với  những 
nhà thiết kế để định rõ những “vector kiểm tra”, PALASM có thể là một  sự thật  phù hợp. 
Tất cả những đặc điểm của PAL bao  gồm việc khắc phục những khuyết  điểm của PLA 
kết hợp với việc thúc đẩy sử dụng PAL đã mang đến kết  quả tốt đẹp. PAL đã nhanh 
chóng vượt qua họ vi mạch IFL của công ty Signetics và được phổ biến trên thị trường, 
thuật ngữ PAL đã trở nên đồng nghĩa với PLD. 

Trong lúc ấy, công ty Signetics tiếp tục phát triển họ IFL, và vào năm 1977 Signetics 
giới thiệu họ vi mạch FPGA (Field Programmable Gate Array) 82S103, vào năm 1979 là 
họ FPLS (Field Programmable Logic Sequencer). Họ FPGA có cấu tạo một mảng AND ở 
mức đơn với ngỏ vào lập trình được và cực tính ngõ ra cũng vậy cho phép thực hiện các 
hàm logic cơ bản (AND, OR, NAND, NOR, INVERT), cấu trúc của họ FPLS có chức các 
FlipFlop để thực hiện các trạng thái của hàm tuần tự. Đồng thời Signetics cũng giới thiệu 
AMAZE (Automated Map and Zap Equations) là chương trình biên dịch để hổ trợ cho 
những vi mạch của họ. Tương tự, những công ty chế tạo PLD khác đã lần lược giới thiệu 
những phần mềm hỗ trợ của họ. 

Cả 2 công ty Signetics và MMI tiếp tục giới thiệu những PLD mới để đáp ứng tính 
đa dạng theo các yêu cầu thiết kế. Vào giữa năm 1980, mạch logic lập trình đã được thừa 
nhận cùng với sự phát triển tính đa dạng của IFL và PAL đã có nhiều giá trị cho những  
người thiết kế. Mặc dù sự khởi  đầu thành công của PLD, tuy nhiên chỉ một số ít các nhà 
thiết kế  quen với việc dùng PLD, một số trường đại học đã đưa vi mạch logic lập trình 
vào những khóa học thiết kế của họ.  

Tuy thế, kĩ thuật logic lập trình tiếp tục cải tiến và những vi mạch phát triển ở giai 
đoạn thứ hai được giới thiệu vào năm 1983. Công ty Advance Micro Devices ( AMD) đã 
giới thiệu PAL22V10 với những đặc điểm đặc biệt là sự linh động của những cổng PLD ở 
10 ngỏ vào. Mỗi cổng PLD có khả năng tổ hợp hoặc với thanh ghi ở ngỏ ra hoặc một ngỏ 
vào. Cổng đệm ngõ ra ba trạng thái được điều khiển bởi một tích số riêng cho phép vận 
hành hai chiều. Tất cả thanh ghi đều được reset tự động trong quá trình tắt hay mở và 
mỗi thanh ghi có khả năng “đặt trước”, đó là đặc điểm đặc biệt cho việc kiểm tra sau này. 

Với những vi mạch mới, được giới thiệu thường xuyên trên thị trường đã dẫn đến 
việc cần thiết phải có một phần mềm hỗ trợ trong quá trình sử dụng PLD để đạt hiệu quả 
cao. 

Bob Osann đã nhận thấy được sự cần thiết của một chương trình biên dịch PLD 
vạn năng dùng cho tất cả PLD của những công ty chế tạo khác nhau.  

Vào tháng 9/1983, Công ty Assisted Technology đã đưa ra phiên bản 1.01a của 
chương trình biên dịch PLD có tên là CUPL( Universal Compiler for Programmable). 
Chương trình này hỗ trợ cho 29 loại vi mạch, sự ra đời của CUPL đã gây được sự chú ý 
của nhiều công ty chế tạo. Công ty Data I/O, nhà chế tạo các vi mạch lập trình lớn nhất 
trên thế giới (EPROM, PROM, PLD), đã quyết định phát triển phần mềm hỗ trợ cho riêng 
họ. Năm 1984, Data I/O giới thiệu ABEL (Advanced Boolean Expression Language), đó là 
chương trình biên dịch PLD có đặc điểm tương tự như CUPL nhưng nó được đầu tư tiếp 
thị nên được các nhà thiết kế chấp nhận. Vì vậy, ABEL đã sớm theo kịp CUPL trên thị 
trường. 

Sự ra đời của chương trình biên dịch vạn năng cho PLD đã thúc đẩy nền công 
nghiệp thiết kế số sẵn sàng cho việc áp dụng PLD cho những thiết kế mới. Những 
chương trình biên dịch vạn năng này đã được cải tiến hơn so với các chương trình biên 
dịch PALASM và AMAZE, nó được cung cấp cho các nhà thiết kế để thực hiện các mạch 
logic và mô phỏng những thiết bị. Đó là những đặc điểm tiêu chuẩn của hai bộ biên dịch 
vạn năng CUPL và ABAL. JEDEC ( the Joint Electron Device Engineering Council) dự 
định sản xuất một bộ biên dịch PLD tạo ra một tiêu chuẩn để sử dụng cho tất cả các công 
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ty chế tạo PLD hiện nay và tương lai. Vào 10/1983, the JEDEC Solid State Products 
Engineering Council đưa ra tiêu chuẩn JEDEC thứ 3“. Tiêu chuẩn khuôn thức chuyển đổi 
giữa hệ thống tạo dữ liệu và thiết bị lập trình cho PLD”. Tháng 5/1986, JEDEC tiếp tục 
đưa ra tiêu chuẩn 3-A, tiêu chuẩn này trở thành tiêu chuẩn chung cho công nghiệp PLD. 

Tháng 7/1984, công ty Altera giới thiệu EP300. Đó là vi mạch sử dụng công nghệ 
CMOS của EPROM, nó có đặc tính là công suất tiêu thụ thấp, có thể xóa được (dùng tia 
cực tím) cùng một số đặc tính mở rộng khác.Năm 1985, một họ PLD  mới được công ty 
Lattice Semiconductor giới thiệu là GAL (Generic Array Logic). Lattice dùng công nghệ 
CMOS của EEPROM, có các đặc tính kỹ thuật như công suất thấp, có thể lập trình nhiều 
lần ( xóa bằng điện áp với thời gian xóa khoảng vài giây). Vi mạch đầu tiên của họ GAL 
được kí hiệu là GAL16V8 có khả năng thay thế hoạt động của PAL (đối với vi mạch cùng 
loại). 

Ngày càng nhiều công ty tham gia vào thị trường PLD để tạo ra những vi mạch đặc 
biệt và sử dụng nhiều công nghệ chế tạo khác nhau. Vào năm 1985, công ty Xilen tạo ra 
một họ mới  là LCA (Logic Call Array). Cấu trúc của LCA có 3 đoạn: một ma trận của khối 
logic được bao quanh là khối vào ra và một mạng đường dữ liệu nối gián tiếp. Đặc biệt 
của LCA là PLD đầu tiên sử dụng tế bào RAM động cho chức năng logic. Ưu điểm của 
cấu trúc này là khách hàng có thể kiểm tra được chương trình của vi mạch, do bản chất 
dễ xóa của LCA, nên cần phải lưu trữ  cấu hình của LCA ở bộ nhớ ngoài. Vì vậy, LCA 
không được sử dụng ở những trường hợp đòi hỏi sự hoạt động ngay lập tức khi khởi 
động máy. Đi kèm với LCA là chương trình soạn thảo XACT và bộ mô phỏng giúp cho 
việc sửa lỗi cho những thiết kế trên LCA được thuận tiện. 

Năm 1985, công ty Signetics với một khái niệm mới là PML (Programmable Macro 
Logic). Vi mạch PML đầu tiên của Signetics PMLS 501, vi mạch này sử dụng công nghệ 
lưỡng cực, và được đóng vỏ 52 chân . 

Vào năm 1986, công ty ExMicroelectronic giới thiệu họ ERASIC (Erasable 
Application Specific 7C)  sử dụng công nghệ EEPROM CMOS. Vi mạch đầu tiên là 
XL78C00 có dạng 24 chân và điều đặc biệt là XL78C00 có thể thay thế chức năng cho 
PAL và EPLA cùng loại (không tính đến tốc độ), đi kèm là một phần mềm hỗ trợ ERASIC.  

Vào năm 1986, công ty Signetics quyết định thay đổi họ IFL thành họ PLS 
(Programmable Logic From Signetics). Ví dụ như từ 82S100 thành PLS100, từ 82S157 
thành PLS157. Sau đó 2 năm, công ty Actel đã cải tiến khuyết điểm họ LCA là vi mạch có 
thể hoạt động không nhất thiết phải có bộ nhớ ngoài. Đồng thời công ty Gazelle 
Microcircuit đã công bố phát minh công nghệ GaAs  

(Gallium Arsenide). Đặc điểm của công nghệ này là cải tiến tốc độ , công suất của 
các vi mạch trên nền tảng là công nghệ silicon, cho phép vi mạch làm việc với tốc độ 
nhanh hơn công suất tiêu tán khi ở mức trung bình. 

Ưng dụng đầu tiên của công nghệ GaAs được công ty Gazelle đưa ra là phiên bản 
của PAL 22V10. Ưu điểm của mạch này là cho phép vi mạch GaAs có thể tương hợp với 
các vi mạchTTL, do đó công nghệ GaAS đã được ứng dụng rộng rãi. Sau một thời gian 
cải tiến không ngừng, những PLD thế hệ sau đã được ứng dụng rộng rãi trong kỹ thuật 
phần cứng, nó trở thành công cụ cần thiết cho những kỹ sư thiết kế. 

Sự phát triển trong công nghiệp PLD nói riêng và với công nghiệp bán dẫn nói 
chung đã tạo nên sự cạnh tranh của các công ty chế tạo PLD trên thế giới. Do đó, đã có 
nhiều xung đột xảy ra giữa các công ty trong việc cạnh tranh thị trường. 

Vào năm 1986 công ty MMI đã kiện hai công tyAltera và Lattic vì đã vi phạm bản 
quyền PAL. Kết quả là hai công ty này đã chấp nhận thua kiện và phải mua bản quyền. 
Sau đó công ty MMI mua cổ phần trong công ty Xilin và sở hữu bản quyền họ LCA. Sau 
đó 1 năm công ty MMI hợp với AMD trở thành một tập đoàn sản xuất các linh kiện bán 
dẫn hàng đầu trên thế giới. Tuy đã hợp nhất hai công ty nhưng họ vẫn tiếp tục phát triển 
các họ vi mạch hiện có vì những họ PLD này đã trở nên phổ biến trên thị trường. Vào 
năm 1987, công ty National Semiconductor đã mua lại công ty Fairchild và tiếp tục phát 
triển họ PAL FASTPLA trên thị trường. 
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2. CẤU TRÚC CƠ BẢN CỦA PLD 
Vi mạch số lập trình trải qua thời gian dài phát triển và cải tiến đã thực sự mở ra 

một hướng đi mới cho những nhà thiết kế. Ưu điểm của PLD là giải quyết được vô số 
những vấn đề thiết kế nhờ vào nhiều họ PLD  khác nhau. Những họ vi mạch này có cấu 
trúc và công nghệ chế tạo khác nhau, do đó chúng có những đặc điểm riêng để ứng dụng 
vào nhiều lĩnh vực trong công ngiệp. Mặc khác người thiết kế còn quan tâm đến các 
thông số kỹ thuật của vi mạch như tốc độ, công suất tiêu thụ, nguồn cung cấp và công cụ 
hỗ trợ để lập trình. 

2.1 Họ vi mạch PROM 
PROM gọi là bộ nhớ chỉ đọc lập trình được. Đây là họ vi mạch đầu tiên được sử 

dụng như là những vi mạch số lập trình theo quan điểm của vi mạch số. Cấu trúc của 
PROM rất đơn giản bao gồm một mảng tế bào nhớ với những đường điạ chỉ ngỏ vào và 
nhũng đường dữ liệu ngỏ ra. Số đường điạ chỉ và dữ liệu cho biết ma trận nhớ của 
PROM. Một PROM đơn giản được trình bày ở hình 1.1 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Hình 1.1 Cấu tạo PROM đơn giản 
 
        PROM có 5 đường điều khiển ngỏ vào cho phép tạo ra 32 tổ hợp logic và 8 

đường dữ liệu ra tạo thành một ma trận nhớ 32x8, vì vậy có tổng cộng 256 tế bào nhớ. 
Cấu trúc của PROM gồm một mảng AND cố định theo sau là mảng OR lập trình, được 
minh họa ở hình 1.2. 
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Hình 1.2 Sơ đồ logic của PROM 
 
 

Ghi chú: 
- Dấu x là những điểm nối lập trình được (kết nối bằng một cầu chì) 
- Dấu  là những điểm nối cố định 
 
Ở mảng AND cố định có 16 biến được chọn và liên kết với 4 tín hiệu ngõ vào mảng 

OR. Do đó bất kì một liên kết nào bị loại bỏ (nghĩa là cầu chì ở đó bị đứt, thì biến đó sẽ 
không có mặt ở biểu thức ngõ ra). Các hàm ở ngỏ ra thay đổi tùy thuộc vào sự kết nối 
của các biến ở ngõ vào. 

PROM thường được sử dụng để giải mã điạ chỉ và ứng dụng để lưu trữ dữ liệu. Khi 
thiết kế các PROM, nguời thiết kế phải chú ý đến sự thay đổi mức logic ngỏ vào (xảy ra 
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trong thời gian ngắn) khi địa chỉ ngõ vào thay đổi. Phương thức ghi của PROM là khi có 
một tín xung clock đồng bộ thì mạch ngõ ra chuyển sang trạng thái khác. Đặc điểm này 
sẽ giúp khắc phục được vấn đề tạp nhiễm ở PROM. 

Khi khảo sát PROM, người ta thường quan tâm đến tốc độ truy xuất dữ liệu. Thông 
thường các loại PROM có thời gian truy xuất dưới 60 ns. Các loại PROM thường sử dụng 
công nghệ lưỡng cực là nguyên tắc cơ bản để chế tạo. Tuy nhiên, khoa học tiến bộ đã 
phát minh ra công nghệ CMOS cho phép rút ngắn thời gian truy xuất. Công nghệ CMOS 
được dùng để chế tạo EPROM, đó là một dạng PROM có thể xóa được bằng tia cực tím. 
Nó đã tạo ra một bước tiến đáng kể như: EPROM WS57C256F của công ty  WaferScale 
Integration có dung lượng 32Kx8 với thời gian truy xuất là 55 ns, công ty  Cypress 
Semicondutor giới thiệu PROM CY7C245 có dung lượng là 2048x8 với thời gian truy xuất 
là 25 ns. 

Trên đây là một vài ví dụ cho thấy công nghệ CMOS được chấp nhận cho những 
ứng dụng thiết kế mạch. 

2.2 Họ vi mạch FPLA ( Field Progammable Logic Array) 
Họ vi mạch FPLA đầu tiên được công ty Signetics giới thiệu vào năm 1975. Cấu 

trúc của FPLA là một mảng AND – OR đơn giản, được trình bày ở hình 3. 3. 
 

Hình 1.3 Sơ đồ biểu thức ngỏ ra của FPLA 
 
 

Mảng AND – OR có thể lập trình để thực hiện 4 hàm logic bất kì với hai biến ngõ 
vào. Mỗi biến ngõ vào được đưa qua cổng đệm để tạo hai mức logic 0 và 1. Mỗi mức 
logic này được nối với ngõ vào cổng AND thông qua một cầu chì lập trình. Tất cả 4 cầu 
chì được giữ nguyên. 

Nếu tất cả cầu chì đều thông, ví dụ như cổng AND có hai ngỏ vào là A và B, ngỏ ra 
là K thì biểu thức ngõ ra cho cổng sẽ là: 

C            B           A 

             O3         O2         O1         O0 
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B.B.AA.K =  

 
Từ kết quả trên cho thấy ngỏ ra của cổng AND luôn ở mức thấp, điều này không có 

lợi. Tuy nhiên nếu ta lập trình cho 4 cầu chì trên, ví dụ ta chọn A x B, lúc này giá trị của 2 
biến này sẽ không có trong biểu thức. 

Biểu thức ngỏ ra của cổng lúc này là; K = A.B 
Nguyên tắc ở đây là lựa chọn những giá trị để lập trình, khi một cầu chì được chọn 

nghĩa là giá trị của nó sẽ không có mặt trong biểu thức. 
Lưu ý mảng OR trong mạch ở hình 1.4. Mỗi ngỏ ra cổng AND được nối tới 1 ngỏ 

vào cổng OR thông qua một cầu chì và một Diode. Xét biểu thức F1 giả sử các cầu chì 
đều thông, ta có : 

 
F1= K + L+ M + N 
 
       Với K,L,M,N là những tích số của AXB, F1 là tổng các tích so của hai biến A và 

B. Bây giờ ta sẽ lập trình bằng cách làm đứt các cầu chì thì các số hạng ứng với những 
cầu chì bị đứt sẽ không có mặt trong biểu thức. Bằng cách lập trình các cầu chì ở mảng 
AND – OR (nghĩa là loại bỏ giá trị giá trị của nó trong biểu thức) FPLA có thể tạo ra các 
hàm logic khác nhau theo mạch thiết kế chỉ với hai biến ngỏ vào. Lưu ý những Diode 
trong mảng OR được dùng để bảo vệ ngắn mạch. 

Sơ đồ mạch trong hình 1.4 là một ví dự đơn giản của họ vi mạch mảng logic lập 
trình trường. Nếu vi mạch do công ty chế tạo đã được lập trình  bằng công đoạn mặt nạ 
với công nghệ lưỡng cực thì chương trtình cố định không thay đổi được. Do đó vi mạch 
này được gọi là PLA. Nếu vi mạch được sản xuất để người sử dụng có thể lập trình thì 
gọi là FPLA 
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Hình 1.4 Sơ đồ logic FPLA  PLS153 
 

2.3 Họ vi mạch FPLS ( Field Programable Logic Sequencer) 
Họ FPLS được giới thiệu vào năm 1979, FPLS có cấu trúc mô phỏng theo cấu trúc 

của FPLA nhưng được bổ sung thêm những thanh ghi cho phép “preloading” trạng thái 
của thiết bị. Một vài thanh ghi ở ngỏ ra được đưa hồi tiếp về mảng AND lập trình và một 
số khác có những thanh ghi ngầm (những thanh ghi được bổ sung trên chíp và không nối 
với chân của ngỏ vào hay ngõ ra) bổ sung với thanh ghi ngỏ ra, nó có thể hồi tiếp hoặc 
không hồi tiếp. 
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Hình 1.5 Sơ đồ logic FPLS PLS 157 

 
 

Sơ đồ logic của vi mạch PLS157 được công ty Signetics giới thiệu được trình bày ở 
hình 1.5, có hình dáng bên ngoài 20 chân, có cấu trúc16x45x12. PLS157 có 6 thanh ghi 
và 6 tổ hợp ở ngõ ra. Các tổ hợp ở ngõ ra có chức năng nhất, những thanh ghi được cấu 
tạo bằng những cổng đảo M(M0-M5). Cấu trúc mới của PLS157 có những đặc điểm đáng 
lưu ý là những thanh ghi cho phép chốt những tín hiệu ở ngõ vào và những tín hiệu này 
được đưa tới mảng AND. Ngoài ra vi mạch còn được thiết kế một mảng bổ sung (mảng 
bù). Đây là tổng số hạng bù và được thực hiện như một ngỏ vào của mảng AND, nó cho 
phép bổ sung thêm nhiều tổ hợp. 
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2.4 Ho vi mạch FPGA ( Field Progammable Gate Array). 

Họ FPGA được Signetics giới thiệu vào năm 1977 được sử dụng để thay thế cho 
những cổng nhiều ngõ vào tiêu chuẩn, cấu trúc của nó bao gồm một mảng AND lập trình, 
với lập trình cực tính ở ngõ ra. Chỉ với một cổng AND có thể biến đổi thành cổng NAND, 
NOR hay cổng OR. Mỗi cổng AND trong FPGA có thể biến đổi thành các cổng logic khác 
nhau. 

FPGA cũng được bổ sung linh động hơn những cổng tiêu chuẩn khác. Vi mạch đại 
diện cho họ FPGA là PLS151, có hình dáng 20 chân được trình bày ở hình 3.6. PLS151 
có 6 ngỏ vào, 12 ngõ ra và có tín hiệu hồi tiếp đưa về mảng AND được sử dụng như 
những ngõ vào. Có thêm 3 tích số được tạo ra bởi 3 đường điều khiển, các tín hiệu này 
điều khiển những cổng đệm ngỏ ra 3 trạng thái. FPGA thích hợp trong các thiết kế để giải 
mã địa chỉ và được thêm vào các chức năng khác. 

 
2.5 Ho vi mạch  PAL ( Programmable Array Logic). 

PAL là một họ phổ biến nhất trong họ PLD được MONOLITHIC MEMORIES INC 
giới thiệu vào năm 1978. PAL được đăng ký bản quyền về cấu trúc của công ty MMI. Cấu 
trúc của PAL bao gồm một mảng AND lập trình theo sau là một mảng OR cố định, cấu 
trúc này được cải tiến từ những khuyết điểm của họ FPLA. Hình 3.7 minh họa cho cấu 
trúc đơn giản của PAL. Do loại bỏ việc sử dụng cầu chì ở mảng OR, do đó số lượng tinh 
thể Silicon được sử dụng giảm, dẫn đến giá thành của PAL thấp hơn so với FPLA. Mặt 
khác thời gian trì hoãn của PAL ngắn hơn so với FPLA do giảm được sự trì hoãn khi 
truyền qua mảng OR. 

Khảo sát PAL16L8 có hình dáng 20 chân sơ đồ logic được trình bày  ở hình 3.8. Vi 
mạch này có 8 tổ hợp ngõ ra, mỗi ngõ ra được đảo với 7 tích số của ngõ vào, 6 trong 8 
ngõ ra được hồi tiếp về mảng AND, cho phép những chân này được sử dụng với chức 
năng I/O. Do PAL16L8 có ngõ ra tác động ở mức thấp nên nó có thể kết hợp với các IC 
khác cùng một mức tác động. 
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Hình 1.6 Sơ đồ logic FPGA  PLS 151 
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hình 1.7 Sơ đồ logic của PAL 
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Hình 1.8 Sơ đồ logic PAL 16L8 
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PAL16L8 được ứng dụng trong lĩnh vực giải mã địa chỉ, nó thuận tiện trong việc kết 

hợp với các bộ vi xử lý và thiết bị ngoại vi vì cùng một mức tác động. Với những đặc tính 
như tốc độ tương đối cao, giá thành thấp, thời gian truyền trì hoãn khoảng 7,5ns nên 
PAL16L8 rất phổ biến trong công nghiệp PLD. Ngoài ra PAL16L8 có một đặc điểm mới so 
với các họ trước là có cầu chì bảo vệ, nó dùng để chống sự sao chép, giúp bảo vệ nội 
dung bên trong. Ngoài PAL16L8 công ty MMI còn giới thiệu các loại vi mạch khác như 
PAL16R4, PAL16R6, PAL16R8. Các vi mạch này có cấu tạo giống như PAL16L8 nhưng 
ở ngõ ra sử dụng thêm các FF D để chốt tín hiệu ngỏ ra. 

Một thế hệ vi mạch PAL được công ty AMD giới thiệu là PAL22V10 với hình dáng 
24 chân được chế tạo bằng công nghệ CMOS thay thế cho công nghệ lưỡng cực. Đặc 
trưng của vi mạch này là ở ngỏ ra được cho qua cổng PLD. 

Ngoài việc tăng số biến ngỏ vào vi mạch này còn có một số đặc điểm nữa là trong 
hàm logic các thành phần tích số có thể thay đổi từ 8 đến 16 biến. Điều này sẽ giúp cho vi 
mạch thực hiện nhiều phương trình phức tạp. Nhờ vào cấu tạo ở ngỏ ra các cổng PLD 
nên các ngỏ ra hoặc vào của vi mạch có đặc tính giao tiếp 2 chiều, điều này làm tăng khả 
năng xử lý của vi mạch và tạo sự thuận lợi cho việc thiết kế. Do những đặc điểm đã được 
cải tiến nên các thế hệ vi mạch PAL được phổ biến rộng rãi (đặc biệt là nhóm vi mạch 20 
chân) và PAL được xem là họ vi mạch đại diện cho họ vi mạch số lập trình. 

Ngoài ra các công ty chế tạo PAL có chọn lựa trong việc ký hiệu các số trên một vi 
mạch. Điều này cung cấp cho người sử dụng những thông tin cần thiết có liên quan đến 
ứng dụng của vi mạch. Các ký hiệu trong việc đánh số của họ PAL nói chung bao gồm 2 
số đếm được tách rời nhau bởi 1 hay 2 ký tự. Số đần tiên trong tên vi mạch cho biết số 
ngõ vào của vi mạch (đây chính là số biến ngõ vào của mảng AND). Số thứ hai biểu thị số 
ngỏ ra của vi mạch. Ký tự nằm giữa 2 số chỉ ra ý nghĩa các thuộc tính của ngỏ ra. Một số 
mã ký tự có ý nghĩa là: 

   H  tác động mức thấp. 
 L  tác động mức cao. 
 P  tác động ngỏ ra có thể lập trình. 
 C  phần bổ sung các ngỏ ra. 
   S  bộ tuần tự. 
Các ký hiệu của vi mạch họ PAL được xem là những hướng dẫn cơ bản của vi 

mạch. Ngoài ra các công ty chế tạo còn cung cấp bản thông số kỹ thuật và sơ đồ logic 
của vi mạch kèm theo để làm tài liệu tham khảo cho các nhà thiết kế.  

 
2.6 Họ vi mạch GAL ( Generic Array Logic). 

GAL là một nhóm của công nghệ EEPLD, nó được giới thiệu và phát triển bởi công 
ty Lattice Semiconductor Comp. Công ty này đã đưa ra một khái niệm về cổng PLD có ký 
hiệu là OLMCs (Output Logic Macrocells).  
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Hình 1.9 Sơ đồ logic GAL 
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Vi mạch này cũng có những đặc điểm là có thể xóa bằng điện và lập trình lại bằng 
các phần mềm và công cụ hỗ trợ. Khảo sát cấu trúc của vi mạch GAL16V8 được trình 
bày ở hình 1.10, GAL16V8 có hình dạng 20 chân là một vi mạch phổ biến trong họ GAL. 

Mỗi một OLMC có 8 ngỏ vào tương đương với 8 tích số trong một biểu thức. Ngoài 
ra OLMC cũng có tín hiệu hồi tiếp đưa về để điều khiển, tín hiệu xung đồng hồ, tín hiệu 
hồi tiếp về mảng AND. Các vi mạch GAL đều có hỗ trợ những thanh ghi “Preload”, điều 
này có ích trong việc kiểm tra vi mạch. Mặt khác một thế hệ vi mạch mới được phát triển 
là vi mạch lập trình hệ thống ký hiệu là ispEELD (In-system Progammable). 

Vi mạch đầu tiên là ispGAL16Z8, cấu trúc của nó gần giống với GAL16V8 nhưng 
được thêm vào 4 chân để điều khiển lập trình. Trong hệ thống ispGAL16Z8 cho phép chu 
kỳ lập trình là 10000 lần và dữ liệu được giữ cố định trong khoảng thời gian 20 năm. Đó 
cũng là quy định của những vi mạch theo nguyên tắc EPROM. Cấu trúc của họ GAL là sự 
lặp lại cấu trúc của họ PAL và những đặc điểm của họ GAL đưọc thiết kế để kết hợp với 
những vi mạch họ PAL. Điều này được thể hiện qua việc ký hiệu  các vi mạch họ GAL và 
cấu trúc tế bào bảo vệ của nó. 

2.7 Họ vi mạch PEEL (Progammable Electrially Erasable Logic). 
Họ PEEL được công ty International Cmos Technology INC giới thiệu. Nó được chế 

tạo với công nghệ EEPROM. Cấu trúc của PEEL cũng tương tự như PAL và GAL, nó 
được xóa bằng điện và lập trình cũng nhờ vào phần mềm hỗ trợ. Khảo sát vi mạch 
PEEL18CV8 được trình bày ở hình 1.10. 

Vi mạch có 20 chân với 8 ngỏ ra được cấu tạo bởi cổng PLD, mỗi ngõ ra có 8 tích 
số trong một hàm của biểu thức và có một tích số riêng để điều khiển cổng đệm ngỏ ra. 
Cực tính ngỏ ra cũng được lập trình các thanh ghi ở ngỏ ra của vi mạch được Reset  
không đồng bộ, ngoài ra các thanh ghi có thể được chốt bên trong khi ngỏ ra được điều 
khiển bởi một biểu thức của tổng các số hạng của ngỏ vào. Đặc điểm này được cải tiến 
hơn số với các vi mạch PAL16V10 hay GAL16V8. 
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Hình 1.10 GAL 16V8 

 
      Công ty Altera lần đầu tiên giới thiệu thuật ngữ xóa các PLD bằng tia cực tím và 

nó đã trở thành thuật ngữ chung cho công nghệ PLD để tham khảo cho các vi mạch lập 
trình xóa bằng tia cực tím. Từ khi khởi đầu, công ty Altera thay đổi công  nghệ chế tạo 
PLD từ công nghệ lưỡng cực sang công nghệ CMOS vì công nghệ CMOS đạt được hiệu 
suất cao về không gian (mật độ tích hợp cao hơn). Như PAL16L8 có mật độ tích hợp từ 
100 lên 150 cổng, PAL22V10 có 500 đến 600 cổng và EP310 (là vi mạch đại diện cho họ 
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EPLD) có trên 1000 cổng. Hình 3.12 trình bày sơ đồ khối của EP310 có 20 chân cấu trúc 
gồm 8 cổng PLD, xung xóa không đồng bộ và có thể đặt trước các tích số. 

Cấu trúc của cổng PLD bao gồm cả khối điều khiển cấu trúc I/O. Cấu hình của ACB 
giống như cấu trúc của cổng PLD của vi mạch PAL và GAL nhưng có chức năng hoạt 
động đơn giản hơn. Trong đó mỗi cổng có 8 biến ngỏ vào cùng với một biến để điều 
khiển cổng đệm ngỏ ra. Nhờ vào cấu trúc ACB I/O mà EP310 có các tín hiệu tổ hợp ngỏ 
ra tác động ở mức cao hoặc thấp hay các tín hiệu được ghi cũng tác động ở mức cao 
hoặc thấp. Đối với tín hiệu hồi tiếp về mảng AND được đưa về từ thanh ghi ở ngỏ ra. Các 
cổng đệm ngỏ ra được điều khiển bằng các biến riêng cho phép các chân của vi mạch có 
thể hoạt động hai chiều. Ngoài ra EP310 cũng có cầu chì bảo vệ chống sao chép và giờ 
đây cầu chì bảo vệ trở thành một tiêu chuẩn cho các thế hệ PLD mới. Một số vi mạch tiêu 
biểu cho họ EPLD là EP900, có cấu tạo 40 chân, bên trong có 24 khối ACB, mật độ tích 
hợp hơn 1000 cổng với các tổ hợp ngỏ ra có lựa chọn. Nhưng trong tương lai kỹ thuật 
ngày càng phát triển thì mật độ tích hợp có thể lên đến hơn 10000 cổng logic trong một 
chip.  

Ngoài vi mạch EP900 thì công ty Altera còn giới thiệu vi mạch EP1800 có 68 chân 
với các chức năng được mở rộng hơn so với EP900 vì số cổng logic trong IC được tăng 
gấp đôi và số ngỏ vào cũng vậy. Vi mạch EP1800 có thể thực hiện đồng thời 4 chức năng 
khác nhau, có thể xem như đó là 4 vi mạch rời. Những vi mạch số lập trình đang hướng 
đến mật độ tích hợp trên 1000 cổng logic trong một chip thì đang gây ảnh hưởng đến các 
PLD có mật độ tích hợp thấp. Công ty Cypress Semicondutor đang sản xuất các sản 
phẩm ứng dụng công nghệ CMOS có tốc độ cao. Sản phẩm cạnh tranh của họ chủ yếu là 
các họ PAL thông thường và PAL 22V10 đã tạo ra thế hệ PAL có công suất thấp, tốc độ 
cao nên được ứng dụng rộng rãi vào các lĩnh vực công nghiệp khác nhau. Những vi 
mạch phổ biến của công ty Cypress Semicondutor như CY7C330, CY7C331 và 
CY7C332. 
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Hình 1.11 Sơ đồ logic EP310 
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Hình 1.12 Sơ đồ logic  EPLD EP900 
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2.8 Họ vi mạch PML ( Programmable Macro Logic). 
Họ vi mạch được công ty Signetics sử dụng cấu trúc mới gọi là “foldback” (gấp về). 

Mạch logic “foldback” sử dụng một cổng NAND đơn hay mảng NOR kết hợp với một cấu 
trúc liên kết lập trình trung tâm cho phép thực hiện nhiều mức logic khác nhau để liên kết 
với macro ngỏ vào và ngỏ ra. Như trong họ vi mạch PML, một mảng NAND được sử 
dụng vì cổng NAND có tốc độ truyền nhanh nhất  trong công nghệ lưỡng cực. 

Từ khóa macro để tham khảo một khối chức năng và có thể xác định một tín hiệu 
ngỏ vào, một cổng đệm ngỏ ra hay bất cứ một hàm logic nào như FF, mạch đếm hay 
mạch tổ hợp. Công ty Signetics phân loại các macro như sau: ngỏ vào là macro ngỏ vào, 
macro ngỏ ra và những khối chức năng khác như thanh ghi hay mạch tổ hợp thì gọi là 
macro chức năng. Macro của họ ML mô tả ở hình 1.13. So với cấu trúc mảng AND – OR 
của các họ IC PAL và FPLA thì cấu trúc mảng NAND phức tạp hơn. Để đơn giản cho việc 
tìm hiểu, xét ví dụ sau: 

Hình 1.14 a trình bày một mạch logic đơn giản sử dụng cấu trúc AND – OR của họ 
vi mạch PAL và hình 3.14 b sử dụng cấu trúc NAND – NAND với chức năng tương tự 
nhưng có ưu điểm là không bị giới hạn với các hàm có hơn 2 cấp logic. Mặc khác, cấu 
trúc của PML tận dụng tối đa các cổng logic và các khả năng hoạt động của vi mạch.        

Ví dụ như ở họ PAL và FPLA khi cần thêm một biến ở ngỏ vào sẽ chọn đường tín 
hiệu ngỏ ra xem như một đường tín hiệu ngỏ vào, do đó sẽ làm tăng thời gian truyền và 
lãng phí một ngỏ ra. Đối với họ PML thì tất cả các ngỏ vào của cổng NAND được sử dụng 
như là ngỏ vào của tín hiệu và các hàm logic được thực hiện với cấu trúc 3 cấp logic. Vi 
mạch đại diện cho họ PML là PLHS 501 có cấu tạo gồm 72 cổng NAND trong đó có 44 
cổng NAND được dùng để hỗ trợ cho macro ngỏ ra. Vi mạch có 24 ngỏ vào, 8 cổng đệm 
XOR ở ngỏ ra với 4 cổng tác động ở mức thấp , có 4 cổng tác động ở mức cao và có 8 
đường dữ liệu 2 chiều. Vi mạch có 52 chân với kiểu chân theo dạng PLCC. Hình 3.15 
trình bày cấu trúc của PLHS 501 . 

Các cổng đệm ngỏ ra 3 trạng thái được điều khiển bằng từng cổng NAND riêng để 
tạo nên tính linh hoạt trong thiết kế. 
 

 

 
 

Hình 1.13 Sơ đồ logic lập trình macro 
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Hình 1.14 Mạch logic cấu trúc Flodback 
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Hình 1.15 Mạch lật RS và D xử dụng cấu trúc PML 
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Hình 1.16 Sơ đồ logic PLS 501 
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2.9 Họ vi mạch ERASIC(Erasable Programmable Application Specific IC). 
Họ vi mạch ERASIC được giới thiệu bởi công ty Exel Microeletronics có cấu trúc 

tương tự như họ PML nhưng được chế tạo bằng công nghệ CMOS EEPROM  khác với 
họ PML dùng công nghệ lưỡng cực . Một đặc điểm khác biệt nữa là họ ERASIS sử dụng 
cấu trúc mảng NOR , vì trong công nghệ CMOS cổng NOR có thời gian truyền nhanh 
nhất. Vi mạch đầu tiên của họ này là XL 78C800 có 24 chân với mật độ thích hợp khoảng 
800 cổng.  

XL78C800 có 12 ngỏ vào và 10 chân I/O được liên kết với các cổng lập trình. Chân 
số 1 là đường cung cấp tín hiệu xung clock cho FF JK, chân 13 dùng để điều khiển các 
cổng đệm ngỏ ra cho các cổng lập trình, 8 ngỏ vào được đưa vào mảng NOR thông qua 
các mạch lật, 2 cổng NOR được sử dụng để điều khiển mạch lật. Ngỏ ra của cổng NOR 
được cấu tạo bằng các khối PCE (Polarity Control Element ) để tăng tính ling hoạt. 

XL78C800 có 32 biến ở ngỏ vào cổng NOR, hai biến dùng để điều khiển mạch lật 
và có 30 biến dùng cho cổng lập trình.      

Hình 1.17 trình bày sơ đồ logic của cổng lập trìnhtrong vi mạch XL78C800.Có ba 
ngỏ vào của tín hiệu J,K,O được đưa vào cổng lập trình.Với hai biến J,K để điều khiển FF 
JK. Từ cổng lập trình cũng có 4 đường tín hiệu được đưa về mảng NOR. Chân của vi 
mạch kết hợp với các cổng lập trình được kết nối với ngỏ vào của bộ đa hợp (IN-MUX) và 
nối với cổng đệm ngỏ ra. Ngoài ra còn có các đường tín hiệu xung clock và xung xóa 
không đồng bộ cho FF JK, một đường tín hiệu OE để điều khiển cổng đệm ngỏ ra. Bộ đa 
hợp ngỏ ra sẽ lựa chọn các tín hiệu từ biến O hay từ ngỏ ra của FF JK. Ở IN- MUX cho 
phép tín hiệu vào đi mới mảng NOR từ chân IC hay từ biến O của mảng NOR. Chân điều 
khiển của bộ đa hợp ngỏ ra OE-MUX dùng để điều khiển cổng đệm ngỏ ra hoạt động 1 
chiều hay 2 chiều hay ở trang thái tổng trở cao. Sơ đồ cổng lập trình ở hình 1.17 

Sơ đồ cổng lập trình trên trình bày 3 chế độ làm việc của vi mạch. Thời gian truyền 
của vi mạch họ ERASIC là 35 ns cộng với thời gian truyền qua mảng NOR là 20 ns do đó 
thời gian truyền của vi mạch là 55 ns, dòng tiêu thụ 35 mA, so với dòng tiêu thụ của 
PLHS 501 là 250 mA. Qua sự so sánh trên cho thấy công suất tiêu thụ của họ ERASIC 
thấp hơn họ PML, đó là ưu điểm của công nghệ CMOS.  
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Hình 2.17 Cổng lập trình ERASIC XL78E800 

 
 

2.10 Họ vi mạch LCA ( Logic Cell Array) 
Họ LCA được công ty Xillinx giới thiệu dựa theo các cấu trúc của công ty MMI, đã 

trình bày một cấu trúc độc đáo trong các họ của PLD. Cấu trúc truyền thống của các họ vi 
mạch PAL và FPLA là các mảng AND – OR. Các cổng lập trình có cấu trúc của họ LCA 
gọi là cấu trúc lập trình cho người sử dụng. Đặc biệt là trong cấu tạo của LCA, họ dùng 
RAM động để tạo ra các chức năng logic theo yêu cầu thiết kế. Nhược điểm của các tế 
bào RAM động thường không ổn định. Do đó các chức năng sẽ trở lại trạng thái ban đầu 
khi mất điện. Để hỗ trợ cho vấn đề này họ sử dụng thêm phương pháp lưu trữ mới có 
chức năng tương tự như ROM. Cấu trúc của LCA được mô tả ở hình 3.18, bao gồm một 
khối IOB bao quanh ma trận của khối LCB. 
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Hình 2.18 Cấu trúc LCA 
 
 
Liên kết các đường tín hiệu dọc và ngang giữa 2 khối giúp cho việc kết nối giữa 2 

khối thêm thuận tiện. Vi mạch đầu tiên của họ LCA là XC 2064, có mật độ thích hợp khá 
phức tạp khoảng 1200 cổng logic, 58 khối IOB cùng một ma trận 8x8 hàng và cột tạo ra 
64 khối CLB. Tạo ra một vi mạch khác là   XC 2018 có mật độ tích hợp khoảng 1800 
cổng, có 74 khối IOB cùng một ma trận 10x10 tạo ra 100 khối CLB. Vi mạch có các 
đường tín hiệu xung clock, tín hiệu reset đặc biệt và mạch tạo dao động thạch anh bên 
trong IC dùng để kết nối với các phần tử dao động bằng thạch anh bên ngoài.  

Hình 1.19  trình bày sơ đồ của khối IOB, bao gồm 1 cổng đệm ngỏ vào, bộ đa hợp 
IN – MUX và FFD. Mức điện áp ngưỡng ở ngỏ vào cổng đệm thích hợp cho cả hai họ 
TTL và CMOS. Ngỏ ra của FFD được nối với ngỏ vào của bộ đa hợp và ở ngỏ ra của bộ 
đa hợp có thể nối 1 hay nhiều khối CLB. Ngỏ ra của khối IOB gồm 1 cổng đệm 3 trạng 
thái được nối thẳng tới chân IC. 
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Hình 2.19 Cấu trúc khối vào/ra (IOB) của LCA 
 

3. PHẦN MỀM HỔ TRỢ PLD 
Các phần mềm hỗ trợ cho các vi mạch lập trình được các công ty phát triển liên tục, 

ngày càng có nhiều tính đa dạng, có thể hỗ trợ cho nhiều loại vi mạch khác nhau nên có 
tính cạnh tranh mạnh mẽ trong thị trường vi mạch lập trình. 

3.1 Phần mềm PALASM 2 (PAL Assembler) 
PALASM 2 của công ty MMI là phần mềm tiêu chuẩn cho các vi mạch lập trình. Đây 

là bộ biên dịch thế hệ thứ 2 hỗ trợ cho các vi mạch hoạt động không đồng bộ, như các vi 
mạch họ PAL của công ty MMI, vi mạch họ PLA và các vi mạch của công ty AMD. 

 
3.2 Phần mềm AMAZE. 

Phần mềm AMAZE được công ty Signetics phát triển và nó được cung cấp cho các 
khách hàng sử dụng vi mạch lập trình của công ty. Module chính của phần mềm AMAZE 
là BLAST ( Boolean logic & State Transfer) dùng để biên dịch các thông tin ngỏ vào 
chuyển đổi sang các file chương trình chuẩn của Signetics (các file có phần mở rộng là  ‘ 
STD ’). AMAZE hỗ trợ để mô phỏng các vectơ kiểm tra để thiết kế theo yêu cầu của 
người sử dụng. 

 
3.3 Phần mềm PLAN ( Programmable Logic Analysis). 

Phần mềm PLAN được công ty National Semiconductor giới thiệu hỗ trợ cho các vi 
mạch lập trình cở vừa và nhỏ. PLAN là một ngôn ngữ đơn giản, dùng để thực hiện các 
biểu thức của đại số Boolean và có khả năng giao tiếp với các công cụ lập trình để lập 
trình cho vi mạch. 
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nhưng có khả năng kiểm tra lỗi tổng quát. Ngoài ra HELD còn yêu cầu các phương trình 
ngõ vào ở dạng tổng các tích ( SOP). 

 
3.5 Phần mềm PLPL (Programmable Logic Programming Language). 

PLPL được công ty Avanced Micro Devices giới thiệu vào năm 1984. Đây là phần 
mềm tiến bộ nhất so với các phấn mềm trước, có những đặc điểm mới và khả năng cài 
đặt được mở rộng hơn so với phần mềm AMAZE. Những đặc điểm mới như cho phép 
định nghĩa và sử dụng các chân của vi mạch cho một nhóm tín hiệu cũng như sử dụng 
các phương trình của đại số Boolean. PLPL cũng hỗ trợ các phương trình phức tạp có 
nhiều cấp logic khác nhau. Ngoài ra bộ biên dịch này cũng để ứng dụng nguyên lí 
Demorgan, các hàm của đại số Boolean nhưng không bắt được ở dạng tổng của các tích 
do đó cho phép cú pháp linh hoạt hơn. 

 
3.6 Phần mềm APEEL (Assembler for Programmable Electrically Erasable 
Logic). 

Vào năm 1987, Công ty International Cmos Technology giới thiệu trình biên dịch 
APEEL. APEEL là một trình biên dịch đơn giản phù hợp với các yêu cầu thiết kế vừa và 
nhỏ và có chức năng mô phỏng. APEEL gồm một chương trình soạn thảo toàn màn hình 
và ở ngỏ ra theo tiêu chuẩn của JEDEC. Nhưng khuyết điểm của bộ biên dịch này là 
không hỗ trợ để tối giản các biểu thức logic. Phần mềm APEEL cài đặt trên các máy tính 
cá nhân của công ty IBM và các công ty khác thích hợp với nó. 

 
3.7 Phần mềm IPLDS II (Intel Programmable Logic Devolopment System 
II). 

Phần mềm IPLDS II được công ty Intel giới thiệu để hỗ trợ cho các vi mạch họ 
EPLD. Điều cơ bản của phần mềm này là cho phép thiết kế theo 2 phương pháp là 
phương pháp dùng phương trình đại số Boolean và phương pháp liệt kê các lệnh. Để tối 
giảng các biểu thức logic IPLDS II sử dụng thuật giải đơn giản ESPRESSO II – MV. Đó là 
thuật giải được phát triển bởi đại học California, nó được dùng để thực hiện việc rút gọn 
các tích số trong các hàm logic của các vi mạch do công ty Intel sản xuất. Tương tự như 
các phần mềm trước, IPLDS II cài đặt được trong các máy tính của công ty IBM và các 
máy tính khác có cấu hình thích hợp, được sử dụng kèm với công cụ lập trình cho vi 
mạch. 

 
3.8 Phần mềm CUPL ( Universal Compiler for Programmable Logic ). 

CUPL được công tyAssited Technology giới thiệu vào năm 1983. Đây là bộ biên 
dịch vạn năng được hỗ trợ cho 29 loại vi mạch các loại kể cả PROM và các công ty chế 
tạo vi mạch lập trình khác. CUPL là một ngôn ngữ mạnh hỗ trợ cho các phương trình của 
đại số Boolean , bảng sự thật và thiết kế sơ đồ trạng thái, CUPL được sử dụng hầu hết 
các máy vi tính cá nhân trên các hệ điều hành khác nhau như trên máy vi tính của công ty 
IBM hay CP/M, VAX/ UNIX và VAX/ VMS. 

 
3.9 Phần mềm ABEL (Advanced Boolean Expression Language). 

ABEL là phần mềm của công ty Data I/0, nó được sử dụng hầu hết các loại vi mạch 
lập trình khác nhau kể cả EPROM. Đây là bộ biên dịch vạn năng có nhiều chức năng hỗ 
trợ tương tự như CUPL. 

       Trên đây là giới thiệu sơ lược các phần mềm hỗ trợ cho vi mạch lập trình để 
soạn thảo và lập trình cho các vi mạch. Ngoài ra còn nhiều phần mềm của các công ty 
khác được sản xuất để hỗ trợ cho các vi mạch lập trình của họ. 

Sau đây là bảng tóm tắt các ngôn ngữ thiết kế cho các vi mạch lập trình 
 
 

Phần mềm Hỗ trợ cho Phương trình Bảng sự Sơ đồ Dạng Rút gọn 
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các vi 
mạch 

đại số 
Boolean 

thật nguyên 
lý 

sóng biểu thức 
logic 

PALASM 2 
(MMI) 

AMAZE 
(Signetics) 

PLAN 
(National) 

HELP 
(Harris) 
PLPL 
(AMD) 
APEEL 
(ICT) 

A+PLUS 
(Altera) 
iPLDS II 
(Intel) 

ERASIC 
(Exel) 
CUPL 

(Logical Dev) 
ABEL 

(Data I/O) 
ELDS 

(Pistohl) 
LOG/IC 
(Elan) 

PLDesigner 
(Minc) 
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X 
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X: Chỉ hổ trợ cho vi mạch của chính hảng 
Xx: Hổ trợ cho nhiều loại vi mạch khác 
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BÀI 2 
 
 

Tên bài: Mãng logic lập trình Mã bài: CIO 01 12 02 
 
 
 

GIỚI THIỆU 
Bài học này giới thiệu về một cấu trúc mạch logic đa năng cơ bản nhất đó là các 

mảng logic lập trình được, từ phần lý thuyết cấu tạo, đặc tính và cách thực hiện các hàm 
logic bất kỳ bằng PLA, PAL. Ngoài ra nội dung bài còn đề cập đến các mảng cụ thể 
thường thấy trong thực tế. Phần thực tập là các bài tập thiết kế kết hợp chạy thử trên test 
board và các mô hình kèm theo. 

MỤC TIÊU THỰC HIỆN 
• Hiểu được cấu tạo, ý nghĩa thực tế của việc xử dụng mảng logic lập trình trong 

các yêu cầu thiết kế logic phức tạp 
• Biết cách xác định bảng nạp PLA và PAL, phân tích được sự khác nhau giữa 

hai thiết bị này. 
• Thực hiện được các thiết bị GAL16V8 và ispGAL22V10 
 

NỘI DUNG CHÍNH 
Nội dung bài học tập trung về các chủ đề chính như sau: 
• Sự cần thiết và cấu tạo logic của PLA 
• Áp dụng PLA trong thiết kế logic. 
• So sánh giữa PLA và PAL 
• Các ví dụ ứng dụng điển hình 
• Khảo sát thiết bị GSAL16V8 
• Khảo sát thiết bị ispGAL22V10 
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1. GIỚI THIỆU CHUNG 
Các nhà sản xuất IC đã rất thành công trong việc tích hợp hàng triệu transistor trên 

một bản mạch. Nhưng công nghệ này có thể giúp giãm số lượng thiết bị trong hệ thống 
số ? 

Vấn đề cơ bản ở đây là phải tìm ra các khối logic vạn năng có thể áp dụng được 
cho nhiều thiết kế logic khác nhau. Ví dụ như các cổng AOI có thể dùng trong nhiều thiết 
kế song các khối này cũng không giúp nhiều trong việc làm giãm các số lượng thiết bị, 
điều này có thể thực hiện bằng cách đưa vào xử dụng một khối chứa hàng trăm cổng. 
Nhưng cấu trúc các khối này phải như thế nào ? 

Một giải pháp không khéo cho tình huống này là sắp xếp các cổng AND và OR 
(hoặc NAND và NOR) theo một cấu trúc mảng được tổng quát hóa mà các điễm nối giữa 
chúng với nhau có thể lập trình được để thực hiện một hàm logic xác định. Những khối 
logic mục đích chung như vậy được gọi là PLA hoặc PAL. 

2. PLA và PAL 
Hình 2.1 biểu diển sơ đồ khối của một thiết bị mảng logic lập trình. Đó là các thiết bị 

nhiều đầu vào và nhiều đầu ra được tổ chức thành một mảng con các phần tử AND và 
một mảng con các phần tử OR. Mảng con AND sẻ chuyển các đầu vào thành các tích số 
(product term) phụ thuộc vào các điễm nối được lập trình. Mảng con OR sẻ cộng các tích 
số này với nhau để tạo ra biểu thức dạng tổng các tích cuối cùng. 

 
 

 
 
Một thiết bị PLA có thể thực hiện một tập hợp các hàm khá phức tạp. Sự phức tạp 

này được xác định bởi số lượng đầu vào (input), số lượng các tích số (chính là số lượng 
các cổng AND) và số lượng các đầu ra (chính là số lượng các cổng OR) mà PLA có thể 
cung cấp. 

Chẳng hạn một FPLA tiêu biểu kiểu TTL có thể có 16 đầu vào, 48 tích số và 8 đầu 
ra được đóng gói trong một vỏ 24 chân dử liệu. Nó tương đương với 48 cổng AND 16 
đầu vào và 8 cổng OR 48 đầu vào. Nếu xét một vi mạch SSI 12 chân dử liệu thì nó chỉ có 
4 cổng hai đầu vào, từ đó có thể thấy tác dụng thực sự của các mảng logic. Ví dụ để thực 
hiện các hàm boole sau đây: 

 

 
 
Mảng AND 

 
 
Mảng OR 

Tích số 

Ngỏ vào 

Ngỏ ra 

Hình 2.1 Cấu trúc mảng logic 
lập trình
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ACBF3

ABCBF2

ABCAF1

CBAF0

+=

+=

+=

+=

 

 
các phương trình trên có thể được mô tả bằng tập hợp các biến (A, B, C), các tích 

số (A, CB , AC , AB, BC ) và các hàm (F0, F1, F2, F3). Những chử này tương đương với 
số đầu vào của mảng AND,  các đầu ra từ mảng AND sẻ tương đương với số đầu vào 
của mảng OR và các đầu ra của mảng OR là các hàm. Để thực hiện các hàm này phải 
cần một PLA có ít nhất 3 đầu vào, 5 tích số và 4 đầu ra. 

Một cách tiện lợi để mô tả các hàm là dùng một ma trận đặc tính được vẻ trong hình 
2.2. Nó mô tả đầu vào nào phải nối với cổng AND để hình thành tích số mong muốn (1 = 
Biến không đảo; 0 = Biến đảo; - = Không nối) và những tích số nào phải được OR với 
nhau để tạo thành các đầu ra cuối cùng (1 = Nối; 0 = Không nối). các hàng trong bảng 
xác định các tích số, các cột biểu diển các đầu vào và đầu ra. Một tích số tham gia trong 
nhiều hàm nếu như có nhiều giá trị 1 trên hàng của nó trong các cột ra của ma trận đặc 
tính. Trong hình 2.2 dể dàng nhậ thấy rằng các tích số A, AB và CB  được dùng trong 
nhiều hàm. 

 

Tích số A B C F0 F1 F2 F3 

AB 1 1 - 0 1 1 0 

CB  - 0 1 0 0 0 1 

CA  1 - 0 0 1 0 0 

CB  - 0 0 1 0 1 0 

A 1 - - 1 0 0 1 

 
Hình 2.2 Bảng ma trận đặc tính 

 
 

Hình 2.3 và 2.4 vẻ các sơ đồ thực hiện các hàm ở trên dưới dạng các cổng rời rạc 
tương đương với mảng logic lập trình. Hình 2.3 là mảng trước khi lập trình với tất cả các 
điễm nối giữa đầu vào với các cổng. Có thể đặc tính hóa mảng bằng cách xử dụng một 
thiết bị phần cứng gọi là bộ lập trình. 

 
 



 44 

 
 
Những chi tiết của quá trình lập trình phụ thuộc vào các vi mạch cụ thể. Một kỹ thuật 

thường hay được xử dụng là đặt các cầu chì giữa tất cả các điểm nối ở đầu vào và đầu ra 
của một cổng. Một cầu chì là một tiếp giáp điện được thiết kế đặc biệt để có thể bị đứt 
dưới dòng điện lớn. Bằng cách cho một dòng điện cao chảy qua các cầu chì được chọn, 
phần cứng lập trình sẻ phá hỏng các tiếp giáp này. Phần mềm lập trình sẻ phân tích các 
phương trình boole để xác định những cầu chì nào cần phá hỏng những cầu chì nào cần 
để lại. Hình 2.4 trình bày mảng logic sau khi đã lập trình. 

 
 

 
Sự khác nhau giữa PLA và PAL 

A B C 

A B C 

F0 F1 F2 F3

Hình 2.3 PLA  trước khi 
lập trình 

Hình 2.4 PLA sau khi lập 
trình 
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Trong hình 2.3 cho nthấy cả hai mảng con AND và OR có thể đặc tính hóa theo bất 
kỳ cách nào msf người thiết kế mong muốn. Những thiết bị như thế được gọi là mảng 
logic chương trình hóa (Programmable Logic Array – PLA). 

Trong thực tế có những mảng logic không cung cấp khả năng lập trình đầy đủ. Ví 
dụ các thiết bị PAL (Programmable Array Logic) có mảng AND lập trình được còn mảng 
OR thì được xác định trước. Số lượng tích số đi vào một cổng OR thường được giới hạn 
là: 2, 4, 8 hoặc 16. 

Có một sự bù trừ trong các thiết bị PAL giữa độ phức tạp của các hàm với số lượng 
tích số trên một cổng OR và số lượng các hàm độc lập mà thiết bị có thể thực hiện được. 
Cổng OR có độ chịu tải đầu vào (fan – in) càng cao thì thiết bị PAL càng ít đầu ra. 

Ví dụ một họ PAL có thể tồn tại dưới 3 dạng, mỗi dạng đều có 16 đầu vào, 16 tích 
số nhưng khác nhau về tổ chức của mảng OR: 4 cổng OR mỗi cổng 4 đầu vào, 2 cổng 
OR mỗi cổng 8 đầu vào hoặc 1 cổng OR 16 đầu vào. Còn mảng AND thì vẩn hoàn toàn 
có thể lập trình. Hình 2.5 biểu diển một thiết bị PAL có 3 đầu vào, 4 tích số và 2 đầu ra 
còn mảng OR đẫ được xác định sẳn, trong trường hợp này các cổng OR bị giới hạn 2 tích 
số mỗi cổng. 

 
 

 
 
Điễm khác chính giữa PLA với PAL là: PLA có thể lợi dụng các tích số chung để 

chia xẻ cho nhiều đầu ra còn thiết bị PAL không thể làm điều này. Như vậy nên dùng một 
PLA khi cần thực hiện một tập hợp các hàm mà có nhiều tích số chung để có thể chia xẻ 
cho các đầu ra. 

Mặt khác một thiết bị PLA sẻ chậm hơn so với PAL do sự khác nhau về trở kháng 
của tiếp giáp, một có thể lập trình còn một thì đẫ được định vị cứng. các tiếp giáp có thể 
lập trình được cấu tạo từ các cầu chì có trở kháng cao hơn là các tiếp giáp đã được định 
vị cứng. Vì vậy tín hiệu đi qua hai tiếp giáp lập trình trong PLA bị trể hơn khi chỉ đi qua 
một tiếp giáp lập trình trong PAL. 

3. CÁC VÍ DỤ THIẾT KẾ 
Phần dưới đây sẻ trình bày hai ví dụ thiết kế khác nhau đó là một bộ chuyển đổi mã 

và một bộ so sánh để minh họa cách thực hiện mạch logic tổ hợp bằng cách dùng PLA 
hoặc PAL 

A B C 

Hình 2.5 Cấu trúc PAL 
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3.1 Bộ chuyển mã BCD sang Gray 
Nhiệm vụ của bộ chuyển mã này là chuyển một số BCD 4 bít thành mã gray 4 bít. 

Mỗi số trong mã gray chỉ khác so với số cạnh nó 1 bít. Mạch có 4 đầu vào A, B, C và D 
biểu diển số BCD và 4 đầu ra W, X, Y, Z biểu diển mã gray 4 bít. 

 
A B C D W X Y Z 
0 0 0 0 0 0 0 0 
0 0 0 1 0 0 0 1 
0 0 1 0 0 0 1 1 
0 0 1 1 0 0 1 0 
0 1 0 0 0 1 1 0 
0 1 0 1 1 1 1 0 
0 1 1 0 1 0 1 0 
0 1 1 1 1 0 1 1 
1 0 0 0 1 0 0 1 
1 0 0 1 1 0 0 0 
1 0 1 0 X X X X 
1 0 1 1 X X X X 
1 1 0 0 X X X X 
1 1 0 1 X X X X 
1 1 1 0 X X X X 
1 1 1 1 X X X X 

 
Hình 2.6 Bảng sự thật bộ chuyển mã BCD sang Gray 

 
 

 

 
 
 

 
Hình 2.7 Bảng Karnaugh bộ chuyển mã 
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Kết quả sau khi tối thiểu hóa 
 
W = A + BD + BC  Y = B + C 
 

CBX =     DCBDABCDDCBAZ +++=  
 

 
 

Hình 2.8 Thực hiện bộ chuyển mạch bằng thiết bị PAL 
 

A B C D 

A 

BD 

BC 

0

CB  

0

0 

0 

B

C

0 

0 

DCBA  

BCD 

DA  

DCB  

W X Y Z 
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Vì tập hợp các hàm này không có tích số nào chung để chia xẻ nên chúng thích 

hợp với cách thực hiện bằng thiết bị PAL (hình 2.8). Thiết bị này gồm 4 cổng OR 4 đầu 
vào nhưng có nhiều cổng AND không dùng đến, bài này có thể thực hiện bằng thiết bị 
PLA đơn giản hơn nhưng tốc độ sẻ chậm hơn. 

3.2 Bộ so sánh hai bít 
Đầu vào của mạch là hai số nhị phân hai bít ký hiệu là AB và CD. Đầu ra là 4 hàm 

xác định bởi giá trị logic của các mệnh đề. 
 
AB = CD (EQ: Bằng nhau) AB ≠  CD (NE: Không bằng nhau) 
AB < CD (LT: Nhỏ hơn)  AB > CD (GT: Lớn hơn) 
 
 

 
 

Hình 2.9 Bảng Karnaugh bộ so sánh 
 
Các phương trình logic sau khi tối thiểu hóa 
 

DCBDABCAGT

CDBDBACALT

DBDBCACANE

DCBAABCDDCBADCBAEQ

++=

++=

+++=

+++=

 

 
Các hàm xử dụng 14 tích số trong đó có 2 tích sô ( CA  và CA ) được dùng hai lần 

nên dùng PLA có lợi hơn. Một PAL hoặc PLA có thể thay thế từ 5 đến 15 vi mạch số rời. 
Đó là lý do hiện nay chúng được dùng rất để thực hiện các hệ logic. 
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Hình 2.10 Thực hiện bộ so sánh bằng PLA 

 

4. CÁC MẢNG LOGIC LẬP TRÌNH THÔNG DỤNG 
4.1 GAL16V8C 

Là một vi mạch được sản xuất bởi hảng LATTICE có trì hoãn truyền tối đa 5 nS, là 
một kết hợp giữa công nghệ CMOS hiệu năng cao với công nghệ ghi xóa được bằng điện 
nhằm tạo ra các PLD tốc độ cao trên thị trường. Do thời gian xóa cao (< 100 mS) cho 
phép thiết bị được lập trình lại một cách nhanh chóng và hiệu quả. 

Cấu trúc tổng quát của thiết bị cung cấp khả năng thiết kế linh động nhất nhờ vào 
tính năng cấu hình ngỏ ra OLMC bởi người dùng, một tập hợp phụ nhiều khả năng cấu 
hình của GAL16V8 là các cấu trúc PAL được liệt kê trong một bảng ở phần mô tả 
macrocell. Các thiết bị GAL16V8 cho phép mô phỏng một cấu trúc PAL bất kỳ với sự 
tương thích hoàn toàn về chức năng/bản đồ cầu chì/thông số. 

Mạch thử đồng nhất và các tế bào lập trình lại cho phép thử toàn bộ đặc tính AC, 
DC và chức năng trong khi sản xuất. Kết quả là công ty LATTICE bảo đãm 100% chức 
năng và khả năng lập trình tất cả các sản phẩm GAL. Thêm vào đó còn bảo đãm 100 lần 
ghi/xóa và dử liệu được lưu trử trên 20 năm. 

A B C D 

DCBA  

DCBA  

ABCD 

DCBA  

CA  

CA  

DB  

DB  

DBA  

CDB  

ABC 

DCB  

EQ NE LT GT 
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Đặc tính kỹ thuật 
• Công nghệ CMOS và E2 

- Trì hoản truyền tối đa 5 nS 
- Fmax = 166 MHz 
- Trể tối đa 4 nS kể từ lúc có xung đồng hồ cho đến khi nhận được dử liệu ra 

• Công suất giãm từ 50% đến 75% so với loại lưỡng cực 
- Dòng Icc điển hình 75 mA đối với loại công suất thấp 
- Dòng Icc điển hình 45 mA đối với loại ¼ công suất 

• Có điện trở kéo lên ở tất cả các chân 
• Công nghệ tế bào E2 

- Cho phép logic cấu hình lại 
- Các tế bào lập trình lại được 
- Bảo đãm kiểm tra 100% 
- Tốc độ xóa cao (< 100 mS) 
- Khả năng lưu trử dử liệu 20 năm 

• 8 OLMC 
- Rất linh hoạt đối với các thiết kế logic phức tạp 

Hình 2.11 Hình dạng vỏ 
GAL16V8 

Hình 2.11 Sơ đồ khối GAL16V8 
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- Lập trình được cực tính ngỏ ra 
- Mô phỏng được các thiết bị PAL 20 chân với chức năng/bản đồ cầu chì/thông 

số tương thích 
• Nạp trước và reset khi mở nguồn tất cả các thanh ghi 

- Khả năng kiểm tra chức năng 100% 
• Ứng dụng điển hình 

- Điều khiển DMA 
- Điều khiển máy trạng thái 
- Xử lý đồ họa tốc độ cao 
- Nâng cấp tốc độ logic chuẩn 

• Có ký hiệu nhận dạng điện tử 
 

4.1.1 Ngỏ ra OLMC 
Trong phần này giới thiệu về cách cấu hình ngỏ ra macrocell. Trong thực tế công 

việc này được thực hiện bằng các công cụ phần mềm cũng như phần cứng và hoàn toàn 
dẻ dàng xử dụng. 

Có 3 chế độ chế độ cấu hình chung đó là: Simple, complex và registered. Hai bít 
toàn cục SYN và AC0 xác định cấu hình cho tất cả các ngỏ ra macrocell. Bít XOR của mỗi 
macrocell xác định cực tính ngỏ ra của một trong 3 chế độ. Trong khi bít AC1 cũa mỗi 
macrocell có nhiệm vụ điều khiển cấu hình I/O. Hai bít toàn cục kết hợp với  16 bít cấu 
trúc riêng định nghĩa tất cả các cấu hình của GAL16V8. Thông tin cung cấp bởi các bít 
cấu trúc này chỉ nhằm làm hiểu rỏ hơn về thiết bị. Chương trình dịch sẻ thiết lập các bít 
cấu trúc này một cách rỏ ràng thông qua việc định nghĩa chân linh kiện, do đó người dùng 
không cần thao tác trực tiếp đến chúng. 

Tiếp theo sau đây là một bảng liệt kê các cấu trúc của PAL mà GAL16V8 có thể mô 
phỏng, nó cũng cho thấy chế độ OLMC trong các cấu trúc mô phỏng PAL của GAL16V8. 

 
Cấu trúc mô phỏng PAL của GAL16V8 Chế độ OLMC toàn cục 

16R8 
16R6 
16R4 

16RP8 
16RP6 
16RP4 

 
16L8 
16H8 
16P8 

 
10L8 
12L6 
14L4 
16L2 
10H8 
12H6 
14H4 
16H2 
10P8 
12P6 
14P4 
16P2 

Registered 
Registered 
Registered 
Registered 
Registered 
Registered 

 
Complex 
Complex 
Complex 

 
Simple 
Simple 
Simple 
Simple 
Simple 
Simple 
Simple 
Simple 
Simple 
Simple 
Simple 
Simple 

 
4.1.2 Trình dịch hổ trợ OLMC 
Phần mềm dịch hổ trợ 3 chế độ OLMC toàn cục khác nhau khi các kiểu thiết bị khác 

nhau. Các kiểu thiết bị này được liệt kê trong bảng dưới đây. Hầu hết các trình dịch đều 
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có khả năng tự động chọn kiểu thiết bị thường dựa vào việc xử dụng thanh ghi và chân 
cho phép ra (OE). Việc dùng thanh ghi sẻ buộc phần mềm chọn chế độ thanh ghi. Tất cả 
các ngỏ ra tổ hợp với OE được điều khiển bởi thành phần tích số sẻ buộc phần mềm 
chọn chế độ complex. Phần mềm chỉ chọn chế độ simple khi tất cả các ngỏ ra đều là 
dạng tổ hợp không có điều khiển OE. Các kiểu thiết bị khác nhau được liệt kê trong bảng 
có thể được dùng để hủy bỏ việc tự động lựa chọn thiết bị của phần mềm. Để biết thêm 
chi tiết có thể tham khảo tài liệu của chương trình dịch. 

Khi dùng phần mềm để cấu hình thiết bị cần phải lưu ý đến những giới hạn cho mỗi 
chế độ như sau 

 
 Registered Complex Simple Tự động chọn 

chế độ 
ABEL P16V8R P16V8C P16V8AS P16V8 
CUPL G16V8MS G16V8MA G16V8AS G16V8 
LOG/iC GAL16V8_R GAL16V8_C7 GAL16V8_C8 GAL16V8 
OrCAD-PLD “Registered” 1 “Complex” 1 “Simple” 1 GAL16V8A 
PLDesigner P16V8R2 P16V8C2 P16V8C2 P16V8A 
TANGO-PLD G16V8R G16V8C G16V8AS3 G16V8 

 
1) Được dùng với từ khóa configuration 
2) Hổ trợ trước version 2.0 
3) Được hổ trợ từ version 1.20 trở đi 
 

4.1.3 Chế độ thanh ghi 
Trong chế độ này các macrocell được cấu hình thành các ngỏ ra dạng thanh ghi 

hoặc chức năng I/O. 
Các cấu hình kiến trúc trong chế độ này tương tự các thiết bị 16R8 và 16RP4 với 

sự bố trí I/O, thanh ghi và cực tính thay đổi. 
Tất cả các macrocell kiểu thanh ghi chia xẻ chung chân xung đồng hồ và chân cho 

phép ra. Một macrocell bất kỳ có thể được cấu hình là thanh ghi hoặc I/O. Chế độ này 
cho phép đến 8 thanh ghi hoặc 8 I/O. các chức năng vào ra định sẳn có thể được thực 
hiện như một tập hợp phụ của chức năng I/O. 

Mỗi ngỏ ra kiểu thanh ghi có 8 thành phần tích số, mỗi ngỏ ra kiểu I/O có 7 thành 
phần tích số. 

Số lượng cầu chì JEDEC bao gồm cầu chì UES (User Electronic Signature ) và 
PTD (Product Term Disable) được trình bày trong sơ đồ logic sau đây. 

 
 

 
 
 
 
 
 
 

Cấu hình thanh ghi trong chế độ 
thanh ghi 
SYN = 0 
AC0 = 0 
XOR = 0 Ngỏ ra tích cực mức thấp 
XOR = 1 Ngỏ ra tích cực mức cao 
AC1 = 1 Cấu hình ra 
Chân1 là đồng hồ chung cho các ngỏ ra 
thanh ghi 
Chân 11 là OE  cho các ngỏ ra thanh ghi
Chân 1 và 11 luôn được cấu hình là CLK 
và  OE  

Cấu hình thanh ghi trong chế độ 
thanh ghi 
SYN = 0 
AC0 = 0 
XOR = 0 Ngỏ ra tích cực mức thấp 
XOR = 1 Ngỏ ra tích cực mức cao 
AC1 1 Cấ hì h
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Ghi chú: Phần mềm phát triển tự động cấu hình tất cả các bít điều khiển kiến trúc và 
kiểm tra việc xử dụng các chân tương ứng 

 
 

Hình 2.12 Sơ đồ khối chế độ thanh ghi 
 

4.1.4 Chế độ complex 
Trong chế độ này các macrocell chí được cấu hình là ngỏ ra hoặc chức năng I/O. 

các cấu hình kiến trúc trong chế độ này tương tự các thiết bị 16L8 và 16P8 với cực tính 
lập trình được cho mỗi macrocell 
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Cho phép lên đến 6 I/O, các ngỏ vào và ra định sẳn có thể được thực hiện như các 
tập hợp phụ của chức năng I/O. Hai macrocell ngoài cùng (chân 12 và 19) không thể là 
ngỏ vào. Các thiết kế cần 8 I/O có thể thực hiện ở chế độ thanh ghi. 

Mỗi macrocell có 7 thành phần tích số, một tích số được dùng để điều khiển chức 
năng cho phép ra. Chân 1 và 11 luôn là ngỏ vào dử liệu cho mảng AND 

Số lượng cầu chì JEDEC bao gồm các cầu chì UES và PTD được trình bày trong 
sơ đồ logic sau đây. 

 
 

 
 
 
 

 
 
 
 
 
Ghi chú: Phần mềm phát triển tự động cấu hình tất cả các bít điều khiển kiến trúc và 

kiểm tra việc xử dụng các chân tương ứng 
 
 

Cấu hình I/O tổ hợp trong chế độ 
complex 
SYN = 1 
AC0 = 1 
XOR = 0 Ngỏ ra tích cực mức thấp 
XOR =1 Ngỏ ra tích cực mức cao 
AC1 = 1 
Chân 13 đến 18 được cấu hình 
chức năng này 

Cấu hình ngỏ ra  tổ hợp trong 
chế độ complex 
SYN = 1 
AC0 = 1 
XOR = 0 Ngỏ ra tích cực mức thấp 
XOR =1 Ngỏ ra tích cực mức cao 
AC1 = 1 
Chân 12 đến 19 được cấu hình 
chức năng này 
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Hình 2.13 Sơ đồ khối chế độ complex 

 
4.1.5 Chế độ simple 
Trong chế độ này các macrocell được cấu hình như các ngỏ vào hoặc các ngỏ ra tổ 

hợp định sẳn. các cấu trúc kiến trúc trong chế độ này tương tự như các thiết bị 10L8 và 
12P6 với nhiều sự hoán vị của cực tính ra hoặc việc lựa chọn vào. 

Tất cả ngỏ ra trong chế độ simple có tối đa 8 tích số có thể điều khiển logic. Thêm 
vào đó cực tính của mỗi ngỏ ra có thể lập trình được. 

Chân 1 và 11 luôn là ngỏ vào dử liệu cho mảng AND, hai macrocell trung tâm (chân 
15 và 16) không thể dùng làm ngỏ vào hoặc chân I/O và chỉ là các ngỏ ra định sẳn. 

 
 

 

Ngỏ ra tổ hợp có hồi tiếp trong chế độ 
simple 
SYN = 1 
AC0 = 0 
XOR = 0 Ngỏ ra tích cực mức thấp 
XOR =1 Ngỏ ra tích cực mức cao 
AC1 = 0 Xác định cấu hình này 
Tất cả OLMC trừ chân 15 và 16 đều 
được cấu hình chức năng này 
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Ghi chú: Phần mềm phát triển tự động cấu hình tất cả các bít điều khiển kiến trúc và 

kiểm tra việc xử dụng các chân tương ứng 
 

Ngỏ ra tổ hợp  trong chế độ 
simple 
SYN = 1 
AC0 = 0 
XOR = 0 Ngỏ ra tích cực mức 
thấp 
XOR =1 Ngỏ ra tích cực mức cao 
AC1 = 0 Xác định cấu hình này 
Chân 15 và 16  được cấu hình 
thường trực ở chức năng này 

Ngỏ vào định sẳn trong chế độ 
simple 
SYN = 1 
AC0 = 0 
XOR = 0 Ngỏ ra tích cực mức 
thấp 
XOR =1 Ngỏ ra tích cực mức cao 
AC1 = 1 Xác định cấu hình này 
Tất cả OLMC trừ chân 15 và 16 
đều được cấu hình chức năng 
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Hình 2.14 Sơ đồ khối chế độ simple 
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Hình 2.15 Dạng sóng chuyển mạch 

 
Giới hạn tần số fmax 
 

 
 
 
 
 
 
 
 
 
 
 

 
fmax  hồi tiếp ngoài 1/(tSU + tCO)
 
Ghi chú: fmax được tính từ các giá trị đo 
tSU và tCO 

fmax  hồi tiếp trong  1/(tSU + tCf) 
 
Ghi chú: tCf = 1/fmax – tSU. Giá trị của tCf 
được dùng để tính trì hoãn từ thời điễm 
đồng hồ cho đến ngỏ ra tổ hợp. VD trên 
hình thời gian từ thời điễm đồng hồ đến 
ngỏ ra tổ hợp bằng tCf + tpd 
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Ký hiệu nhận dạng 
Một ký hiệu nhận dạng điện tử được cung cấp cho mỗi thiết bị GAL16V8, nó gồm 

64 bít nhớ lập trình được. Các bít này có thể chứa dử liệu định nghĩa bởi người dùng. 
Trong một số ứng dụng bao gồm mã nhận dạng người dùng, các số đọc lại hoặc điều 
khiển kiểm kê. Dử liệu nhận dạng luôn cho phép người dùng không phụ thuộc vào trạng 
thái bít bảo mật. 

Ghi chú: Ký hiệu nhận dạng điện tử đượ bao gồm trong phép tính kiểm tra tổng. 
Việc thay đổi ký hiệu nhận dạng sẻ làm thay đổi kiểm tra tổng. 

 
Bít bảo mật 
Một bít bảo mật được cung cấp trong GAL16V8 để ngăn việc sao chép không bản 

quyền nội dung các mảng. Mỗi khi được lập trình bít này sẻ ngăn không cho phép đọc 
các bít chức năng trong thiết bị. Bít này chỉ có thể xóa bằng cách lập trình lại thiết bị. Vì 
vậy cấu hình nguyên thủy không bao giờ được kiểm tra mỗi khi bít này được lập trình. 
Nhưng dử liệu nhận dạng thì luôn được phép bất chấp trạng thái của bít này. 

 
Chống điện tích khóa 
Các thiết bị GAL16V8 được thiết kế có tính năng nạp trong hệ thống với nền được 

pjhân cực âm. Sự phân cực âm giúp làm giãm điện tích khóa gây ra bởi các nhiểu xung 
âm ở ngỏ vào. Thêm vào đó, ngỏ ra còn được thiết kế với kênh N kéo lên thay vì thông 
thường là kênh P kéo lên để triệt hiện tượng khóa gây ra bởi sự vọt lố ở ngỏ ra. 

 
Lập trình thiết bị 
Các thiết bị GAL được nạp chương trình bằng một thiết bị lập trình logic phù hợp 

chuẩn của LATTICE. Chương trình được nạp hoàn tất chỉ trong vòng vài giây, quá trình 
xóa dể dàng đối với người dùng và được thực hiện tự động trong thời gian lập trình. 

 
Nạp trước thanh ghi ra 
Khi kiểm tra kết quả thiết kế máy trạng thái phải kiểm lại tất cả các trạng thái và sự 

chuyển trạng thái của hệ. Điều này là cần thiết vì trong các tình huống hoạt động nhất 
định có thể tạo ra tín hiệu logic tại trạng thái không hợp lệ (bật nguồn, nhiểu lưới điện…). 
Để kiễm tra thiết kế trong những điều kiện như thế phải cung cấp một phương pháp cho 
phép cách ly đường hồi tiếp và áp đặt mộ trạng thái bất kỳ vào thanh ghi, sau đó hệ tiếp 
tục hoạt động và giá trị ra được kiểm tra tại các trạng thái thích hợp tiếp theo. 

Sơ đồ mạch của GAL16V8 cho phép mỗi ngỏ ra thanh ghi được thiết lập đồng bộ 
với một trong hai mức cao hoặc thấp. Do đó, một trạng thái hiện tại bất kỳ có thể được áp 
đặt để kiểm tra hoạt động tuần tự. Khi cần thiết các thiết bị nạp GAL có khả năng chạy  
các vectơ thử tự động thực hiện việc nạp trước các thanh ghi ra. 

 
Bộ đệm ngỏ vào 
Thiết bị Gal16V8 được thiết kế với các bộ đệm vào tương thích với mức TTL. Các 

bộ đệm này có trở kháng vào cao nên làm giãm dòng tải hơn nhiều so với các thiết bị TTL 
lưỡng cực. 

Ngỏ vào của GAL16V8 và các chân I/O có đặt sẳn các điện trở kéo lên, nên các 
ngỏ vào và các chân I/O không dùng sẻ được treo lên mức cao (logic 1). LATTICE 

fmax không có hồi tiếp 
 
Ghi chú: fmax không có hồi tiếp có thể 
nhỏ hơn 1/(twh + twl), điều này cho 
phép xung đồng hồ có chu kỳ nhiệm 
vụ khác 50% 
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khuyến cáo nên nối các ngỏ không dùng này đến các ngỏ vào khác, Vcc hoặc GND. Việc 
làm này nhằm giãm nhiểu và dòng Icc của thiết bị. 

 
 

 
 
RESET khi mở nguồn 
 

 
 
Mạch điện GAL16V8 cung cấp một tín hiệu reset cho tất cả các thanh ghi trong suốt 

thời gian mở nguồn, ngỏ ra Q của tất cả các thanh ghi nội bộ được thiết lập mức thấp sau 
một thời gian xác định (tpr, 1 μS MAX). Kết quả là trạng thái của các chân ra kiểu thanh 
ghi (nếu chúng được cho phép) sẻ luôn ở mức cao khi mở nguồn bất chấp cực tính đã 
lập trình ở các chân ra. Đặc tính này có thể làm đơn giản hóa rất nhiều quá trình thiết kế 
máy trạng thái bằng cách tạo ra một trạng thái đã biết khi mở nguồn. Vì việc mở nguồn 
xảy ra ngẩu nhiên nên phải có một vài điều khiện để bảo đãm thiết bị được chắc chắn 
rsset. Thứ nhất điện áp Vcc phải tăng đều, thứ hai xung đồng hồ ngỏ vào phải cố định ở 
mức TTL như trình bày trên đồ thị trong suốt thời gian mở nguồn. các thanh ghi sẻ reset 
trong khoảng thời gian tối đa là tpr. 

Khi hệ thống hoạt động bình thường nên tránh kích thích thiết bị cho đến khi tất cả 
các thời gian thiết lập ngỏ vào và các đường hồi tiếp hoàn tất. Xung đồng hồ cũng cần 
phải có bề rộng tối thiểu. 
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Hình 2.16 Sơ đồ tương đương vào/ra 
 
 

4.2 ispGAL22V10 
Thiết bị ispGAL22V10 có thời gian trì hoãn truyền tối đa là 7,5 nS. Kết hợp giữa 

công nghệ CMOS hiệu năng cao với công nghệ cổng E2 (Electrical Erasable floating gate) 
đã tạo ra sản phẩm 22V10 đầu tiên lập trình được trong hệ thống cho công nghiệp. Công 
nghệ E2 có thời gian xóa nhanh (< 100 mS) cung cấp khả năng lập trình hoặc cấu hình lại 
thiết bị một cách nhanh chóng và hiệu quả. 

Cấu trúc tổng quát tạo khả năng thiết kế linh động một cách tối đa nhờ vào sự cho 
phép cấu hình của OLMC bởi người dùng. 

Thiết bị ispGAL22V10 có chức năng/bản đồ cầu chì/thông số tương thích với các 
thiết bị GAL22V10 lưởng cực và CMOS. 

Mạch điện kiểm tra đồng nhất và các tế bào lập trình lại cho phép kiểm tra đầy đủ 
chức năng, đặc tính AC, DC trong khi sản xuất. Thêm vào đó thiết bị còn có khả năng ghi 
xóa 10.000 lần và dử liệu được lưu trử trên 20 năm. 

 
 

 
 
Đặc tính kỹ thuật 
• Lập trình trong hệ thống (5 V) 

- 4 đường giao tiếp lập trình nối tiếp 

Hình 2.17 Sơ đồ chân  
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- Tối thiểu 10.000 lần ghi/xóa 
- Mạch kéo xuống bên trong chân SDI làm giãm điện trở ngoài (chỉ đối với 

ispGAL22v10C) 
• Công nghệ CMOS và E2 

- Trì hoãn truyền tối đa 7,5 nS 
- Fmax = 111 MHz 
- Trể tối đa 5 nS từ khi có xung đồng hồ cho đến khi có dử liệu ra 

• Có mạch kéo lên ở tất cả các chân vào và chân I/O 
• Tương thích với các thiết bị 22V10 chuẩn 

- Chức năng/bản đồ cầu chì/thông số các loại 22v10 lưỡng cực và CMOS 
• Công nghệ tế bào E2 

- Lập trình trong hệ thống 
- Bảo đãm được kiểm tra 100% 
- Tốc độ xóa bằng điện cao (< 100 mS) 
- Dử liệu lưu trử trong vòng 20 năm 

• 10 OLMC 
- Đạt độ linh hoạt tối đa với các thiết kế logic phức tạp 

• Ứng dụng điển hình 
- Điều khiển DMA 
- Điều khiển máy trạng thái 
- Xử lý đồ họa tốc độ cao 
- Driver cấu hình phần cứng 

• Nhận dạng bằng ký hiệu điện tử 
 

4.2.1 OLMC 
Mỗi OLMC trong ispGAL22V10 có số thành phần tích số thay đổi. Hai trong 10 

OLMC có 8 tích số (chân 17 và 27), hai OLMC có 10 tích số (chân 18 và 26), hai OLMC 
12 tích số (chân 19 và 25), hai OLMC 14 tích số (chân 20 và 24) và hai OLMC 16 tích số 
(chân 21 và 23). Thêm vào đó mỗi OLMC còn có 1 tích số dành sẳn để điều khiển chức 
năng cho phép ngỏ ra. 

Cực tính ra của mỗi OLMC có thể được lập trình riêng rẻ ở một trong hai chế độ tổ 
hợp hoặc thanh ghi. Điều này cho phép mỗi ngỏ ra có thể được cấu hình tích cực mức 
thấp hoặc mức cao một cách độc lập. 

Thiết bị ispGAL22V10 có một tích số reset không đồng bộ (AR) và một tích số 
preset đồng bộ (SP). Hai tích số này dùng chung cho tất cả các OLMC kiểu thanh ghi. AR 
sẻ thiết lập tất cả các thanh ghi về 0 bất cú khi nào tích số này được xác định. SP sẻ thiết 
lập tất cả các thanh ghi lên 1 tại cạnh lên của xung đồng hồ kế tiếp sau khi tích số này 
được xác định. 

Lưu ý: Hai tích số AR và SP sẻ bắt buộc ngỏ ra Q của FF vào cùng trạng thái bất 
chấp cực tính ngỏ ra. Do đó, một thao tác reset sẻ làm ngỏ ra các thanh ghi trở về 0, dẩn 
đến kết quả chân ra có thể cao hoặc thấp là tùy thuộc vào việc chọn cực tính của chân. 
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4.2.2 Cấu hình OLMC 
Mỗi OLMC trong ispGAL22V10 có hai mode chức năng cơ bản: Thanh ghi và I/O tổ 

hợp. các chế độ và cực tính ra được thiết lập bởi hai bít (S0 và S1). Thông thường các bít 
này được điều khiển bởi chương trình dịch. 

 
Chế độ thanh ghi 
Trong chế độ này, chân ra được kết hợp với một OLMC được lái bởi ngỏ ra Q của 

FF-D trong OLMC đó. Cực tính tín hiệu ra tại chân này có thể được chọn bằng cách xác 
định bộ đệm ra của nó tích cực mức cao hoặc mức thấp. Việc điều khiển ngỏ ra 3 trạng 
thái có hiệu lực như một tích số riêng của mỗi OLMC và vì vậy có thể được định nghĩa 
bằng một phương trình logic. Ngỏ ra Q  của FF-D được hồi tiếp về mảng AND. 

Lưu ý: Trong chế độ thanh ghi, tín hiệu hồi tiếp lấy từ ngỏ ra Q  của thanh ghi chứ 
không phải từ chân thiết bị, do đó một chân khi đã được định nghĩa là thanh ghi thì sẻ chỉ 
là ngỏ ra và không thể dùng làm I/O động như các chân tổ hợp. 

 
Chế độ I/O tổ hợp 
Trong chế độ này một chân được liên kết với một OLMC riêng được điều khiển từ 

ngỏ ra của một tổng số. Cực tính tín hiệu ra tại chân này có thể được chọn bằng cách xác 
định bộ đệm ra điều khiển tích cực mức cao hoặc mức thấp, việc điều khiển ngỏ ra 3 
trạng thái có khả năng như một thành phần tích số riêng cho mỗi ngỏ ra và có thể được 
thiết lập bởi chương trình dịch là ON (ngỏ ra định sẳn), OFF (ngỏ vào định sẳn) hoặc tích 
số điều khiển (I/O động). Tín hiệu hồi tiếp đưa về mảng AND lấy từ chân của bộ đệm cho 
phép ra, cả hai cực tính của chân (đảo và không đảo) đều được hồi tiếp về mảng AND. 
 

 
Hình 2.19 Chế độ thanh ghi 

Hình 2.18 Cấu tạo OLMC 
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Hình 2.20 Chế độ tổ hợp 

 

 
Hình 2.21 Sơ đồ logic và bản đồ cầu chì 



 65

 
 

Hình 2.22 Dạng sóng chuyển mạch 
 
 

 
 
 
 

 

fmax với hồi tiếp ngoài 1/(tSU + tCO) 
 
Lưu ý: fmax với hồi tiếp ngoài được tính từ 
các giá trị đo tSU và tCO 

fmax với hồi tiếp trong 1/(tSU + tCf) 
 
Lưu ý:  tCf = 1/fmax – tSU. Giá trị tCf 
được dùng để tính thời gian trì hoản kể 
từ khi có xung đồng hồ cho đến ngỏ ra 
tổ hợp 9qua hồi tiếp thanh ghi) , thời 
gian này là tCf + tpd 
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Ký hiệu nhận dạng 
Mỗi ispGAL22V10 được cung cấp một ký hiệu nhận dạng điện tử (ES) gồm 64 bít 

nhớ cho phép lập trình lại. các bít này có thể chứa dử liệu được định nghĩa bởi người 
dùng. Một số ứng dụng bao gồm mã nhận dạng người dùng, số phiên bản hoặc điều 
khiển kiểm kê. Dử liệu nhận dạng luôn được phép xử dụng không phụ thuộc vào trạng 
thái của tế bào bảo mật. 

Ký hiệu nhận dạng điện tử là một đặc tính bổ sung không có hổ trợ trong các thiết bị 
22V10 của các nhà sản xuất khác. Để xử dụng tính năng này phải chọn loại 22V10 của 
LATTICE khi dịch một tập hợp các phương trình logic. Thêm vào đó nhiều máy lập trình 
có hai khả năng lựa chọn: Một ispGAL22V10 và một ispGAL22V10-UES (User Electronic 
Signature) hoặc ispGAL22V10-ES, điều này cho phép người dùng duy trì sự tương thích 
với các thiết kế 22V10 hiện có trong khi vẩn còn khả năng tùy chọn xử dunngj tính năng 
mở rộng của các thiết bị GAL. 

Bản đồ JEDEC của ispGAL22V10 bao gồm 64 cầu chì bổ xung cho ký hiệu nhậ 
dạng điện tử trong tổng số 5892 cầu chì. Tuy nhiên, ispGAL22V10 vẩn còn có thể được 
lập trình theo bản đồ JEDEC 22V10 chuẩn (5828 cầu chì) với máy lập trình bất kỳ. 

 
Tế bào bảo mật 
Mỗi ispGAL22V10 có một tế bào bảo mật để chống sao chép nội dung của mảng. 

Mỗi khi được lập trình tế bào này sẻ ngăn việc đọc các bít chức năng của thiết bị. Tế bào 
này chỉ có thể bị xóa khi lập trình lại nên cấu hình nguyên thủy có thể không bao giờ 
được kiểm tra. Ký hiệu nhận dạng điện tử vẩn cho phép xử dụng bất chấp trạng thái của 
té bào này. 

 
Chống nghẻn mạch 
Thiết bị ispGAL22V10 được thiết kế với một bơm điện tích trên mạch để phân cực 

âm khối nền, biên độ phân cực âm đủ để ngăn các nhiểu xung âm ở ngỏ vào có thể làm 
nghẻn mạch. Ngoài ra, các ngỏ ra được thiết kế với mạch kéo lên kênh N thay vì thông 
thường là kênh P để giãm thiểu mọi khả năng nghẻn mạch cãm ứng SCR. 

 
Lập trình thiết bị 
Các thiết bị ispGAL22V10 xử dụng một file bản đồ cầu chì JEDEC 22V10 chuẩn để 

mô tả thông tin lập trình cho thiết bị. các chương trình dịch của hảng thứ ba có thể tạo ra 
file JEDEC cho thiết bị này. 

 
Khả năng lập trình trong hệ thống 
Thiết bị ispGAL22V10 có tính năng lập trình được trong hệ thống. Bằng cách tích 

hợp tất cả mạch lập trình điện áp cao trên chip, việc lập trình được thực hiện đơn giản 
bằng cách dịch chuyển dử liệu vào thiết bị. Mỗi khi được lập trình dử liệu trong các tế bào 
E2CMOS vẩn duy trì ngay cả khi tắt nguồn. 

Tất cả các điều kiện cần thiết cho việc lập trình được thực hiện thông qua 4 tín hiệu 
giao tiếp mức TTL. Các tín hiệu này được đưa đến mạch lập trình trên chip, nơi đó một 
máy trạng thái sẻ điều khiển việc lập trình. Các tín hiệu giao tiếp là: Dử liệu vào nối tiếp 
(SDI), dử liệu ra nối tiếp (SDO), xung đồng hồ nối tiếp (SCLK) và tín hiệu điều khiển chế 
độ (MODE). 

 

fmax không có hồ tiếp
 
Lưu ý: fmax không hồi tiếp có thể nhỏ hơn 
1/(twh + twl). Điều này cho phép xung đồng 
hồ có chu kỳ hoạt động khác 50% 
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Nạp trước thanh ghi ra 
Khi kiểm tra các thiết kế máy trạng thái cần thiết phải kiểm tra tất cả các trạng thái 

có thể và các quá trình chuyển trạng thái. Đây là những tình huống có thể xảy ra khi máy 
đang hoạt động có thể xuất hiện nhiểu gây ra bởi việc tắt/mở nguồn, nhiểu trên lưới 
điện…Để kiểm tra một thiết kế phù hợp với các điều kiện này cần phải cung cấp một 
phương pháp cách ly đường hồi tiếp và áp đặt một trạng thái bất kỳ vào các thanh ghi. 
Sau đó máy trạng thái có thể hoạt động tiếp tục và các ngỏ ra được kiểm tra đùng theo 
các điều kiện của trạng thái kế tiếp. 

Thiết bị ispGAL22V10 bao gồm mạch điện cho phép mỗi ngỏ ra kiểu thanh ghi được 
thiết lập đồng bộ với mức cao hoặc mức thấp. Do đó một trạng thái hiện tại bất kỳ có thể 
được áp đặt để kiểm tra hoạt động của máy. Khi cần thiết máy nạp GAL có khả năng tiến 
hành các véc tơ thử bằng cách tự động thực hiện việc nạp trước các thanh ghi ra. 

 
Đệm ngỏ vào 
Thiết bị ispGAL22V10 được thiết kế với các bộ đệm vào tương thích TTL. Các bộ 

đệm này có trở kháng vào cao nên mức tải tương đương nhỏ hơn nhiều so với các tải 
TTL thông thường khác. 

Tất cả các chân vào và chân I/O (ngoại trừ chân SDI của ispGAL22V10C) đều có 
mạch kéo lên bên trong, do đó các ngỏ vào để hở sẻ có mức cao TTL (mức 1), chân SDI 
có mạch kéo xuống bên trong để giữ cho thiết bị thoát khỏi trạng thái lập trình khi chân 
này không được điều khiển tích cực. Tuy nhiên, công ty LATTICE khuyên nên nối các ngỏ 
vào không dùng, các chân I/O 3 trạng thái với các ngỏ vào tích cực gần đó, với Vcc hoặc 
với GND nhằm cải thiện khả năng chống nhiểu và giãm dòng Icc cho thiết bị. 

 
 

 
 
Reset khi mở nguồn 
 

 
 
mạch điện của ispGAL22V10 cung cấp một tín hiệu reset cho tất cả các thanh ghi 

trong suốt thời gian mở nguồn. Ngỏ ra Q của các thanh ghi được đưa về mức thấp sau 
một thời gian xác định (tpr, 1 μS MAX). Kết quả là trạng thái của các chân ra kiểu thanh 
ghi (nếu chúng được cho phép) sẻ ở một trong hai mức cao hoặc thấp khi mở nguồn phụ 
thuộc vào cực tính đã được lập trình của các chân ra. Đặc tính này làm đơn giản việc 
thiết kế máy trạng thái qua việc tạo ra một trạng thái biết trước khi mở nguồn. Vì thời 
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điễm mở nguồn là ngẩu nhiên nên phải thỏa mản một số điều khiện để đạt được quá trình 
reset hợp lệ. Trước tiên, Vcc phải tăng lên, thứ hai xung đồng hồ phait đạt mức TTL trong 
suốt thời gian mở nguồn như trình bày trong đồ thị. Các thanh ghi sẻ reset trong khoảng 
thời gian tối đa tpr. Trong chế độ hoạt động bình thường tránh kích thiết bị cho đến khi tất 
cả các đường vào và đường hồi tiếp đã hoàn tất thời gian thiết lập, xung đồng hồ cũng 
phải có bề rộng tối thiểu. 

 
 
Sơ đồ tương đương vào/ra 
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BÀI 3 
 
 

Tên bài: Ngôn ngữ ABEL Mã bài: CIO 01 09 03 
 
 
 

GIỚI THIỆU 
Bài học này giới thiệu về một trong số các ngôn ngữ mô tả phần cứng thông dụng 

phục vụ cho yêu cầu thiết kế logic dùng PLDs đó là phần mềm ABEL, ngoài khả năng tạo 
ra file đốt cầu chì, ABEL còn có thêm tính năng mô phỏng để kiểm tra chức năng hoạt 
động của hệ thống giúp làm giãm thời gian cũng như chi phí quá trình thiết kế. 

MỤC TIÊU THỰC HIỆN 
• Hiểu được cấu trúc chung của một chương trình ABEL 
• Hiểu rỏ cú pháp, tính năng các dòng lệnh 
• Phân tích và viết được chương trình logic theo yêu cầu 
 

NỘI DUNG CHÍNH 
Nội dung bài học tập trung về các chủ đề chính như sau: 
• Cấu trúc chương trình ABEL 
• Các mô tả chương trình : Module, title, device... 
• Các hệ thống số : thập phân, nhị phân, bát phân, thập lục phân. 
• Các chỉ dẩn chương trình 
• Khái niệm về tập hợp và ứng dụng. 
• Phương pháp mô tả hệ thống : Phương trình logic, bảng sự thật, sơ đồ trạng 

thái. 
• Một số chương trình mẫu 
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1. GIỚI THIỆU 
ABEL (Advanced Boolean Equation Language) là một ngôn ngữ lập trình rất mạnh 

cho PLDs bao gồm cả phần lập trình, mô phỏng và tạo file cầu chì để đốt PLDs. Nó cho 
phép nhập những mô tả tương tự hành vi của một mạch logic. ABEL là một ngôn ngữ mô 
tả phần cứng (HDL) chuẩn công nghiệp được phát triển bởi công ty Data I/O cho các thiết 
bị PLD. Trên thực tế còn có nhiều ngôn ngữ mô tả phần cứng khác như VHDL và Verilog. 
ABEL đơn giản hơn VHDL là một ngôn ngữ có khả năng mô tả các hệ thống có độ phức 
tạp cao hơn. 

ABEL có thể được dùng để mô tả hành vi của một hệ thống trong một loại các định 
dạng bao gồm các phương trình logic, các bảng sự thật và các sơ đồ trạng thái bằng 
cách dùng các câu lệnh giống như ngôn ngữ C. Chương trình dịch ABEL cho phép mô 
phỏng và thực hiện các thiết kế trên PLDs như PALs, CPLDs, FPGAs. 

2. CẤU TRÚC FILE NGUỒN ABEL 
Một file nguồn ABEL gồm có các thành phần sau đây 
• Phần mở đầu: Bao gồm module, các tùy chọn và tiêu đề. 
• Phần mô tả: Chân linh kiện, hằng số, chân ẩn, tập hợp, trạng thái, thư viện. 
• Phần mô tả logic: Phương trình, bảng sự thật, sơ đồ trạng thái. 
• Phần véc tơ thử: các véc tơ thử. 
• Kết thúc. 
 
Các từ khóa (các từ được nhậ dạng bởi ABEL như các lệnh, VD: goto, if, then, 

module…) không phân biệt chử hoa và chử thường. các tên do người dùng định nghĩa, 
các nhản (từ định danh) có thể được viết bằng chử hoa, chử thường hoặc lẩn lộn. Một 
mấu điển hình được trình bày như sau: 

 
module module name  

[title string]  

[deviceID device deviceType;]  

pin declarations  

other declarations  

equations  

equations  

[Test_Vectors]  

test vectors  

end module name 

Ví dụ sau đây là file nguồn của một mạch cộng bán phần 
 
module my_first_circuit;  
title 'ee200 assignment 1'  
EE200XY device 'XC4003E';  



 71

   
   

" input pins  
A, B pin 3, 5;  

" output pins  
SUM, Carry_out pin 15, 18 istype 'com';  

equations  

SUM = (A & !B) # (!A & B) ;  
Carry_out = A & B;  

end my_first_circuit;  
 

Khi xử dụng ABEL với phần mềm CAD Xilinx người dùng có thể dựa trên mẫu 
hướng dẩn có sẳn của ABEL và thêm vào một số từ khóa, cũng tương tự như trong phần 
trợ giúp của trình soạn thảo ABEL cung cấp các trợ giúp trực tuyến. Vào thực đơn TOOL 
> LANGUAGE ASSISTANT. Các biểu mẫu có sẳn cung cấp một mô tả của hầu hết các 
lệnh ABE, cú pháp, cấu trúc…Trong khi các mẫu tổng hợp trình bày các ví dụ mạch điển 
hình. 

3. CÁC MÔ TẢ 
Module: Mỗi file nguồn bắt đầu với một câu lệnh module và theo sau là một tên 

module (nhận dạng). các file nguồn lớn thường bao gồm nhiều module với các thành 
phần riêng của chúng như: Tiêu đề, phương trình, lệnh end… 

Title: Là tùy chọn và có thể được dùng để nhận dạng dự án, tên tiêu đề phải được 
đặt giữa hai dấu móc đơn. Dòng chứa tiêu đề được chương trình dịch bỏ qua nhưng 
được dùng để tạo tài liệu cho chương trình. 

String: Là một chuỗi các ký tự ASCII được bao bởi hai dấu móc đơn, string được 
dùng cho tiêu đề, các câu lệnh tùy chọn, mô tả chân linh kiện, chân ẩn và thuộc tính. 

Device: Mô tả này là tùy chọn và tướng với một định danh thiết bị PLD xác định. 
Câu lệnh device phải được kết thúc bằng dấu chấm phẩy. Khi dùng hệ thống CAD xilinx 
để dịch thiết kế tốt hơn là không nên đặt câu lệnh device trong file nguồn đẻ giữ cho thiết 
kế khong phụ thuộc vào linh kiện. Khi cần tạo một dự án mới trong xilinx thì cần phải xác 
định kiểu thiết bị (cũng có thể thay đổi trong cửa sổ quản lý dự án bằng cách chọn nút 
thông tin dự án). Dạng thức như sau: 

 
device_id device 'real_device';  

 
Ví dụ: MY_DECODER device ‘XC4003E’ ; 
 
Comment: Có thể được chèn vào bất kỳ nơi nào trong file nguồn và được bắt đầu 

bằng dấu móc kép và kết thúc bằng dấu móc kép khác hoặc khi đến cuối dòng. 
Pin: Mô tả pin cho báo cho chương trình dịch tên các ký hiệu tương ứng với các 

chân bên ngoài của thiết bị. Dạng thức như sau: 
 
[!]pin_id pin [pin#] [istype 'attributes'] ; 

One can specify more than one pin per line:  
[!]pin_id , pin_id, pin_id pin [pin#, [pin#, [pin#]]] [istype 'attributes'];  

 
Ví dụ: 

IN1, IN2, A1 pin 2, 3, 4;  
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OUT1 pin 9 istype 'reg';  

ENABLE pin;  

!Chip_select pin 12 istype 'com';  

!S0..!S6 pin istype 'com';  
   
Lập trình viên không cần xác định chân. Số chân có thể được xác định sau đó bằng cách 
xử dụng một file người dùng trong khi đang dịch bằng CAD xilinx. Điều này giúp kết quả 
thiết kế được tổng quát và linh động hơn. Ký hiệu ! biểu thị mức tích cực là mức thấp (tín 
hiệu bị đảo) istype là một thuộc tính tùy chọn của chân linh kiện ví dụ ‘com’ báo cho biết 
tín hiệu ra là kiểu tổ hợp hoặc ‘reg’ là một tín hiệu tuần tự (được ghi vào một FF). Thuộc 
tính này chỉ áp dụng cho các chân ra. 

Node: Mô tả node có cùng dạng thức như mô tả pin. Node là các tín hiệu bên trong 
linh kiện chúng không được nối đến các chân ngoài. 

Ví dụ: 
 
tmp1 node [istype 'com' 
 
Các mô tả khác cho phép người dùng định nghĩa các hằng số, tập hợp, macro, biểu 

thức nhằm mục đích đơn giản hóa chương trình. Như ví dụ sau đây là một mô tả hằng số 
 

id [, id],... = expr [, expr].. ;  
 
Ví dụ: 
 

A = 21;  

C=2*7;  

ADDR = [1,0,11];  

LARGE = B & C;  

D = [D3, D2, D1, D0];  

D = [D3..D0]; 

Hai phương trình cuối cùng là tương đương nhau. Ký hiệu “..” được xử dụng để 
định nghĩa một khoảng. Ví dụ sau cùng dùng cho chú thích véc tơ, khi D được xử dụng 
trong một phương trình thì nó sẻ tham chiếu đến véc tơ [D3, D2, D1, D0]. 

4. SỐ 
Giá trị số có thể được nhập vào theo 4 dạng khác nhau: Nhị phân, bát phân, thập 

phân và thập lục phân. Hệ thống số mặc định là thập phân. Hệ thống số được xác định 
bằng một trong các ký hiêu sau đây (chấp nhận chử hoa và chử thường). Khi không có ký 
hiệu xác định thì số được hiểu là thập phân. Có thể thay đổi hệ thống số mặc định bằng 
chỉ dẩn “radix” 

 
 

Hệ thống số Cơ số Ký hiệu 
Nhị phân 2 ^b 
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Bát phân 8 ^o 
Thập phân 10 ^d (mặc định) 
Thập lục phân 16 ^h 

 
Ví dụ: 
 

Định nghĩa bởi ABEL Giá trị thập phân tương ứng 
35 35 
^h35 53 
^b101 5 

 

5. CÁC CHỈ DẨN 
Các chỉ dẩn cho phép thao tác và xử lý các file nguồn và chúng có thể được đặt bất 

kỳ nơi nào khi cần trong file nguồn. 
 

5.1 @ALTERNATE  
 
Cú pháp  
@alternate 

 
@ALTERNATE cho phép một tập hợp luân phiên các toán tử. Việc xử dụng tập hợp 

toán tử luân phiên để tránh việc dùng các toán tử ABEL-HDL công (+), nhân (*) và chia (/) 
bởi vì chúng biểu diển các toán tử logic AND, OR và NOT trong tập hợp luân phiên. Toán 
tử củ vẩn hoạt động khi @ALTERNATE có hiệu lực. Toán tử luân phiên vẩn duy trì tác 
dụng cho đến khi @ALTERNATE được xử dụng hoặc kết thúc module. 

 
@RADIX  
 
Cú pháp  
@radix expr ;  
 
Expr là một biểu thức hợp lệ cho ra các giá trị 2, 8, 10, 16 để để báo một cơ số mặc định 
mới. 
 
Chỉ dẩn @RADIX thay đổi hệ thống số mặc định, cơ số mặc định duy trì hiệu lực cho đến 
khi một chỉ dẩn @radix khác được xử dụng hoặc khi kết thúc module. Lưu ý là khi một 
@radix mới được tạo ra thì đặc điễm của cơ số mới phải ở trong dạng thức của cơ số 
hiện hành. 
 
Ví dụ:  @radix 2;  “ thay đổi cơ số mặc định là nhị phân 
 
 @radix 1010; “ chuyển từ nhị phân sang thập phân 
 

5.2 @STANDARD  
 
Cú pháp  
@standard 
 
Chỉ dẩn @standart phục hồi các toán tử về chuẩn ABEL-HDL. Tập hợp luân phiên được 
chọn với chỉ dẩn @alternate 
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6. TẬP HỢP 
Một tập hợp là một bộ các tín hiệu hoặc hằng số được dùng để tham chiếu đến một 

nhóm tín hiệu thông qua một tên. Tập hợp rất tiện lợi để làm đơn giản các biểu thức logic. 
Một toán tử bất kỳ áp dụng cho tập hợp sẻ tác dụng đến từng phần tử trong tập hợp đó. 

Tập hợp là một danh sách các hằng số hoặc tín hiệu phân cách nhau bởi dấu phẩy 
hoặc toán tử khoảng (..) đặt giữa các ngoặc vuông. 

Ví dụ: 
 

[D0, D1, D2, D4, D5]  
[D0..D6] “ Khoảng tăng 
[b6..b0] “ Khoảng giãm 
[D7..D15]  
[b1, b2, a0..a3] “ Khoảng trong một tập hợp lớn hơn 
[!s7..!s0] “ Khoảng giãm của các tín hiệu tích cực 

mức thấp 
 
Tuy nhiên, không được phép viết [D0, x] ; 
 
Trong đó x cũng là một tập hợp x = [x3..x0], do đó phải viết là [D0, x3..x0] 
 

6.1 Chỉ số hoặc truy xuất một tập hợp 
Chỉ số cho phép truy xuất các phần tử trong tập hợp, các giá trị số được dùng để 

biểu thị chỉ số của một tập hợp. Chỉ số tham chiếu đến vị trí bít trong tập hợp và được bắt 
đầu là 0 tương ứng với bít thấp nhất trong tập hợp. Sau đây là một số ví dụ. 

 
D1 = [D15..D0] ; “ mô tả tập hợp 
X2 = [X3..X0] ; “ mô tả tập hợp 
X2 := D1[3..0] ; “ làm cho X2 bằng với [D3, D2, D1, D0] 
X2 := D1[7..4] ; “ làm cho X2 bằng với [D7, D6, D5, D4] 
 
Cú pháp sau đây dùng để truy xuất một phần tử trong tập hợp 
 
OUT = ( X[2] == 1) ; 
 
Toán tử so sánh == được dùng để biến đổi phần tử ( X[2] ) ra giá trị bít chính là X2. 

Toán tử == cho ra kết quả 1 hoặc 0 là tùy thuộc vào phép so sánh true hoặc false.  
 

6.2 Các toán tử trên tập hợp 
Hầu hết các toán tử có thể áp dụng cho tập hợp và được thực hiện trên từng phần 

tử theo đúng quy luật đại số Boolean. Các toán tử được thực hiện theo thứ tự ưu tiên. 
Các toán tử có cùng mức ưu tiên được thực hiện từ trái sang phải (trừ trường hợp dùng 
dấu ngoặc đơn). 

 
Ví dụ 1: 
 
Signal = [D2, D1, D0] ; “ mô tả tập hợp các tín hiệu 
 
Signal = [1, 0, 1] & [0, 1, 1] ; “ kết quả là signal sẻ bằng [0, 0, 1] 
 
Ví dụ 2: 
 
[A, B] = C & D ; 
 tương đương với hai câu lệnh 
A = C & D ; 
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B = C & D ; 
 
Ví dụ 3: 
 
[A1, B1] = [D1, D2] & [C3, C2] ; 
 
tương đương với 
 
[A1, B1] = [D1 & C3, D2 & C2] ; 
 
Kết quả là 
 
A1 = D1 & C3 và B1 = D2 & C2. 
 
Ví dụ 4: 
 
X & [A, B, C] ; 
 
Tương đương với 
 
[X & A, X & B, X & C] ; 
 
Tuy nhiên, hãy xem biểu thức sau đây 
 
2 & [A, B, C] ; 
 
Trước tiên, giá trị 2 được biến đổi thành nhị phân và được thêm vào các số 0 nếu 

cần thiết (0010), phương trình trên trở thành. 
 
[0 & A, 1 & B, 0 & C] ; 
 
Ví dụ 5: 
 
A = [A2, A1, A0] ; “ thiết lập mô tả 
 
B = [B2, B1, B0] ; “ thiết lập mô tả 
 
A # B ; tương đương với [A2 # B2, A1 # B1, A0 # B0] ; 
 
!A ; tương đương với [!A2, !A1, !A0] ; 
 
Ví dụ 6: 
 
[b3, b2, b1, b0] = 2 ; tương đương với b3 = 0, b2 = 0, b1 = 1, b0 = 0. Giá trị 2 được 

chuyển thành nhị phân và thêm vào các số zero. 
 
Ví dụ 7: 
 
Tập hợp cũng rất thuận tiện đẻ xác định các phương trình logic 
 
Chip_sel = !A7 & A6 & A5 ; 
Yêu cầu này có thể được thực hiện bằng cách dùng tập hợp. Trước tiên, định nghĩa 

một tập hợp hằng Addr. 
 
Addr = [A7, A6, A5] ; “ mô tả tập hợp hằng Addr 
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Sau đó có thể dùng phương trình sau đây để xác định địa chỉ. 
 
Chip_sel = Addr == [0, 1, 1] ; kết quả tương đương 
 
Chip_sel = !A7 & A6 & A5 ; 
 
Nếu A7 = 0, A6 = 1, A5 = 1, biểu thức Addr == [0, 1, 1] là true (hoặc 1) nên Chip_sel 

cũng là true (hoặc 1). Phương trình trên có thể viết cách khác. 
 
Chip_sel = Addr == 3 ; “ trị thập phân 3 tương đương với 011 
 
Phương pháp trên rất thông dụng khi làm việc với các biến giá trị lớn (ví dụ địa chỉ 

16 bít) 
 
Ví dụ 8: 
 
Cũng như ví dụ trên, biểu thức 
 
3 & Addr ; tương đương với 
 
[0, 1, 1] & [A7, A6, A5] ; 
 
[0 & A7, 1 & A6, 1 & A5] ; 
 
[0, A6, A5]. 
 
Tuy nhiên, phát biểu sau thì lại khác. 
 
3 & (Addr == 1) ; 
 
Biểu thức tương đương 
 
3 & [!A7, !A6, A5] ; 
 
Tuy nhiên, toán tử so sánh chỉ cho kết quả 1 bít nên giá trị tính cũng được đánh giá 

là 1 bít và giá trị 3 bị cắt thành 1. Phương trình trên trở thành 
 
1 & !A7 & !A6 & A5 
 

7. TOÁN TỬ 
Có 4 kiểu toán tử cơ bản: Logic, số học, so sánh và gán 
 

7.1 Toán tử logic 
Bảng sau đây trình bày các toán tử logic. Chúng được thực hiện từng bít một. Với 

chỉ dẩn @alternate người dùng có thể chuyển tập hợp toán tử như trình bày trong bảng 
 

Toán tử (mặc định) Mô tả Toán tử luân phiên 
! NOT (bù một) / 
& AND * 
# OR + 
$ XOR :+: 
!$ XNOR :*: 
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7.2 Toán tử số học 
Bảng sau đây trình bày các toán tử số học, trong đó 4 toán tử sau cùng không áp 

dụng được cho tổ hợp, dấu trừ có thể có ý nghĩa khác: Là phép trừ (hoặc phép cộng số 
bù hai) nếu dùng với hai toán hạng và là số bù hai khi dùng với  1 toán hạng 

 
Toán tử  Ví dụ Mô tả 
- - D1 Số bù 2 (đảo) 
- C1 – C2 Phép trừ 
+ A + B Phép cộng 

Các toán tử sau đây không dùng với tập hợp 
* A * B Phép nhân 
/ A / B Phép chia số nguyên không dấu 
% A % B Modulus số dư của phép chia 
<< A << B A được dịch trái B bít 
>> A >> B A được dịch phải B bít 

 
7.3 Toán tử so sánh 

Bốn toán tử này cho kết quả là giá trị boolean: True (-1) hoặc falsse (0). Giá trị là -1 
khi tất cả các bít đều bằng 1. Ví dụ với số 16 bít -1 tương đương với 1111 1111 1111 
1111 

 
Toán tử Ví dụ Mô tả 
== A == B 3= = 5 (false) Bằng nhau 
!= A != B 3 != 5 (true) Khác nhau 
< A < B 3 < 5 (true) Nhỏ hơn 
<= A <= B 3 <= 5 (true) Nhỏ hơn hoặc bằng 
> A > B -1 > 5 (true) Lớn hơn 
>= A >= B !0 >= 0 (true) Lớn hơn hoặc bằng 

 
 
Toán tử so sánh là không dấu. Chú ý: !0 là bổ túc của 0 hoặc 1111 1111 (dử liệu 8 

bít) có giá trị là 255. Vì vậy 10 > 9 là true và biểu thức -1 > 5 cũng là true 
Giá trị -1 hoặc 0 có thể được thay thế tùy thuộc vào kết quả logic ví dụ: 
 
A = B !$ (C==D) ; 
 
A bằng B nếu C = D (true hoặc 1111…B XNOR 1 bằng B). Ngược lại A sẻ bằng bổ 

túc của B (nếu C khác B (false hoặc 0)). 
 

7.4 Toán tử gán 
Các toán tử này được dùng trong phương trình để gán giá trị một biểu thức cho tín 

hiệu ra. Có hai kiểu toán tử gán: Tỏ hợp và thanh ghi. Trong một toán tử tổ hợp phép gán 
xảy ra tức thời không có trì hoãn. Trong khi phép gán kiểu thanh ghi xảy ra tại xung đồng 
hồ kế tiếp kết hợp với ngỏ ra. Ví dụ một FF có thể được định nghĩa bằng các dòng lệnh 
sau đây. 

 
Q1 pin istype ‘reg’ ; 
 
Q1 := D ; 
 
Dòng lệnh đầu tiên định nghĩa FF Q1 bằng mô tả istype ‘reg’. (registered output). 

Dòng lệnh thứ hai cho biết rằng ngỏ ra của FF nhận giá trị của ngỏ vào D tại thời điễm 
chuyển tiếp xung đồng hồ kế tiếp. 
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Toán tử Mô tả 
= Gán tổ hợp 
:= Gán thanh ghi 

 
7.5 Thứ tự ưu tiên 

Mức ưu tiên của mỗi toán tử được trình bày trong bảng dưới đây, với 1 là mức ưu 
tiên cao nhất và 4 là thấp nhất. Những toán tử có cùng mức ưu tiên thì được thực hiện từ 
trái sang phải. 

 
Mức ưu tiên Toán tử Mô tả 
1 - Phủ định (bù 2) 
1 ! Đảo 
2 & AND 
2 << Dịch trái 
2 >> Dịch phải 
2 * Nhân 
2 / Chia không dấu 
2 % Modulus 
3 + Cộng 
3 - Trừ 
3 # OR 
3 $ XOR 
3 !$ XNOR 
4 == Bằng nhau 
4 != Khác nhau 
4 < Nhỏ hơn 
4 <= Nhỏ hơn hoặc bằng 
4 > Lớn hơn 
4 >= Lớn hơn hoặc bằng 

  

8. MÔ TẢ LOGIC 
Một thiết kế logic có thể được mô tả theo các phương pháp sau đây: 
 

• Phương trình. 
• Bảng sự thật 
• Sơ đồ trạng thái 

 
8.1 Phương trình 

Mô tả phương trình logic được bắt đầu bằng từ khóa equations. Phương trình xác 
định các biểu thức logic bằng cách dùng các toán tử như đã trình bày ở phần trên hoặc 
câu lệnh “When – Then – Else”. 

Câu lệnh “When – Then – Else” được dùng trong phương trình để mô tả một chức 
năng logic (Lưu ý: “If – Then –Else” được dùng trong phần sơ đồ trạng thái để mô tả quá 
trình chuyển đổi trạng thái).  

Dạng thức của câu lệnh “When – Then – Else” như sau: 
 
When điều kiện Then phần tử = Biểu thức ; 
Else phương trình ; 
 
Hoặc: 
 
When điều kiện Then phương trình ; 
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Ví dụ: 
 
SUM = (A & !B) # (!A & B) ;  
A0 := EN & !D1 & D3 & !D7;  

WHEN (A == B) THEN D1_out = A1;  

 
ELSE WHEN (A == C) THEN D1_out = A0; 

WHEN (A>B) THEN { X1 :=D1; X2 :=D2; } 
 
Cũng có thể dùng dấu ngoặc móc để nhóm các đoạn lại với nhau thành một khối. 

Đoạn văn bản trong khối có thể được viết trên một dòng hoặc rải trên nhiều dòng. Các 
khối được dùng trong phương trình, sơ đồ trạng thái và các chỉ dẩn. 

 
8.2 bảng sự thật 

Từ khóa là truth_table và cú pháp là 
 
TRUTH_TABLE ( in_ids -> out_ids )  

inputs -> outputs ; 

Hoặc  
TRUTH_TABLE ( in_ids :> reg_ids )  

inputs :> reg_outs ; 

Hoặc  
TRUTH_TABLE  

( in_ids :> reg_ids -> out_ids )  

inputs :> reg_outs -> outputs ;  
 

Ký hiệu -> là ngỏ ra tổ hợp và :> là ngỏ ra kiểu thanh ghi. Dòng đầu tiên của bảng 
sự thật (trong cặp ngoặc đơn) định nghĩa các tín hiệu vào và ra. Các dòng tiếp theo cho 
biết giá trị của tín hiệu vào và ra, mỗi dòng phải kết thúc bằng dấu chấm phẩy. các ngỏ 
vào và ra có thể là tín hiệu đơn hoặc tập hợp. Khi là tập hợp thì các tín hiệu phải được 
bao bằng các ngoặc vuông và cách nhau bằng các dấu phẩy. Giá trị không xác đinh được 
biểu diển bằng ký hiệu “.X.”. 

 
Ví dụ 1: mạch cộng bán phần 
 
TRUTH_TABLE ( [ A, B] -> [Sum, Carry_out] )  

[ 0, 0 ] -> [0, 0 ] ;  
[ 0, 1 ] -> [1, 0 ] ;  
[ 1, 0 ] -> [1, 0 ] ;  
[ 1, 1 ] -> [1, 1 ] ; 

 
Tuy nhiên, nếu định nghĩa một tập hợp IN = [A, B] hoặc OUT = [sum, carry_out] ; lúc 

này bảng sự thật sẻ trở nên đơn giản hơn 
 
 
 
TRUTH_TABLE (IN -> OUT )  

0 -> 0;  
1 -> 2;  



 80 

2 -> 2;  
3 -> 3; 

 
Ví dụ 2: Mạch EXOR có hai ngỏ vào và một ngỏ cho phép, ví dụ này cho thấy cách 

dùng các trị không xác định 
 
TRUTH_TABLE ([EN, A, B] -> OUT )  

[ 0, .X.,.X.] -> .X. ;  
[ 1, 0 , 0 ] -> 0 ;  
[ 1, 0 , 1 ] -> 1 ;  
[ 1, 1 , 0 ] -> 1 ;  
[ 1, 1 , 1 ] -> 0 ; 
 

Bảng sự thật cũng có thể được dùng để định nghĩa hệ tuần tự ví dụ một mạch đếm 
lên 3 bít từ 000, 001 đến 111 và trở về 000. Gọi QA, QB và QC là ngỏ ra của các FF và 
ngỏ ra OUT khi bộ đếm đạt đến giá trị 111, bộ đếm bị xóa về 000 khi tín hiệu reset ở mức 
cao. 

 
MODULE CNT3;  

CLOCK pin; " input signal  
RESET . pin; " input signal  
OUT pin istype 'com'; " output signal (combinational)  
QC,QB,QA pin istype 'reg'; " output signal (registered)  

[QC,QB,QA].CLK = CLOCK; "FF clocked on the CLOCK input  
[QC,QB,QA].AR = RESET; "asynchronous reset by RESET  

TRUTH_TABLE ) [QC, QB, QA] :> [QC,QB,QA] -> OUT)  

[ 0 0 0 ] :> [ 0 0 1 ] -> 0;  
[ 0 0 1 ] :> [ 0 1 0 ] -> 0;  
[ 0 1 0 ] :> [ 0 1 1 ] -> 0;  
[ 0 1 1 ] :> [ 1 0 0 ] -> 0;  
[ 1 0 0 ] :> [ 1 0 1 ] -> 0;  
[ 1 0 1 ] :> [ 1 1 0 ] -> 0;  
[ 1 1 0 ] :> [ 1 1 1 ] -> 0;  
[ 1 1 1 ] :> [ 0 0 0 ] -> 1; 

END CNT3; 
 

8.3 Mô tả trạng thái 
Phần sơ đồ trạng thái bao gồm việc mô tả trạng thái một thiết kế logic. Trong phần 

này dùng cú pháp state_diagram với các câu lệnh “If – Then –Else”, “Goto”, “case” và 
“With”. Thông thường tên trạng thái được đặt trong phần mô tả để giúp việc đọc chương 
trình dể hơn. 

 
Cú pháp: state_id [, state_id ...] STATE ; 

 
Ví dụ: SREG = [Q1, Q2] ; kết hợp tên trạng thái SREG với các trạng thái được định 

nghĩa là Q1 và Q2. 
 
Cú pháp phần sơ đồ trạng thái như sau: 
State_diagram state_reg  

STATE state_value : [equation;]  

[equation;]  

:  
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:  

trans_stmt ; ... 

Từ khóa state_diagram báo cho biết vị trí bắt đầu phần mô tả máy trạng thái. Từ 
khóa STATE và các câu lệnh theo sau trình bày một trạng thái của sơ đồ trạng thái trong 
đó gồm có giá trị và tên trạng thái, câu lệnh chuyển trạng thái và một phương trình ngỏ ra 
tùy chọn. Trong cú pháp trình bày ở trên: 

 
• State_reg: Là một định danh định nghĩa các ký hiệu xác định trạng thái của máy. 

Đây có thể là một thanh ghi trạng thái đã được mô tả trước trong phần mô tả. 
• State_value: Có hể là một biểu thức, một giá trị hoặc tên trạng thái hiện hành. 
• Equation: Phương trình định nghĩa các ngỏ ra của máy trạng thái. 
• Trans_stmt: các câu lệnh “If – Then – Else”, “Case” hoặc “Goto” dùng để xác 

định các trạng thái kế tiếp, được theo sau bởi các phương trình chuyển tiếp 
WITH tùy chọn. 

 
“If – Then – Else” 
Câu lệnh này được dùng trong phần sơ đồ trạng thái để mô tả trạng thái kế tiếp và 

xác định các điều kiện chuyển tiếp  
 
Cú pháp: 
 
IF expression THEN state_exp  

[ELSE state_exp] ; 

state_exp có thể là một biểu thức logic hoặc tên trạng thái. Lưu ý là câu lệnh If – 
Then – Else chỉ có thể được dùng trong phần sơ đồ trạng thái (dùng “When – If – Then” 
để mô tả các chức năng logic). Mệnh đề ELSE là tùy chọn. Câu lệnh If – Then – Else có 
thể được kế tiếp bởi các câu lệnh Goto, Case và With. 

 
Ví dụ: 
Trong phần mô tả, trước tiên chúng ta định nghĩa các thanh ghi trạng thái 
 
SREG = [Q1, Q0]; "definition of state registers  
S0 = [0, 0];  
S1 = [1, 1];  

state_diagram SREG  
state S0: OUT1 = 1;  

 
if A then S1  
else S0; 

state S1: OUT2 =1;  
 
if A then S0  
else S1; 

 
Các câu lệnh If – Then – Else có thể lồng nhau như ví dụ sau đây. Giả sử rằng các 

trạng thái và các thanh ghi đã được định nghĩa trong phần mô tả. 
 
state_diagram MAK  
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state INIT: if RESET then INIT else LOOK;  

state LOOK: if REST than INIT  

else if (X == LASTX) then OK  
else LOOK; 

state OK: if RESET than INIT  
else if Y then OK  
else if (X == LASTX) then OK  
else LOOK; 

state OK: goto INIT;  
 

Câu lênh “With” 
Cú pháp: 
 
trans_stmt state_exp WITH equation  
[equation ] ... ; 

 
trans_stmt có thể là câu lệnh “If – then – else”, “Goto” hoặc “Case”, state_exp là 

trạng thái kế tiếp và equation là một phương trình ra của máy. 
Câu lệnh này có thể được dùng với “If – then – else”, “Goto” hoặc “Case” tại vị trí 

của một biểu thức trạng thái đơn. Câu lệnh “With” cho phép các phương trình ra được ghi 
vào các số hạng của sự chuyển tiếp. 

 
Ví dụ 1: 
 
if X#Y==1 then S1 with Z=1 else S2; 

 
Trong ví dụ trên ngỏ ra Z sẻ được xác định ngay khi biểu thức sau câu lệnh If có giá 

trị là 1 (hoặc true). Biểu thức sau từ khóa WITH có thể là một phương trình và được định 
trị ngay khi điều kiện If là true như trong ví dụ 2. 

 
Ví dụ 2: 
 
if X&!Y then S3 with Z=X#Y else S2 with Z=Y; 

 
Câu lệnh “With” cũng thường được dùng để mô tả hành vi ra của các ngỏ ra kiểu 

thanh ghi. Do các ngỏ ra kiểu thanh ghi chậm sau một chu kỳ đồng hồ. Nó cũng cho phép 
thể hiện để xác định ngỏ ra thanh ghi có một giá trị xác định sau một chuyển tiếp đặc biệt 
như ở ví dụ [1] 

 
Ví dụ 3[1] 
 

state S1:  

if RST then S2 with { OUT1 := 1;  
Error-Adrs := ADDRESS; } 

else if (ADDRESS <= ^hC101)  
then S4  
else S1; 

 
Lưu ý là có thể dùng cặp ngoặc nghoéo để nhóm chung các ngỏ ra và các phương 

trình như ví dụ trên. 
 
Ví dụ 3 
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state S1: if (A & B) then S2 with TK = 1  
else S0 with TK = 0 ; 

 
Cần phải quan tâm đến thời gian khi dùng câu lênh “With” đối với các ngỏ ra tổ hợp 

hoặc không đồng bộ (như trong hệ Mealy). Hệ Mealy thay đổi các ngỏ ra của nó ngay khi 
các ngỏ vào thay đổi. Điều này có thể làm cho ngỏ ra thay đổi quá nhanh và sẻ gây ra 
nhiểu logic.Các ngỏ ra của Mealy phải ổn định tại thời điểm cuối của trạng thái (có nghĩa 
là ngay trước khi xung đồng hồ thay đổi). Về điễm này thì một ngỏ ra Moore sẻ ít gây lổi 
hơn.  

 
Câu lệnh “Case” 
Cú pháp: 
 
CASE expression : state_exp;  

[ expression : state_exp; ]  
:  

ENDCASE ; 

expression là một biểu thức ABEL bất kỳ và state_exp là một biểu thức cho biết 
trạng thái kế tiếp (có thể được theo sau bởi câu lệnh “With”) 

 
Ví dụ: 
 
State S0:  

case ( A == 0) : S1;  
( A == 1) : S0; 

endcase; 
 
Câu lệnh case được dùng để liệt kê một chuỗi các điều kiện chuyển tiếp loại trừ 

nhau và các trạng thái kế tiếp tương ứng. Các điều kiện của câu lệnh case phải loại trừ 
lẩn nhau (khônmg thể có hai điều kiện chuyển tiếp cùng bằng true) hoặc kết quả trạng 
thái kế tiếp không thể đoán được. 

 
8.4 Dấu chấm (.) 

Dấu chấm có thể được dùng để mô tả hành vi mạch điện một cách chi tiết hơn. Việc 
mở rộng tín hiệu rất thuận lợi và cung cấp một phương pháp tham chiếu đến tín hiệu bên 
trong và các chân nội kết hợp với một tín hiệu sơ cấp. 

 
Cú pháp 
signal_name.ext 

 
Một số dấu chấm mở rộng được cho trong bảng sau. Các mở rộng không phân biệt 

chử hoa chử thường, một số dấu chấm mở rộng có công dụng chung (cũng còn được gọi 
là độc lập cấu trúc hoặc điễm – điễm) và có thể được dùng với nhiều kiểu cấu trúc thiết 
bị. Các dấu chấm mở rộng khác được dùng cho các cấu trúc thiết bị xác định và được gọi 
là phụ thuộc cấu trúc hoặc dấu chấm mở rộng chi tiết. 

 
 

Dấu chấm mở rộng Mô tả 
Mở rộng không phụ thuộc cấu trúc hoặc điễm - điễm 

.ACLR Reset không đồng bộ 

.ASET Preset không đồng bộ 

.CLK Ngỏ vào đồng hồ FF tác động cạnh 
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.CLR Reset đồng bộ 

.COM Ngỏ vào dử liệu hồi tiếp kiểu tổ hợp từ FF 

.FG Hồi tiếp thanh ghi 

.OE Cho phép ra 

.PIN Hồi tiếp chân thiết bị 

.SET Preset đồng bộ 
Các mở rộng xác định (phụ thuộc cấu trúc) 

.D Ngỏ vào dử liệu của D – FF 

.J Ngỏ vào J của JK – FF 

.K Ngỏ vào K của JK – FF 

.S Ngỏ vào S của SR – FF 

.R Ngỏ vào R của SR – FF 

.T Ngỏ vào T của T – FF 

.Q Hồi tiếp thanh ghi 

.PR Preset thanh ghi 

.RE Reset thanh ghi 

.AP Preset thanh ghi không đồng bộ 

.AR Reset thanh ghi không đồng bộ 

.SP Preset thanh ghi đồng bộ 

.SR Reset thanh ghi đồng bộ 
 
Hình sau đây trình bày một số các mở rộng 
 
 

 
 

Hình 3.1 Mô tả các mở rộng : (a) Không phụ thuộc cấu trúc, (b)  Phụ thuộc cấu trúc. D – FF hoặc T – FF 
 

 
Ví dụ 1 : 
 
[S6..S0].OE = ACTIVE; 

 
Truy cập đến tín hiệu điều khiển 3 trạng thái của bộ đệm ra của các tín hiệu 

S6…S0. Khi ACTIVE ở mức cao, các tín hiệu được cho phép. Ngược lại, các ngỏ ra sẻ ở 
trạng thái Z cao. 

 
Ví dụ 2 : 
 
Q.AR = reset;  

[Z.ar, Q.ar] = reset; 
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Ngỏ ra của các thanh ghi (FF) trở về 0 khi reset ở mức cao 
 

8.5 Các véc tơ thử 
Các véc tơ thử là tùy chọn nhằm cung cấp một phương pháp để kiểm tra hoạt động 

của máy trạng thái. Các véc tơ xác định hoạt động logic mong muốn của một thiết bị logic 
bằng cách cho các ngỏ ra là hàm của các ngỏ vào một cách rỏ ràng. 

 
Cú pháp : 
 
Test_vectors [note]  

(input [, input ].. -> output [, output ] .. )  

[invalues -> outvalues ; ]  
:  
: 

 
Ví dụ : 
 
Test_vectors  

( [A, B] -> [Sum, Carry] )  

[ 0, 0 ] -> [0, 0];  
[ 0, 1 ] -> [1, 0];  
[ 1, 0 ] -> [1, 0];  
[ 1, 1 ] -> [1, 1]; 

Cũng có thể xác định các giá trị của tập hợp với các hằng số như chỉ ra sau đây : 
 

( [A, B] -> [Sum, Carry] )  

0 -> 0;  
1 -> 2;  
2 -> 2;  
3 -> 3; 
 

Trị bất định (.X.), ngỏ vào đồng hồ (.C.) được dùng như các hằng số, xem ví dụ sau 
 
test_vectors  

( [CLK, RESET, A, B ] -> [ Y0, Y1, Y3] )  

[.X., 1, .X.,.X.]->[ S0, 0, 0];  
[.C., 0, 0, 1 ] -> [ S0, 0, 0];  
[.C., 1, 1, 0 ] -> [ S0, 0, 1]; 

 
8.6 Các câu lệnh thuộc tính 

ABEL cho phép cung cấp các câu lệnh xác định thiết bị bằng cách dùng lệnh thuộc 
tính. Lệnh này được bỏ qua trong quá trình dịch. Thuộc tính của các thiết bị CPLD gồm 
có: 

• Độ dốc 
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• Tối ưu logic 
• Sắp xếp logic 
• Thiết lập công suất 
• Giá trị nạp trước 
 

8.7 Linh tinh 
Mô tả tích cực mức thấp 
Các tín hiệu tích cực mức thấp được định nghĩa với toán tử “!” như sau: 
 
!OUT pin istype 'com' ; 

 
Khi tín hiệu được xử dụng trong sự mô tả thiết kế tiếp theo sau, nó sẻ được tự động 

đảo lại như trong ví dụ sau đây 
 
module EXAMPLE  

A, B pin ;  

!OUT pin istype 'com';  

equations  

OUT = A & !B # !A & B ;  

end 

Trong ví dụ trên, tín hiệu OUT là kết quả EXOR giữa A với B có nghĩa là OUT sẻ 
bằng 1 (High hoặc ON) khi chỉ một trong các ngỏ vào bằng 1. Mặt khác OUT sẻ bằng 0. 
Tuy nhiên, vì chân ra được định nghĩa là !OUT có nghĩa là tín hiệu tích cực mức thấp. 
Điều này cho thấy rằng chân ra sẻ bằng 0 (tích cực mức thấp hoặc ON) chỉ khi một trong 
hai ngỏ vào bằng 1. Cũng có thể nhận được cùng kết quả bằng cách đảo tín hiệu trong 
các phương trình hoặc bằng cách mô tả chân ra là OUT. Ví dụ: 

 
module EXAMPLE  

A, B pin ;  

OUT pin istype 'com';  

equations  

!OUT = A & !B # !A & B ;  

end 

 
Tích cực mức thấp cũng có thể áp dụng cho tổ hợp, như ví dụ sau đây định nghĩa 

các tổ hợp A, B và C 
 
A = [A2,A1,A0]; "set declaration  
B = [B2,B1.B0]; "set declaration  
X = [X2,X1.X0]; "set declaration  

!X = A & !B # !A & B; 
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Phương trình cuối cùng tương đương với cách viết sau 
 

!X0 = A0 & !B0 # !A0 & B0;  
!X1 = A1 & !B1 # !A1 & B1;  
!X2 = A2 & !B2 # !A2 & B2; 

 

9. CHƯONG TRÌNH MẪU 
 
Chương trình 1: 
 
1  module Alarm_Circuit 
2  title ’Alarm Circuit Example 
3  J. Wakerly, Micro Systems Engineering’ 
4  ALARMCKT device ’P16V8C’; 
5  " Input pins 
6  PANIC, ENABLEA, EXITING pin 1, 2, 3; 
7  WINDOW, DOOR, GARAGE pin 4, 5, 6; 
8  " Output pins 
9  ALARM pin 11 istype ’com’; 
10 " Constant definition 
11 X = .X.; 
12 " Intermediate equation 
13 SECURE = WINDOW & DOOR & GARAGE; 
14 equations 
15 ALARM = PANIC # ENABLEA & !EXITING & !(WINDOW & DOOR & 

GARAGE); 
16 test_vectors 
17 ([PANIC,ENABLEA,EXITING,WINDOW,DOOR,GARAGE] -> [ALARM]) 
18 [ 1, .X., .X., .X., .X., .X.] -> [ 1]; 
19 [ 0, 0, .X., .X., .X., .X.] -> [ 0]; 
20 [ 0, 1, 1, .X., .X., .X.] -> [ 0]; 
21 [ 0, 1, 0, 0, .X., .X.] -> [ 1]; 
22 [ 0, 1, 0, .X., 0, .X.] -> [ 1]; 
23 [ 0, 1, 0, .X., .X., 0] -> [ 1]; 
24 [ 0, 1, 0, 1, 1, 1] -> [ 0]; 
25 end Alarm_Circuit 
 
Giải thích chương trình: 
• Dòng 1 khai báo module tên là Alarm_Circuit 
• Dòng 2 và 3 khai báo tiêu đề của module 
• Dòng 4 khai báo kiểu thiết bị là P16V8C (chế độ tổ hợp) 
• Dòng 5 là chú thích cho biết bắt đầu khai báo các chân vào 
• Dòng 6 và 7 khai báo các chân vào 
• Dòng 8 là chú thích cho biết bắt đầu khai báo các chân ra 
• Dòng 9 cho biết tín hiệu ra kiểu tổ hợp ALARM được kết nối với chân 11 
• Dòng 10 chú thích định nghĩa hằng số 
• Dòng 11 định nghĩa X là giá trị không xác định 
• Dòng 12 và 13 chú thích và định nghĩa phương trình trung gian SECURE 
• Dòng 14 từ khóa equations cho biết bắt đầu phần phương trình  
• Dòng 15 khai báo phương trình của tín hiệu ALARM 
• Dòng 16 từ khóa test_vectors báo bắt đầu phần véc tơ thử kiểm tra chức năng 

hoạt động của mạch 
• Dòng 17 khai báo các tín hiệu vào và ra cần kiểm tra 
• Dòng 18 đến 24 là các véc tơ thử 
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• Dòng 25 kết thúc module Alarm_Circuit bằng từ khóa end 
 
Chương trình 2: cách dùng các trị bất định 
 
module DontCare 
title 'Dont Care Examples' 
@DCSET 
" Input and output pins 
N3..N0, A, B pin; 
F, Y pin istype 'com'; 
NUM = [N3..N0]; 
X = .X.; 
 
truth_table (NUM->F) 
0->0; 
1->1; 
2->1; 
3->1; 
4->0; 
5->1; 
6->0; 
7->1; 
8->0; 
9->0; 
 
truth_table ([A,B]->Y) 
[0,0]->0; 
[0,1]->X; 
[1,0]->X; 
[1,1]->1; 
end DontCare 
 
Từ chương trình trên cho thấy có thể xác định các tổ hợp bất định một cách rỏ ràng 

như ở bảng sự thật thứ hai. 
 
Chương trình 3: Dùng phương pháp máy trạng thái thiết kế mạch đếm lên, đồng bộ, 

16 dùng GAL 16V8 có ngỏ CL đồng bộ tích cực mức thấp như sơ đồ mạch sau 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Từ sơ đồ trạng thái kèm theo và lưư ý là các ngỏ ra Q3…Q0 cũng chính là các biến 
trạng thái. 

 
1 module Count4 

3                     19
4                     18

17
16

GAL16V8 

CK 
CL 

Q3
Q2 
Q1
Q0

Hình 3.2 Sơ đồ chân mạch đếm 
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2 title ‘bộ đếm lên 16’ 
3 U4 device ‘P16V8R’ ; 
4 Ck, cl  pin 1, 2 ; 
5 Q3, Q2, Q1, Q0 pin 19, 18, 17, 16 ; 
6 Count = [Q3,Q2,Q1,Q0] ; 
7 c, h, l = .C., 1, 0 ; 
8 “định nghĩa các trạng thái 
9 s0 = ^b0000 ; s1 = ^b0001 ; s2 = ^b0010 ; 
10 s3 = ^b0011 ; s4 = ^b0100 ; s5 = ^b0101 ; 
11 s6 = ^b0110 ; s7 = ^b0111 ; s8 = ^b1000 ; 
12 s9 = ^b1001 ; s10 = ^b1010 ; s11 = ^b1011 ; 
13 s12 = ^b1100 ; s13 = ^b1101 ; s14 = ^b1110 ; 
14 s15 = ^b1111 ; 
15 state_diagram [Q3,Q2,Q1,Q0]  
16 state s0 : if cl then s1 else s0 ; 
17 state s1 : if cl then s2 else s0 ; 
18 state s2 : if cl then s3 else s0 ; 
19 state s3 : if cl then s4 else s0 ; 
20 state s4 : if cl then s5 else s0 ; 
21 state s5 : if cl then s6 else s0 ; 
22 state s6 : if cl then s7 else s0 ; 
23 state s7 : if cl then s8 else s0 ; 
24 state s8 : if cl then s9 else s0 ; 
25 state s9 : if cl then s10 else s0 ; 
26 state s10 : if cl then s11 else s0 ; 
27 state s11 : if cl then s12 else s0 ; 
28 state s12 : if cl then s13 else s0 ; 
29 state s13 : if cl then s14 else s0 ; 
30 state s14 : if cl then s15 else s0 ; 
31 state s15 : goto s0 ; 
32 test_vectors ([ck,cl] -> count) 
33 [c,h] -> ^b0000 ; 
34 [c,h] -> ^b0001 ; 
35 [c,h] -> ^b0010 ; 
36 [c,h] -> ^b0011 ; 
37 [c,h] -> ^b0100 ; 
38 [c,l] -> ^b0000 ; 
39 end Count 
Giải thích chương trình 
• Từ dòng 9 đné 14 định nghĩa các trạng thái s0 đến s15 bằng toán tử gán “=”, 

trong chương trình này dùng mã nhị phân “^b” 
• Dòng 15 định nghĩa 4 biến trạng thái Q3Q2Q1Q0 bằng từ khóa state_diagram 
• Từ dòng 16 đến 30 là các câu lệnh if – then mô tả quá trình chuyển trạng thái 
• Dòng 31 câu lệnh goto đưa trạng thái bộ đếm về 0 vô điều kiện 
• Dòng 32 bắt đầu phần véc tơ thử bằng từ khóa test_vectors 
• Từ dòng 33 đến 38 là các véc tơ thử 
• Dòng 39 từ khóa end kết thúc module. 

cl 0 

S0 0000 

cl 0 

S1 0001 

S15 1111 
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BÀI 4 
 
 

Tên bài: Họ CPLD Mã bài: CIO 01 09 04 
 
 
 

GIỚI THIỆU 
Bài học này giới thiệu về cấu tạo logic, đặc tính điện của một trong các họ CPLD 

thông dụng của hảng LATTICE đó là vi mạch ispLSI 1016, ngoài khả năng cho phép lập 
trình lạI vi mạch này còn có thể được nạp chương trình ngay trên hệ thống làm việc, điều 
này rất thích hợp vớI những yêu cầu cập nhật tính năng của hệ thống điều khiển số 

MỤC TIÊU THỰC HIỆN 
• Hiểu được cấu trúc logic của họ ispLSI 1016 
• Nắm được các tính năng cần thiết của thiết bị để có thể khai thác thiết bị một 

cách hiệu quả nhất. 
 
 

NỘI DUNG CHÍNH 
Nội dung bài học tập trung về các chủ đề chính như sau: 
• GiớI thiệu chung về CPLD 
• Các đặc tính cơ bản của họ ispLSI 1016 
• Mô tả chi tiết về cấu trúc logic của ispLSI 1016 
• Các thông số giớI hạn 
• Đặc tính DC 
• Công suất tiêu thụ 
• Sơ đồ chân 
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1. GIỚI THIỆU CHUNG 
Trong một vi mạch logic đơn lẻ được Ví dụ trong trường hợp của IC 7400 gồm 4 

cổng NAND được thiết kế ở bên trong. Trong trường hợp IC 7406, 6 cổng đảo được thiết 
kế ở bên trong. Đây là những IC riêng biệt nên để sử dụng cần phải kết nối chúng với 
nhau trên board mạch và vì thế chúng chiếm nhiều khoảng trống trên board. Trong 
trường hợp CPLD, nó kết nối các khối chức năng logic này với nhau trong cùng một IC 
(sơ đồ kết nối này được xác định bởi phần mềm) nên không chiếm nhiều khoảng trống và 
nhờ thế mạch thiết kế sẽ gọn hơn.. Ngoài ra CPLD còn có các ưu điểm khác hơn hẳn so 
với khi dùng các họ vi mạch truyề thống như : 

♣ Công suất tiêu thụ thấp 
♣ Độ tin cậy cao 
♣ Kich thước board mạch nhỏ gọn, sơ đồ nối dây bên ngoài rất đơn giản dẩn đến thi 

công đơn giản 
♣ Quá trình thiết kế dể dàng nhờ có sự trợ giúp của các công cụ phần mềm p-hát 

triển hệ thống 
♣ Giá thành rẻ 

 

 
 

 Tuy nhiên, Khả năng của CPLD cũng có giới hạn, đó là sự giới hạn về số chân vì 
vậy đừng trông mong quá nhiều vào CPLD. Mặc khác vì được chế tạo theo dạng flash 
nên CPLD có thể tái lập trình khoảng 10.000 lần đó là con số mà nhà sản xuất cung cấp 

2. VI MẠCH ispLSI 1016  
2.1 Đặc tính 

 Vi mạch logic mật độ cao 
− Khả năng kết nốI tốc độ cao 
− Gồm 2000 cổng PLD 
− 32 chân I/O, 4 ngỏ vào định sẳn 
− 96 thanh ghi 
− Cổng vào dảI rộng cho chức năng đếm tốc độ cao, máy trạng thái, giãi mả địa 

chỉ… 
− Khả năng bảo mật chống sao chép 
 

 Công nghệ E2CMOS 
− Tần số tốI đa fmax = 110 KHz 
− Tần số fmax = 60 MHz đốI vớI thiết bị công nghiệp và quân sự 
− Trì hoãn truyền tpd = 3 nS 
− Ngỏ vào và ra tương thích TTL 
− Cho phép lập trình lạI và xóa bằng điện 
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− Công nghệ bộ nhớ không mất dử liệu E2CMOS 
− Được kiểm tra 100% 
 

 Lập trình trong hệ thống 
− Khả năng lập trình 5 V ngay trong hệ thống 
− Tăng lỉnh vực sản xuất, giãm thờI gian thương mạI hóa và cảI thiện chất 

lượng sản phẩm 
− Tìm lổI nhanh 

 
 Kết hợp dể dàng giữa việc ứng dụng các hệ PLD tốc độ cao vớI mật độ và tính 

linh hoạt của FPGA 
− Thiết bị lập trình toàn bộ có thể kết hợp giữa logic tổ hợp vớI thiết kế có cấu 

trúc 
− Có 3 ngỏ vào đồng hồ định sẳn 
− Xung đồng hồ đồng bộ và không đồng bộ 
− Vị trí chân linh hoạt 
 

2.2 Mô tả 
IspLSI 1016 là vi mạch số lập trình mật độ cao bao gồm 96 thanh ghi, 32 ngỏ I/O đa 

năng, 4 ngỏ vào định sẳn, 3 ngỏ vào đồng hồ định sẳn và một khốI kết nốI toàn cục 
(global routing pool). IspLSI 1016 cho phép lập trình ngay trên hệ thống vớI mức điện áp 
5 V và cũng là thiết bị logic đầu tiên có bộ nhớ lập trình lạI được mà không mất dử liệu. 

KhốI logic cơ sở trong ispLSI 1016 là khốI logic tông quát GLB (generic logic block), 
các khốI này được đặt tên là A0, A1,…,B7 (hình 4.1), có tất cả 16 GLB : MỗI GLB có 18 
ngỏ vào, một mảng AND/OR/XOR lập trình được và 4 ngỏ ra. Các ngỏ ra có thể được 
cấu hình theo kiểu tổ hợp hoặc thanh ghi. Tín hiệu đưa vào GLB lấy từ các GRB hoặc từ 
các ngỏ vào định sẳn. Tất cả ngỏ ra của GLB được hồi tiếp về GRB để có thể kết nốI vớI 
ngỏ vào của các GLB khác trong thiết bị. 

 

 
 

Hình 4.1 Sơ đồ khốI ispLSI 1016 
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Các thiết bị cũng có 32 đơn vị I/O được nốI trực tiếp đến các chân I/O bên ngoài. 
MỗI đơn vị I/O có thể được lập trình riêng rẻ theo các kiểu : Ngỏ vào tổ hợp, ngỏ vào 
thanh ghi, ngỏ vào chốt, ngỏ ra hoặc chân I/O hai chiều 3 trạng thái. Các mức tín hiệu 
tương thích TTL, dòng nguồn ngỏ ra 4 mA và dòng nhận ngỏ ra là 8 mA. MỗI ngỏ ra cho 
phép lập trình độc lập vớI tốc độ tăng điện áp ra nhanh hoặc chậm nhằm giãm thiểu nhiểu 
phát sinh khi ngỏ ra chuyển trạng thái. 

Tám khốI GLB, 16 đơn vị I/O, hai ngỏ vào định sẳn và một ORP được nốI vớI nhau 
tạo thành một khốI mega (hình 4.1), các ngỏ ra của 8 GLB được nốI đến một tập hợp 
gồm 16 đơn vị I/O đa năng bởI ORP. MỗI vi mạch ispLSI 1016 gồm có hai khốI mega 

KhốI GRP có các ngỏ ra cũng như các ngỏ vào được cung cấp từ các GLP, các ngỏ 
vào của đơn vị I/O hai chiều. Tất cả các tín hiệu này có thể dùng làm tín hiệu vào cho các 
GLP 

Xung đồng hồ trong họ ispLSI 1016 được chọn bởI khốI phân phốI xung. Ba chân 
đồng hồ định sẳn Y0, Y1 và Y2 được đưa vào khốI này và năm ngỏ ra đồng hồ CLK 0, 
CLK 1, CLK 2, IOCLK 0 và IOCLK 1 được cung cấp đến các GLB và các đơn vị I/O. KhốI 
phân phốI xung cũng có thể được điều khiển từ một GLB đồng hồ đặc biệt (B0 trong 
ispLSI 1016). Chức năng GLB này cho phép ngườI dùng tạo ra xung đồng hồ bên trong 
qua việc kết hợp các tín hiệu trong thiết bị 

 
2.3 Thông số giớI hạn    

 
Điện áp nuôi Vcc………………………..-0,5 đến +7 V 
Điện áp ngỏ vào ………………………...-2,5 đến Vcc + 1 V 
Điện áp ra ở trạng thái tắt………………-2,5 đến Vcc + 1 V 
Nhiệt độ lưu trử………………………….-65 đến + 1500C 
Nhiệt độ vỏ khi cấp nguồn………………-65 đến + 1250C 
Nhiệt độ mốI nốI tốI đa (TJ) khi cấp nguồn..1500C 
 
 

 
2.4 Điều kiện hoạt động DC 

 
 
Ký hiệu Thông số Min Max Đơn vị 

Thương mại TA = 00C ..+700C 4,75 5,25 V Vcc Điện áp nuôi 
Công nghiệp TA = -400C ..+850C 4,5 5,5 V 

VIL Điện áp vào mức thấp 0 0,8 V 
VIH Điện áp vào mức cao 2 Vcc + 1 V 

 
2.5 Điện dung (TA = 250C, f = 1 MHz) 

 
Ký 
hiệu 

Thông số  Điển 
hình 

Đơn 
vị 

Điều kiện thử 

C1 ngỏ vào định sẳn, I/O, Y1, Y2, Y3, 
(thương mại, công nghiệp) 

8 PF Vcc = 5 V, VPIN = 2 V 

C2 ngỏ đồng hồ Y0 12 PF Vcc = 5 V, VPIN = 2 V 
 

2.6 Đặc tính lưu trử dử liệu 
 

Thông số Min Max Đơn vị 
Thời gian lưu trử 20 - Năm 
Số lần lập trình lạI 10000 - Lần 
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2.7 Điều kiện thử chuyển mạch 
 

Mức xung vào GND đến 3 V 
-125 ≤ 2 ns thờI gian tăng và giãm ngỏ 

vào 10% đến 90% -100, -80 ≤ 3 ns 
Mức tham chiếu thờI gian vào 1,5 V 
Mức tham chiếu thờI gian ra 1,5 V 
TảI ngỏ ra Hình 4.2 

 
 
 
 
 
Điều kiện tảI ngỏ ra (hình 4.2) 
 

Điều kiện thử R1 R2 CL 
A  470 Ω 390 Ω 35 pF 

Tích cực mức cao ∞ 390 Ω 35 pF B Tích cực mức thấp 470 Ω 390 Ω 35 pF 
Tích cực H đến Z tạI VOH 
– 0,5 V 

∞ 390 Ω 5 pF 

C Tích cực L đến Z tạI VOL 
+ 0,5 V 

470 Ω 390 Ω 5 pF 

 
 

2.8 Đặc tính điện DC 
 

Ký hiệu Thông số Điều kiện Min Typ Max Đơn vị 
VOL Điện áp ra mức thấp IOL = 8 mA - - 0,4 V 
VOH Điện áp ra mức cao IOH = -4 mA 2,4 - - V 
IIL Dòng rỉ mức thấp ngỏ vào 

hoặc I/O 
0≤VIN≤VIL 
(max) 

- - -10  μA 

IIH Dòng rỉ mức cao ngỏ vào 
hoặc I/O 

3,5 V≤VIN≤VCC - - 10 μA 

IIL-isp Dòng rỉ ngỏ vào ispEN 0≤VIN≤VIL  - - -150 μA 

IIL-PU Dòng kéo lên I/O 0≤VIN≤VIL  - - -150 μA 
IOS Dòng ngắn mạch ngỏ ra VCC = 5 V, 

VOUT = 0,5 V 
- - -200 mA 

ICC Dòng nuôi VIL = 0,5 V, 
VIH = 3 V, 
fCLOCK = 1 
MHz 

- 90 - mA 

 
2.9 Mô hình thời gian ispLSI 1016 

 

Hình 4.2 Tải thử 
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Hình 4.2 

 
2.10 ThờI gian trì hoản tốI đa của GRB vớI tảI GLB 

 
 

 
 

Hình 4.3 ThờI gian trì hoản của GRB 
 

2.11 Công suất tiêu thụ 
Công suất tiêu thụ của ispLSI 1016 phụ thuộc vào hai yếu tố chính : Tốc độ làm việc 

và số lượng tích số đã xử dụng. Hình 4.4 cho thấy quan hệ giữa công suất vớI tốc độ làm 
việc 

 
 

 
 
ICC có thể được tính theo phương trình sau : 
 
ICC (mA) = 23 + (# of PTs * 0,52) + (# of Nets * max freq * 0,004) 
Trong đó : 
  # of PTs : Số tích số đã dùng 
  # of nets : Số tín hiệu xử dụng 

Hình 4.4 Công suất tiêu thụ với fmax 

Lưu ý : Cấu hình 4 bộ đếm 16 bít với 
dòng điển hình tại 5 V, 250C 
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  max freq : Tần số làm việc cao nhất 
 
Việc tính toán ICC dựa trên các điều kiện chuẩn (VCC = 5 V, 250C) vớI tảI là 4 khốI 

GLB và cấu hình thiết bị là 4 bộ đếm 16 bít. Do giá trị của ICC dể bị ảnh hưởng vớI điều 
kiện làm việc và chương trình trong thiết bị nên trị số thực tế của ICC có thể thay đổI 

 
2.12 Sơ đồ chân 

 
 

 
 

Hình 4.5 Sơ đồ chân PLCC 44 
 
 

 
Hình 4.6 Sơ đồ chân TQFP 44 

 
2.13 Ý nghĩa tên linh kiện 
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BÀI 5 
 
 

Tên bài: Phần mềm ISP Synario Mã bài: CIO 01 09 05 
 
 
 

GIỚI THIỆU 
Bài học này giới thiệu về công cụ phần mềm hổ trợ phát triển hệ thống trên cơ sở 

CPLD của công ty LATTICE SEMICONDUCTOR đó là ispVHDL và ISP Synario, hai hệ 
thống này cho phép lập trình dạng sơ đồ mạch và dạng modul VHDL hoặc kết hợp cả hai 
giúp dể dàng cho lập trình viên có khả năng thiết kế được các yêu cầu phức tạp mà 
không cần quan tâm đến các thao tác nhàm chán nhưng rất quan trọng như quá trình tối 
thiểu hóa, liên kết các file nguồn … 

Nội dung bài kết hợp với các yêu cầu thực hành trên board mạch UNIKIT và chủ 
yếu tập trung vào họ CPLD ispLSI của LATTICE như 1016, 2032 đã đề cập ở bài 4 

MỤC TIÊU THỰC HIỆN 
• Hiểu được cách xử dụng công cụ phần mềm phát triển hệ điều khiển CPLD ISP 

Synario 
• Biết vận dụng ISP Synario để thực hiện một dự án cụ thể 
 

NỘI DUNG CHÍNH 
Nội dung bài học tập trung về các chủ đề chính như sau: 
• Giới thiệu chung về ISP Synario 
• Yêu cầu hệ thống 
• Khởi động Synario 
• Nhập modul VHDL vào dự án 
• Nhập sơ đồ mạch vào dự án 
• Hoàn tất thiết kế 
• Nhập thuộc tính 
• Tạo file véc tơ thử 
• Biên dịch VHDL, sơ đồ và véc tơ thử 
• Mô phỏng chức năng và dạng sóng ra 
• Tạo một ký hiệu 
• Tương thích thiết kế với thiết bị LATTICE 
• Tính năng nhập hổn hợp 
• Tạo file nguồn ABEL-HDL 
• Biên dịch ABEL-HDL 
• Mô phỏng kết quả thiết kế 
• Tương thích thiết kế với thiết bị LATTICE 
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1. GIỚI THIỆU 
Với Synario navigator ngườI dùng có thể thực hiện các yêu cầu thiết kế bao gồm 

việc truy cập các thành phần trong thiết kế, theo dỏI các bước xử lý. NgườI dùng có thể 
mở sơ đồ mạch và trình soạn thảo văn bản thông qua các cấp thiết kế. Trong phần sau 
sẻ hướng dẩn việc ứng dụng phần mềm thiết kế ISP synario qua các đề mục sau : 

 Yêu cầu hệ thống 
 KhởI động ISP synario 
 Nhập một modul VHDL vào dự án thiết kế 
 Nhập một sơ đồ vào dự án thiết kế 
 Hoàn tất dự án 
 Bổ sung thuộc tính 
 Tạo véc tơ thử 
 Dịch sơ đồ và véc tơ thử 
 Thực hiện chức năng mô phỏng và dạng sóng ra 
 Tạo một ký hiệu 
 Chế độ nhập hổn hợp 
 Tạo file nguồn ABEL-HDL 
 Dịch ABEL-HDL 
 Mô phỏng thiết kế 
 nạp kết quả thiết kế vào thiết bị CPLD 

2. YÊU CẦU HỆ THỐNG 
Những phần mềm cần thiết cần phảI cài đặt trong hệ thống máy tính trước khi bắt 

đầu thiết kế  
 ISP Synario Entry/Simulation 
 ISP Synario VHDL Entry 
 IspDS + Filter 

3. KHỞI ĐỘNG SYNARIO 
1. Nhấn kép chuột vào biểu tượng ISP Synario, cửa sổ quản lý dự án ISP Synario 

xuất hiện như ở hình 5.1. Cửa sổ được chia làm hai vùng : Vùng bên trái 
(sources in project) liệt kê các file nguồn của dự án và vùng bên phảI (processes 
for curent source) cho thấy các quá trình xử lý liên kết vớI các file nguồn này 
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Hình 5.1 Cửa sổ quản lý dự án 
 

2. Trong hộp sources in project chọn File ⇒ New Project, hộp thoạI Create New 
Project xuất hiện (h.5.2) 

 

 
 

Hình 5.2 Hộp thoạI Create New Project 
 
3. Trong ổ đỉa C (mặc định) kích đúp chuột để mở ispsyn50 (thư mục cài đặt mặc 

định) 
a. Nếu đang dùng hệ ISP Synario thì phải tạo thư mục tutorial. Kích vào nút 

Create Dir (h.5.2), hộp thoại Create Directory xuất hiện nhập vào 
tutorial 

b. Nếu đang dùng hệ ispVHDL Synario thì thư mục tutorial đả được tự 
động tạo ra trong khi cài đặt. Kích đúp để mở nó ra, trong hộp Project 
File Name nhập tên tutor.syn và ấn OK 

4. Trong cửa sổ quản lý dự án có hai muc Untitled và Virtual Device. Để đặt tên dự 
án, kích đúp lên Untitled. Một hộp thoại Project Title xuất hiện (h.5.3) nhập  
Demo Project vào vùng Title sau đó ấn OK 
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Hình 5.3 Cửa sổ quản lý dự án và hộp Project Title 
 
5. Kích chọn mục Virtual Device để xổ xuống cửa sổ Choose Device. Chọn danh 

sách thiết bị ISP Synario Device List trong vùng Device Kit. Một danh sách thiết 
bị xuất hiện (h.5.4) 

 

 
 

Hình 5.4 Cửa sổ chọn thiết bị 
 
6. Cuộn qua danh sách thiết bị đến mục ispLSI 2032-150 TQFP44. Chiếu sáng 

thiết bị này và ấn OK. Bạn sẻ được hỏI để xác nhận sự chọn lựa này vì nó sẻ 
làm thay đổI môi trường thiết kế dự án. Ấn YES 
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4. NHẬP MODUL VHDL VÀO DỰ ÁN 
Thiết kế dự án là sự kết hợp từ một hoặc nhiều nguồn có thể là sơ đồ mạch, file 

ABEL-HDL, file VHDL (chỉ đốI vớI hệ ispVHDL Synario), file véc tơ thử hoặc các file tài 
liệu. 

Bốn bước sau đây sẻ trình bày chi tiết phương pháp dùng một modul VHDL để thiết 
kế dự án. Nếu không muốn dùng tính năng VHDL thì có thể bỏ qua bốn bước này 

7. VớI thiết bị ispLSI 2032 đã chọn, ghi lạI các phương thức xử lý được liên kết vớI 
nguồn này. Từ thanh menu chọn Source ⇒ Import 

8. Trong danh sách thư mục của hộp thoạI Import File chọn đường dẩn drive 
:\ispsyn50\tutorial. Chiếu sáng tên file demo.vhd trong vùng file name. Ấn OK, 
hộp thoạI Import Source Type xuất hiện, chọn VHDL Module và ấn OK như ở 
hình 5.5 

 

 
 

Hình 5.5 Hộp thoạI Import Source Type 
 
File VHDL demo.vhd xuất hiện trong phần Source của danh sách dự án trong cửa 

sổ quản lý dự án. Chiếu sáng biểu tượng VHDL và lưu ý phương pháp xử lý liên kết vớI 
nó. Có thể xem cú pháp bằng cách dùng trình soạn thảo văn bản (h.5.6) 

 

 
 

Hình 5.6 Trình soạn thảo văn bản vớI file demo.vhd 
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PhảI dùng thuộc tính thiết kế LOCK để gán số “4” cho chân I/O, dòng “scp C path1” 
cho biết đường dẩn khởi động và path1 bao gồm tên duy nhất cho thuộc tính đường dẩn 

9. Với file VHDL được chiếu sáng, mục chọn Synthezise Logic trong bảng danh 
sách xử lý cũng được chiếu sáng. Chọn nút nhấn Properties bên dưới để làm 
xuất hiện hộp thoại Properities (Normal : VHDL) 

10. Các thuộc tính nhìn thấy trên hộp thoại là mặc định của modul VHDL. Chiếu 
sáng tùy chọn thuộc tính Generate Reset Logic và dùng phím mũi tên để thay đổi 
từ False thành True. Kích vài dấu kiểm để chấp thuận thay đổi. Hộp thoại hiển thị 
như ở hình 5.7. Đóng hộp thoại 

 

 
 

Hình 5.7 Hộp thoại Properties (Normal : VHDL) 
 

Khi một thuộc tính bất kỳ được thay đổi, nút Default nổi lên cho phép trả về giá trị 
mặc định nếu cần 

5. NHẬP SƠ ĐỒ MẠCH VÀO DỰ ÁN 
Các bước sau đây hướng dẩn cách nhập một sơ đồ trống vào dự án, tiếp theo là 

nhập các ký hiệu và kết nối chúng với nhau 
11. Với thiết bị 2032 đã được chọn ở trên, ghi lại các bước xử lý tương ứng với 

nguồn này. Từ thanh menu chọn Source ⇒ New 
12. Trong hộp thoại New Source chọn Schematic và kích OK hoặc ấn Enter. Một 

hộp thoại xuất hiện yêu cầu nhập tên cho sơ đồ. Chọn đường dẩn 
c:\ispsyn50\tutorial và nhập tên file demo.sch trong vùng text. Kích OK hoặc ấn 
Enter 

 
Lưu ý : Để tránh rắc rối có thể xảy ra tốt nhất nên đặt tên cho file nguồn và file dự 
án khác nhau 
 
13. Một sơ đồ trống sẻ xuất hiện trong cửa sổ soạn thảo (h.5.8). Từ thanh menu 

chọn Add ⇒ Symbol 
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Hình 5.8 Cửa sổ soạn thảo sơ đồ 
 
Mẹo : Dùng chức năng Zoom trong menu thả xuống ở mục View hoặc trên thanh 
công cụ Schematic Editor để dể quan sát 
 
14. Trong hộp thoại Symbol Libraries chọn C:\...\generic\gates.lib từ danh sách thư 

viện sau đó chiếu sáng ký hiệu G_2AND (h.5.9) 
 

 
 

Hình 5.9 Cửa sổ Symbol Libraries 
 
15. Chuyển con trỏ trở về Schematic Editor, lưu ý là cổng AND được dính kèm theo 

con trỏ, đặt cổng bằng cách kích lên sơ đồ, đặt thêm một cổng AND khác bên 
dưới cổng thứ nhất. 

16. Đưa con trỏ trở vào hộp thoại Symbol Libraries và chọn ký hiệu G_2OR, đặt 
cổng này về bên phải của hai cổng AND vừa rồi 
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17. Từ thanh menu trong Schematic Editor chọn Add ⇒ Wire, kích vào chân ra của 
cổng AND phía trên để bắt đầu nối dây. Kích đơn để bẻ cong dây nối và kích đúp 
để kết thúc dây nối. Kích đơn để nối đến ngỏ vào của cổng OR. Lặp lại các thao 
tác vừa rồi với cổng AND bên dưới 

18. Thực hiện lại các bước như trên để nhập vào một thanh ghi g_d từ thư viện 
REGS.LIB và một G_OUTPUT từ thư viện IOPADS.LIB, nối tất cả chúng lại theo 
sơ đồ ở hình 5.10 

19. Từ thanh menu trong cửa sổ Schematic Editor chọn File ⇒ Save để lưu lại các 
thiết kế vừa rồi 

 

 
 

Hình 5.10 Xây dựng sơ đồ 
 

6. HOÀN TẤT THIẾT KẾ 
Thiết kế được hoàn tất bằng cách thêm tên mạng và các dấu I/O, tên mạng được 

nhập bằng tính năng của ISP Synario, tính năng này cho phép nhập cùng lúc mạng và tên 
mạng. Dấu I/O là các ký hiệu đặc biệt cho biết các tín hiệu biểu diển chân của linh kiện. 
Các ký hiệu này chấp nhận tên mạng mà chúng thâm nhập và khác với các ký hiệu chân 
I/O 

20. Trên thanh menu của Schematic Editor chọn Add ⇒ Net Name. Thanh trạng 
thái dưới đáy màn hình sẻ hiện câu nhắc nhập tên mạng. Nhập A và ấn Enter. 
Tên mạng sẻ dính vào con trỏ 

21. Di chuyển con trỏ đến ngỏ vào trên cùng, kích và giử tại điểm chưa nối của 
mạng (chấm màu đỏ bên trái của mạng) drag về bên trái và thả ra. Thao tác này 
đồng thời đặt tên mạng và tạo ra một mạng vào. Tên mạng nên được đặt tại 
điểm cuối của mạng 
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22. Lặp lại các bước trên để nhập tên mạng “B”, “C”, “D” và “CK” cho các ngỏ vào 
và “OUTP” cho ngỏ ra 

 
Mẹo : Đối với các ngỏ vào còn lại sau khi nhập tên và ấn Enter, mổi lần kích vào 
điểm cuối của mạng, chiều dài mạng sẻ bằng với lần đặt đầu tiên bằng cách kích 
giử và rê chuột 
 
23. Từ thanh menu trong Schematic Editor chọn Add ⇒ I/O Marker. Hộp thoại I/O 

Marker xuất hiện, chọn Input 
24. Đưa con trỏ kích vào điểm cuối của một mạng vào (ở giửa điểm cuối và tên của 

mạng). Một dấu I/O xuất hiện với tên mạng chứa bên trong, di chuyển đến ngỏ 
vào kế tiếp và kích chuột. Lặp lại thao tác trên cho đến khi tất cả các ngỏ vào 
đều có dấu I/O 

 
Mẹo : Để nhập một lần tất cả các dấu input, kích và giử chuột sau đó rê một khung 
bao tất cả các mạng vào và nhả ra. Thao tác này cũng áp dụng tốt với các ngỏ ra 
 
25. Chọn Output từ hộp thoại I/O Marker, kích tại điểm cuối của mạng ra. Sơ đồ 

hoàn tất được trình bày trong hình 5.11 Chọn lưu sơ đồ 
 

 
 

Hình 5.11 Sơ đồ hoàn tất 
 
 

7. NHẬP THUỘC TÍNH 
Thuộc tính có thể được nhập vào ký hiệu hoặc mạng. Ví dụ sau sẻ nhập một thuộc 

tính LOCK vào ký hiệu chân ra và một cặp thuộc tính SCP/ECP (đường dẩn giới hạn 
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Start/End) vào đường dẩn. Lưu ý là trong ISP Synario các thuộc tính pin được nhập vào 
các ký hiệu chân I/O thực chứ không phải các dấu I/O và cũng cần nhớ rằng các ký hiệu 
chân I/O chỉ thực sự cần thiết khi muốn nhập các thuộc tính cho các pin. Nếu không thì 
chỉ cần dùng các dấu I/O 

26. Từ thanh menu trong Schematic Editor chọn Add  ⇒ Symbol Attribute, hộp 
thoại Symbol Attribute Editor xuất hiện. Trên sơ đồ kích vào chân I/O dính với 
mạng OUTP. Một danh sách thuộc tính liên quan xuất hiện trong hộp thoại 

27. Chọn thuộc tính ISP SynarioPin=* và thay thế dấu * bằng số 4 như chỉ ở hình 
5.12. Đóng hộp thoại, chú ý : Số 4 đẫ được nhập vào ký hiệu chân I/O trong sơ 
đồ 

 

 
 

Hình 5.12 Symbol Attribute Editor 
 
28. Thực hiện tương tự để nhập thuộc tính cho mạng hoặc đường dẩn. Từ thanh 

menu của Schematic Editor chọn Add ⇒ Net Attribute. Hộp thoại Net Attribute 
Editor xuất hiện. Trên sơ đồ kích vào mạng nối với ngỏ vào “C” của cổng AND, 
một danh sách thuộc tính liên quan xuất hiện trong hộp thoại 

29. Chọn thuộc tính CriticalPath= và nhập S,path1 vào hộp văn bản như chỉ ở hình 
5.13  S cho biết vị trí bắt đầu của đường dẩn và path 1 bao gồm tên duy nhất 
cho thuộc tính đường dẩn. Thuộc tính này không được hiển thị trên sơ đồ 

 

 
 

Hình 5.13 Net Attribute Editor 
 
30. Trên sơ đồ, kích vào mạng nối cổng OR với D-FF. Trong hộp thoại Net Attribute 

Editor nhập E,path1 để xác định vị trí kết thúc của đường dẩn giới hạn có tên 
“path 1”. Đóng hộp thoại 

31. Kiểm tra lổi cho sơ đồ bằng cách chọn File ⇒ Consistency Check. Một cửa sổ 
thông báo lổi được hiện lên với câu thông báo  

 
No Symbol for this schematic 
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Nếu sơ đồ là mới và chưa đươc lưu. Nếu là sơ đồ củ, chọn File ⇒ Matching 
Symbol. ISP Synario sẻ hỏi có muốn thay thế file design.sym. Chọn Replace 

 
Lưu ý : Nếu các dấu I/O đã được nhập hoặc tháo bỏ thì phải thay thế ký hiệu bằng 

cách chọn File ⇒ Matching Symbol 
32. Từ thanh menu của Schematic Editor chọn File ⇒ Save để lưu kết quả thiết kế, 

chọn File ⇒ Exit để đóng cửa sổ Schematic Editor. Các thao tác trình bày ở trên 
cũng có thể được dùng để khóa một pin vào 

8. TẠO VÉC TƠ THỬ 
Trong ISP Saynario cho phép áp dụng một hoặc nhiều tập các véc tơ thử để mô 

phỏng chức năng của thiết bị. Trong phần này sẻ giới thiệu cách tạo một tập các véc tơ 
thử đơn giản 

33. Trong ISP Synario Project Navigator, chiếu sáng thiết bị ispLSI 2032-150 
TQFP44. Từ thanh menu chọn Source ⇒ New. Một hộp thoại New Source xuất 
hiên, chiếu sáng mục ABEL Test Vectors và kích OK hoặc ấn Enter. 

34. Hộp thoại New File và một cửa sổ ISP Synario Text Editor còn trống xuất hiện. 
Nhập tên file demo như trong hình 5.14 cho tên file véc tơ thử. Kích OK hoặc ấn 
Enter 

 

 
 

Hình 5.14 ISP Synario Text Editor với hộp thoại New File 
 
35. Trong cửa sổ ISP Synario Text Editor nhập các dòng sau, chú ý chử thường và 

chử hoa (giống ngôn ngử “C”) 
 

module demo; 
c,x = .c.,.x.; 
CK,A,B,C,D,OUTP PIN; 
TEST_VECTORS 
([CK,A,B,C,D]->[OUTP]) 
[c , 0 , 0 , 0 , 0]->[x]; 
[c , 0 , 0 , 1 , 0]->[x]; 
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[c , 1 , 1 , 0 , 0]->[x]; 
[c , 0 , 1 , 0 , 1]->[x]; 
END 
 

36. Sau khi nhập xong chọn File ⇒ Save từ thanh menu trong ISP Synario Text 
Editor để lưu file véc tơ thử. Chọn File ⇒ Exit. ISP Synario sẻ trở về cửa sổ 
Project Navigator như trình bày ở hình 5.15  

 

 
 

Hình 5.15 ISP Synario Project Navigator 
 

9. BIÊN DỊCH FILE VHDL, SƠ ĐỒ VÀ VÉC TƠ THỬ 
Bây giờ với các file nguồn đã được tạo ra trong dự án, bước kế tiếp là thực hiện 

quá trình xử lý liên hệ với từng file nguồn. Các quá trình xử lý khác nhau này được hiển 
thị và thực hiện bằng cách chọn từng file nguồn. Trong phần này sẻ trình bày việc biên 
dịch file sơ đồ và file véc tơ thử độc lập nhau 

37. Trong cửa sổ ISP Synario Project Navigator, chiếu sáng file sơ đồ có tên demo 
(demo.sch) trong bảng danh sách Sources in Project, kích đúp vào mục Compile 
Schematic trong bảng Processes. Một hộp thoại trạng thái (h.5.16) xuất hiện 
trong khoảng thời gian ngắn. Khi quá trình xử lý kết thúc, trên mục Compile 
Schematic process xuất hiện dấu kiểm màu xanh lá ở kế bên cho biết kết quả 
biên dịch thành công 

 

 
 

Hình 5.16 Hộp thoại trạng thái ISP 
Synario Process 

 



 110 

38. Trong cửa sổ ISP Synario Project Navigator, chiếu sáng file véc tơ thử 
demo.abv. Kích đúp vào mục Compile Test Vectors trong bảng Processes. Một 
dấu kiểm xanh lá xuất hiện kế bên mục Compile Test Vectors khi hoàn tất. 

10. MÔ PHỎNG CHỨC NĂNG VÀ DẠNG SÓNG RA 
Hệ ISP Synario bao gồm tính năng xem dạng sóng ra và mô phỏng chức năng. Các 

bước sau đây trình bày phương pháp thực hiện để đạt được kết quả 
39. Với file véc tơ thử demo.abv đã được chiếu sáng, kích đúp vào mục Equation 

Simulation Waveform trong danh sách Processes. ISP Synario sẻ mô phỏng các 
phương trình và mở cửa sổ Waveform Viewer như trong hình 5.17 

 

 
 

Hình 5.17 Cửa sổ Waveform Viewer 
 
40. Để xem dạng sóng, chọn Edit ⇒ Show từ thanh menu của Waveform Viewer. 

Hộp thoại Show Waveforms xuất hiện như trên hình 5.18 
 

 
 

Hình 5.18 Hộp thoại Show Waveforms 
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41. Tại từng thời điểm, chiếu sáng tên tín hiệu cần xem và ấn Show, dạng sóng 
được chọn sẻ xuất hiện trên cửa sổ Waveform Viewer theo thứ tự chọn. (h.5.19). 
Chọn File ⇒ Exit để đóng Waveform Viewer, một hộp thoại xuất hiện yêu cầu 
xác nhận thay đổi dạng sóng PLA 

 
Mẹo : Chọn nhiều tên tín hiệu cùng lúc bằng cách giử và rê chuột để chiếu sáng 
chúng. Hoặc ấn giử phím CTRL và kích vào từng tên để xem 
 

 
 

Hình 5.19 Một dạng sóng đầy đủ 
 
 

11. TẠO MỘT KÝ HIỆU 
Một tính năng rất hửu dụng của ISP Synario là cho phép tạo nhanh một ký hiệu 

trong sơ đồ. Với tính năng này có thể tạo các macro có thể dùng lại và đặt vào các bản 
sơ đồ cấp cao hơn 

42. Mở file sơ đồ bằng cách kích đúp vào schematic source, demo.sch trong ISP 
Synario Project Navigator 

43. Trong thanh menu của Schematic Editor chọn File ⇒ Matching Symbol. 
44. Chọn File ⇒ Exit để đóng sơ đồ 
45. Ký hiệu đã được tạo ra và nhập vào bảng symbol sẳn sàng để xử dụng cho lần 

sau 

12. THÍCH ỨNG THIẾT KẾ VỚI THIẾT BỊ CỦA LATTICE 
SEMICONDUCTOR 

Bây giờ ví dụ thiết kế đã được hoàn tất và mô phỏng. Nếu dự định  kế tiếp là biên 
dịch VHDL, ABEL-HDL và sơ đồ thì không cần thiết phải hoàn tất các bước còn lại trong 
phần trình bày này. Ngược lại, quá trình xử lý cuối cùng là phải làm cho tương thích giửa 
kết quả thiết kế với họ ispLSI của công ty LATTICE 

46. Chọn ispLSI 2032-150 TQFP44 và quan sát các xử lý liên quan. Kích đúp vào 
mục xử lý Fit Design. Một hộp thoại ISP Synario Process xuất hiện. Khi biên dịch 
xong file nguồn tiếp theo đó  ISP Synario sẻ liên kết các file này lại với nhau. 
Cuối cùng là phân vùng chương trình và tương thích hóa thiết kế vào  phần LSC. 
Khi xử lý hoàn tất ISP Synario quay về cửa sổ Project Navigator (hình 5.20). Chú 
ý dấu kiểm được thêm vào mục Fit Design báo cho biết việc xử lý thành công 

 



 112 

 
 

Hình 5.20 ISP Synario Project Navigator sau khi xử lý Fit Design 
 
Lưu ý : Dấu chấm than màu vàng cho biết có cảnh báo được tạo ra và dấu X đỏ 
báo có lổi xảy ra 
47. Kích đúp vào Fitter Report trong danh sách Processes để xem thông tin về quá 

trình tương thích hóa kết quả thiết kế 
 

 
 

Hình 5.21 Báo cáo sau khi tương thích hóa 
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13. CHẾ ĐỘ NHẬP HỔN HỢP 
Có thể kết hợp phần mềm ispVHDL và ISP Synario để tạo một bản thiết kế VHDL 

tốt hơn là thiết kế ABEL-HDL. Tuy nhiên, để làm quen với công cụ này trước tiên sẻ tạo 
ra một thiết kế ABEL-HDL đơn giản sau đó liên kết nó với sơ đồ từ các bước trước trên 
một sơ đồ cấp đỉnh. Bản thiết kế hoàn tất này sẻ được mô phỏng và biên dịch vào một 
thiết bị ispLSI 

48. Nếu đã thoát ra ISP Synario. Khởi động lại bằng cách kích đúp vào biểu tượng 
trong nhóm chương trình ISP Synarrio. Màn hình Navigator xuất hiện như hình 
5.22. Nếu không giống thì phải bảo đảm tất cả các bước ở phần trên đã được 
hoàn tất một cách đúng đắn 

 

 
 

Hình 5.22 ISP Synario Project Navigator 
 
49. Với thiết bị 2032 đã được chọn, chọn mục Source ⇒ New từ thanh menu của 

ISP Synario Project Navigator. Trong hộp thoại chọn Schematic và kích OK. 
Chọn đường dẩn c:\ispsyn50\tutorial và nhập tên file top.sch vào hôp File Name. 
Kích OK để vào Schematic Editor 

50. Thêm ký hiệu vào sơ đồ đã tạo ở phần trên. Chọn Add ⇒ Symbol. Hộp thoại 
Symbol Libraries xuất hiện với Local library được chọn. Chú ý, ký hiệu demo 
nằm trong text box phía dưới (h.5.23). Chọn ký hiệu demo và đặt nó vào sơ đồ 
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Hình 5.23 Schematic Editor  với  hộp thoại Symbol Libraries 
 
Bước kế tiếp là tạo ra một ký hiệu cấp đỉnh cho file thiết kế ABEL-HDL. Một ký hiệu 

có thể được tạo ra cho modul thiết kế với có mức thấp tùy ý khi biết được giao tiếp của 
nó. File ABEL-HDL thực tế cho dự án thiết kế sẻ được hoàn tất trong một bước tiếp theo 
sau đây 

51. Trong của sổ Schematic Editor chọn Add ⇒ New Block Symbol, trong hộp 
thoại hiện ra nhập vào abeltop trong text box Block Name, IN1, IN2, IN3 trong 
hộp văn bản Input Pins và OUT1, OUT2, OUT3, OUT4 trong hộp văn bản Output 
Pins (h.5.24). Kích RUN 

 

 
 

Hình 5.24 Hộp thoại New Block Symbol 
 
52. Một ký hiệu sẻ được thêm vào local library và ký hiệu này dính kèm theo con trỏ, 

đặt ký hiều về bên trái của ký hiệu demo. Kích chuột phải để hiển thị hộp thoại 
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Symbol Libraries (h.5.25). Chú ý ký hiệu abeltop trong Local library. Đóng hgộp 
thoại 

 

 
 

Hình 5.25 Thêm ký hiệu từ Local Library 
 
53. Hoàn tất sơ đồ cấp đỉnh bằng cách thêm vào các dây nối, tên mạng và các dấu 

I/O cần thiết để kết thúc thiết kế (h.5.26), thực hiện kiểm tra tính đồng nhất và tạo 
một ký hiệu tương thích. Lưu thiết kế và thoát khỏi Schematic Editor 
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Hình 5.26 Hoàn tất thiết kế abeltop 
 
Nếu thích chỉnh sửa cho đúng và đồng nhất bản thiết kế cấp đỉnh, lập trình viên có 

thể chuyển qua các mức thiết kế dùng tính năng Hierarchy Navigator. Một số chức năng 
soạn thảo có hiệu lực qua Navigator 

54. Trong các file nguồn trong danh sách Project của cửa sổ ISP Synario Project 
Navigator, chiếu sáng sơ đồ cấp đỉnh (top.sch). Trong danh sách Processes kích 
đúp lên Navigate Hierarchy, một hộp thông điệp Building Hierarchy xuất hiện 
trong một khoảng thời gian ngắn. Sau đó cửa sổ Hierarchy Navigator hiện ra với 
bản thiết kế cấp đỉnh 

55. Chọn View ⇒ Push/Pop, con trỏ biến thành hình chử thập. Kích lên ký hiệu 
mong muốn, Hierarchy Navigator sẻ mở trang của ký hiệu đó tại cấp kế tiếp. Nếu 
kích lên ký hiệu gốc sẻ xuất hiện một thông báo nhắc nhở ở dưới đáy cửa sổ 
Navigator 

56. Chọn File ⇒ Exit để đóng Hierarchy Navigator và hiện lên câu hỏi save 
changes you made nếu có thay đổi nào đó  

 

14. TẠO FILE NGUỒN ABEL-HDL 
Bây giờ cần phải tạo file nguồn ABEL-HDL và liên kết nó với ký hiệu trên sơ đồ cấp 

đỉnh. Project Navigator thực hiện việc này một cách dể dàng 
57. Cửa sổ Navìgator giống như trong hình 5.27 Biểu tượng “?” của abeltop có 

nghỉa là file này không biết do đã chưa tạo ra nó. Lưu ý đến khoảng thụt vào của 
abeltop và file demo so với sơ đồ cấp đỉnh (sơ đồ chính) 
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Hình 5.27 ISP Synario Project Navigator 
 
58. Để tạo file nguồn, chiếu sáng mục abeltop sau đó chọn Source ⇒ New. Trong 

hộp thoại New Source chọn ABEL-HDL Module và kích OK. Một trình soạn thảo 
văn bản ISP Synario hiện ra với hộp thoại New ABEL-HDL Source (h.5.28) 

 

 
 

Hình 5.28 Hộp thoại New ABEL-HDL Source 
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Để file được liên kết với ký hiệu phải đặt tên modul giống với tên ký hiệu. Tên file 
không cần giống tên ký hiệu nhưng để cho đơn giản cũng nênđặt tên giống nhau. Điền 
vào các vùng văn bản như sau : 

 
Module Name: abeltop 
File Name: abeltop.abl 
Title: This is the Top Level ABEL file 
 
Kích OK để vào trình soạn thảo văn bản ISP Synario và sẻ thấy khung làm việc 

được khởi tạo sẳn 
59. Nhập vào mả lệnh như bên dưới phải bảo đảm nhập đúng ở khoảng giửa hai 

câu lệnh TITLE và END như trong hình 5.29 
 

"Inputs 
     IN1,IN2,IN3 pin; 
"Outputs 
     OUT1,OUT2,OUT3,OUT4   pin; 
 
Equations 
     OUT1=IN1 & !IN3; 
     OUT2=IN1 & !IN2; 
     OUT3=!IN1 & IN2 & IN3; 
     OUT4=IN2 & IN3; 
 

 
 

Hình 5.29 Trình soạn thảo văn bản ISP Synario 
 

60. Chọn File ⇒ Save sau đó File ⇒ Exit. Chú ý trong cửa sổ Project Navigator 
biểu tượng kế bên abeltop đã thay đổi, có nghỉa là đã có một file ABEL-HDL 
tương ứng và nó sẻ được liên kết chính xác. 
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15. BIÊN DỊCH ABEL-HDL 
61. Trong các file nguồn trong vùng Project của Project Navigator chọn 

abeltop (abeltop.abl), trong cửa sổ Processes for Current Source kích đúp 
vào mục Reduce Logic. Navigator sẻ biên dịch cẩn thận trước khi thực hiện 
yêu cầu Reduce Logic (tối thiểu hóa). Khi kết thúc màn hình Navigator 
giống như hình 5.30 

 

 
 

Hình 5.30 ISP Synario Project Navigator sau khi biên dịch ABEL-HDL 
 

16. MÔ PHỎNG KẾT QUẢ THIẾT KẾ 
Trong phần này sẻ mô phỏng toàn bộ kết quả thiết kế, để thực hiện cần phải có một 

file véc tơ thử (.abv) trong phần này sẻ chỉnh sửa file véc tơ thử đã được tạo ra ở các 
phần trên. 

62. Kích đúp lên file demo.abv trong cửa sổ Project Navigator, trình soạn thảo văn 
bản ISP Synario xuất hiện với cú pháp đã được nhập ở bước 39. Chỉnh sửa như 
sau : 

module demo; 
c,x = .c.,.x.; 
CLK,TOPIN1,TOPIN2,TOPIN3,TOPOUT PIN; 
TEST_VECTORS 
([CLK,TOPIN1,TOPIN2,TOPIN3]->[TOPOUT]) 
[c , 0 , 0 , 0]->[x]; 
[c , 0 , 0 , 1]->[x]; 
[c , 0 , 1 , 0]->[x]; 
[c , 0 , 1 , 1]->[x]; 
[c , 1 , 0 , 0]->[x]; 
[c , 1 , 0 , 1]->[x]; 
[c , 1 , 1 , 0]->[x]; 
[c , 1 , 1 , 1]->[x]; 
END 
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Hình 5.31 File véc tơ thử trong trình soạn thảo văn bản ISP Synario 
 
63. Sau khi chỉnh sửa xong chọn File ⇒ Save, tiếp theo chọn File ⇒ Exit 
64. Trong Navigator với véc tơ thử vẩn còn được chọn, kichý đúp lên Equation 

Simulation Waveform process, cửa sổ Waveform Viewer xuất hiện 
65. Để xem dạng sóng chọn Edit ⇒ Show. Hộp thoại Show Waveforms hiện ra với 

đầy đủ tên các tín hiệu 
66. Để xem cùng lúc chọn TOPIN1, TOPIN2, TOPIN3, TOPOUT và CLK và kích 

Show. Từng tín hiệu sẻ hiển thị trong Waveform Viewer (h.5.32). Đóng hộp thoại 
Show Waveforms, chọn File ⇒ Save trong cửa sổ Waveform Viewer, tiếp theo 
chọn File ⇒ Exit. 
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Hình 5.32 Hộp thoại Show Waveforms và Waveform Viewer 
 

17. THÍCH ỨNG THIẾT KẾ VỚI THIẾT BỊ LATTICE 
Dự án thiết kế hổn hợp giữa sơ đồ với ABEL-HDL đã hoàn tất và đã chạy mô 

phỏng, chỉ còn bước cuối cùng là tương thích hóa thiết kế với họ ispLSI của LATTICE 
67. Từ cửa sổ Sources in Project trong ISP Synario Project Navigator chọn ispLSI 

2032-150 TQFP44 và quan sát các quá trình xử lý liên quan được tạo ra 
68. Trong danh sách Processes for Current Source kích đúp lên mục Fit Design. 

Việc làm này sẻ bắt Navigator phải kết thúc quá trình dịch và liên kết các file 
nguồn lại với nhau trước khi phân vùng và tương thích thiết kế vào một phần 
LSC. ISP Synario Project Navigator sẻ thêm dấu kiểm khi nhiệm vụ thành công 
(h.5.33) 
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Hình 5.33 ISP Synario Project Navigator sau khi tương thích thành công 
 
69. Phần mềm ispDS+ có một số điều khiển người dùng có thể được truy cập từ 

Navigator, chiếu sáng Fit Design và kích Properties tại phía dưới đáy của cửa 
sổ Navigator, một hộp thoại chứa danh sách các thuộc tính xuất hiện 

70. Để xem tất cả các thông tin liên quan đến việc tương thích hóa kích đúp vào ISP 
Synario Fitter Report, cửa sổ tutor.rpt hiện ra trong ISP Synario Report Viewer 
(h.5.34), có thể cuốn cửa sổ report đối với dử liệu thiết kế 
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Hình 5.34  ISP Synario Report Viewer với các chức năng chính của ispVHDL và ISP Synario 
 
 
 



 124 

TÀI LIỆU THAM KHẢO 
 

1. Kỹ thuật điện tử số Đặng văn Chuyết 

2. Baugruppen der Mikroelektronik III Pflaum Verlag Muenchen 

3. Xilinx-ABEL Design Software Reference Manual Data I/O Corp., 1993 

4. The ISP Application Guide and CPLD Data Book, 
Application Note XAPP075, 1997 Xilinx, San Jose, CA, 1997 

5. D. Van den Bout, "Xilinx FPGA Student Manual" 

 

Prentice Hall, Englewoods 
Cliff, NJ, 1997. 

 

6. R. Katz, "Contemporary Logic Design," 
Benjamin/Cummings Publ. Comp. Redwood City, CA, 1995 

7. J. Wakerly, "Digital Design," Prentice Hall, Englewoods 
Cliff, NJ, 1993. 

8. Xilinx Foundation Series, On-line documentation Xilinx, San Jose, CA 

9. PLD Designer’s Guide Roger C Alford 

 


	LỜI TỰA 
	MỤC LỤC 
	GIỚI THIỆU VỀ MÔ ĐUN 
	Vị trí, ý nghĩa, vai trò mô đun 
	Mục tiêu của môdun 
	Mục tiêu thực hiện của mô đun 
	Nội dung chính của mô đun 
	SƠ ĐỒ QUAN HỆ THEO TRÌNH TỰ HỌC NGHỀ 
	CÁC HÌNH THỨC HỌC TẬP CHÍNH TRONG MÔ ĐUN 
	YÊU CẦU VỀ ĐÁNH GIÁ HOÀN THÀNH MÔ ĐUN 
	BÀI 1 
	GIỚI THIỆU 
	MỤC TIÊU THỰC HIỆN 
	NỘI DUNG CHÍNH 
	1. LỊCH SỬ PHÁT TRIỂN 
	2. CẤU TRÚC CƠ BẢN CỦA PLD 
	2.1 Họ vi mạch PROM 
	2.2 Họ vi mạch FPLA ( Field Progammable Logic Array) 
	2.3 Họ vi mạch FPLS ( Field Programable Logic Sequencer) 
	2.4 Ho vi mạch FPGA ( Field Progammable Gate Array). 
	2.5 Ho vi mạch  PAL ( Programmable Array Logic). 
	2.6 Họ vi mạch GAL ( Generic Array Logic). 
	2.7 Họ vi mạch PEEL (Progammable Electrially Erasable Logic). 
	2.8 Họ vi mạch PML ( Programmable Macro Logic). 
	2.9 Họ vi mạch ERASIC(Erasable Programmable Application Specific IC). 
	2.10 Họ vi mạch LCA ( Logic Cell Array) 

	3. PHẦN MỀM HỔ TRỢ PLD 
	3.1 Phần mềm PALASM 2 (PAL Assembler) 
	3.2 Phần mềm AMAZE. 
	3.3 Phần mềm PLAN ( Programmable Logic Analysis). 
	3.4 Phần mềm HELD (Harris Enhanced Language for Programmable Logic). 
	3.5 Phần mềm PLPL (Programmable Logic Programming Language). 
	3.6 Phần mềm APEEL (Assembler for Programmable Electrically Erasable Logic). 
	3.7 Phần mềm IPLDS II (Intel Programmable Logic Devolopment System II). 
	3.8 Phần mềm CUPL ( Universal Compiler for Programmable Logic ). 
	3.9 Phần mềm ABEL (Advanced Boolean Expression Language). 

	BÀI 2 
	GIỚI THIỆU 
	MỤC TIÊU THỰC HIỆN 
	NỘI DUNG CHÍNH 
	1. GIỚI THIỆU CHUNG 
	2. PLA và PAL 
	3. CÁC VÍ DỤ THIẾT KẾ 
	3.1 Bộ chuyển mã BCD sang Gray 
	3.2 Bộ so sánh hai bít 

	4. CÁC MẢNG LOGIC LẬP TRÌNH THÔNG DỤNG 
	4.1 GAL16V8C 
	4.1.1 Ngỏ ra OLMC 
	4.1.2 Trình dịch hổ trợ OLMC 
	4.1.3 Chế độ thanh ghi 
	4.1.4 Chế độ complex 
	4.1.5 Chế độ simple 

	4.2 ispGAL22V10 
	4.2.1 OLMC 
	4.2.2 Cấu hình OLMC 


	BÀI 3 
	GIỚI THIỆU 
	MỤC TIÊU THỰC HIỆN 
	NỘI DUNG CHÍNH 
	 1. GIỚI THIỆU 
	2. CẤU TRÚC FILE NGUỒN ABEL 
	3. CÁC MÔ TẢ 
	4. SỐ 
	5. CÁC CHỈ DẨN 
	5.1 @ALTERNATE  
	5.2 @STANDARD  

	6. TẬP HỢP 
	6.1 Chỉ số hoặc truy xuất một tập hợp 
	6.2 Các toán tử trên tập hợp 

	7. TOÁN TỬ 
	7.1 Toán tử logic 
	7.2 Toán tử số học 
	7.3 Toán tử so sánh 
	7.4 Toán tử gán 
	7.5 Thứ tự ưu tiên 

	8. MÔ TẢ LOGIC 
	8.1 Phương trình 
	8.2 bảng sự thật 
	8.3 Mô tả trạng thái 
	8.4 Dấu chấm (.) 
	8.5 Các véc tơ thử 
	8.6 Các câu lệnh thuộc tính 
	8.7 Linh tinh 

	9. CHƯONG TRÌNH MẪU 
	BÀI 4 
	GIỚI THIỆU 
	MỤC TIÊU THỰC HIỆN 
	NỘI DUNG CHÍNH 
	1. GIỚI THIỆU CHUNG 
	2. VI MẠCH ispLSI 1016  
	2.1 Đặc tính 
	2.2 Mô tả 
	2.3 Thông số giớI hạn    
	2.4 Điều kiện hoạt động DC 
	2.5 Điện dung (TA = 250C, f = 1 MHz) 
	2.6 Đặc tính lưu trử dử liệu 
	2.7 Điều kiện thử chuyển mạch 
	2.8 Đặc tính điện DC 
	2.9 Mô hình thời gian ispLSI 1016 
	2.10 ThờI gian trì hoản tốI đa của GRB vớI tảI GLB 
	2.11 Công suất tiêu thụ 
	2.12 Sơ đồ chân 
	2.13 Ý nghĩa tên linh kiện 

	BÀI 5 
	GIỚI THIỆU 
	MỤC TIÊU THỰC HIỆN 
	NỘI DUNG CHÍNH 
	 1. GIỚI THIỆU 
	2. YÊU CẦU HỆ THỐNG 
	3. KHỞI ĐỘNG SYNARIO 
	4. NHẬP MODUL VHDL VÀO DỰ ÁN 
	5. NHẬP SƠ ĐỒ MẠCH VÀO DỰ ÁN 
	6. HOÀN TẤT THIẾT KẾ 
	7. NHẬP THUỘC TÍNH 
	8. TẠO VÉC TƠ THỬ 
	9. BIÊN DỊCH FILE VHDL, SƠ ĐỒ VÀ VÉC TƠ THỬ 
	10. MÔ PHỎNG CHỨC NĂNG VÀ DẠNG SÓNG RA 
	11. TẠO MỘT KÝ HIỆU 
	12. THÍCH ỨNG THIẾT KẾ VỚI THIẾT BỊ CỦA LATTICE SEMICONDUCTOR 
	13. CHẾ ĐỘ NHẬP HỔN HỢP 
	14. TẠO FILE NGUỒN ABEL-HDL 
	15. BIÊN DỊCH ABEL-HDL 
	16. MÔ PHỎNG KẾT QUẢ THIẾT KẾ 
	17. THÍCH ỨNG THIẾT KẾ VỚI THIẾT BỊ LATTICE 
	 TÀI LIỆU THAM KHẢO 
	 




